


In a lecture on motion and gravity, our bespectacled physics lecturer once
taught us about Escape Velocity—the exact speed required for an object to
“escape” earth’s gravitational pull so that it does not fall back. This

velocity—around 25,000 miles an hour—is one of the most important
constants in rocket science.

I remembered this figure because India is now on the threshold of a
different kind of escape velocity, a constant that will either put India on the
growth curve, or push it down a spiral of technological oblivion. 

The next 12 months, therefore, could well define the future of technology
penetration and usage in India.

For long, India’s march on the technology battlefield has been held back,
not by its brain power, but by its sheer lack of collective will. It does show up,
but in spurts—like when Nasscom lobbies to prevent outsourcing from being
banned in the US, or MAIT influences the government to bring down duties
and taxes to encourage hardware sales growth.

To be sure, Nasscom and MAIT will only be minor catalysts in our
technological advancement—it will be people like us who will drive the engine. 

A caveat, though—is technology usage the only measurement of growth?
Former Andhra Pradesh chief minister Chandrababu Naidu, may have

known Bill Gates on first name basis, but he did not know what the person on
the street wants. Even as Hyderabad bid for a Formula 1 racetrack—which
incidentally uses so much technology that the engineers at MIT would be
proud—Naidu lost track of what real development means. Here is a simple
thing that Naidu forgot—technology is only a tool for development, not
development by itself.

Award-winning journalist Thomas Friedman, in his perceptive column for
the New York Times, recently wrote where India is truly shining—in a village
near Bangalore where armyman-turned-software scientist-turned-social worker
Dr Abraham George is bringing about a quiet revolution by building a school
called Shanti Bhavan for underprivileged children who get to work on PCs
every day, and build a life through education and self-respect. 

When Friedman met the students there, he played a typing match on the
PC keyboard against an eight-year-old girl. He lost.

India’s future as a technological powerhouse, you’d realise when you visit
places such as Shanti Bhavan, is not rooted in how many outsourcing contracts
we win, or how many million cellphone connections we have, or how much
percentage of the population can access the Internet.

It is rooted in us. And unless we collectively achieve the escape velocity my
physics teacher so passionately talked about, we will be grounded. For life.

Maulik Jasubhai
Publisher and Executive Director, Jasubhai Digital Media 

Maulik Jasubhai

IT’s in Us

Publisher’s Note
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AGerman university recently became the first organisation to publicly sur-
render the fight against spam and virus-loaded e-mail. The administrators
turned off all filters and let through all e-mail, even though they knew 98

per cent of it was bad. Their filters just couldn’t keep up.

Ever since the innocuous-sounding Melissa hit the Internet in 1999, e-mail has
been the most popular, and the most effective way to deliver viruses. You can stop
junk mail on your PC, but that doesn’t account for all the damage that they do. E-
mail viruses can usurp all available bandwidth to spread. Junk mail accounts for a
huge chunk of the bandwidth available to ISPs, and if you have spent time cleaning
out your Hotmail or Yahoo! account, you know how much it costs you in terms of
bandwidth and productive time. The ideal goal, is to stop the junk from ever
reaching your modem connection, not just your screen. E-mail is a clogged channel
that desperately needs to be cleaned.

The problem is the e-mail system was designed as a simple personal communica-
tion channel over the fledgling Internet. Its trusting nature makes it too easy to
spoof the system. It is trivial to manipulate the records in the e-mail to make it seem
like the mail you send, was actually sent by, say, the CEO of your company. And
there is little chance you will be discovered. Spammers can hide their tracks easily,
because there is no way to accurately determine where in the world an e-mail was
sent from. 

That could be the first problem to be fixed. Yahoo! just published a proposed mod-
ification to the e-mail channel called DomainKeys. It will definitively associate the
server that sends the e-mail, to the message itself, stripping away the layer of
anonymity protecting spammers. After all that talk by Bill Gates about spam,
Microsoft also released its own proposed solution to the same problem called Caller
ID. Yahoo! and Hotmail are probably the world largest e-mail service providers, and
this is the first concrete step to combat malicious mail.

The new problem, of course, is will these two work together to create a common
solution, or are we facing a DVD-wars-like split in technology that will leave a hole
wide open for spammers to drive through?

sumod_hajela@jasubhai.com

“E-mail is a
clogged
channel that
desperately
needs to 
be cleaned”

Cleaning the e-mail mess

Sumod Hajela
Assistant Editor
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taste technology at www.thinkdigit.com

A school of thought  
By the masses, for the masses. A
technology that promises to
democratise computing▼▼

▼▼
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HT MPEG Encoder 6.0 
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Mindware

Painkiller   
Size: 228 MB
Playware

June 2004

Want to brainstorm? Start a discussion? Share an idea?
Log on to www.thinkdigit.com/forum

FORUM

You get to choose what goes on Digit Interactive. 
This month, you have chosen:

Pumping Goodies
thru' Air      
A look at ultra wideband, a
wireless technology that’s faster
than Bluetooth and Wifi, has the
potential to transmit huge amounts of data very rapidly
and can pass through walls, floor and even steel!

Expect these on the July 2004 CDs
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We bring you a compilation of the previous Digit issues, right from the year
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So whenever you need to dig out an article, just enter the keywords, and search
through more than 3,500 pages in matter of seconds.

Look for these products on the CDs



And so we thought only
kids play video games.

And so, we were wrong.
In a survey carried out by

the US-based Entertainment
Software Association (ESA), it
was found that a typical
hardcore gamer is not your
neighbourhood teenager, but
his 12-years older brother.

The survey, based on a
sample size of 1400 US
families, and released at the
r e c e n t l y - c o n c l u d e d
Electronic Entertainment
Expo (E3) in Los Angeles, said
that the average age of
gamers was 29, while most

buyers are aged around 36.
Not surprisingly, however,
men make up for 59 per cent
of the playing audience.

Which leads us to ask: Did
the recent Time magazine
cover feature on failed
marriages miss out on an very

important reason
for the failure?

But the mother
of all musical wars
is yet to begin. With
Sony announcing
the download
service called Sony
Connect for uses of
Sony Mini

Discmans, MTV might be a
sweating a bit under the collar,
even if it reaches 80 million
homes world-wide.

Video may have killed the
radio star. But surely, the
online ring has place only for
a few fighters.
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DDoommaaiinn  KKeeyyss
■■  WWhhaatt  iiss  iitt??
An e-mail standard proposed
by Yahoo! that embeds an
encrypted signature on
outgoing messages. 

■■  HHooww  ddooeess  iitt  wwoorrkk??
It uses a pair of signing keys.
The domain owner first sets
up a key pair, and publishes
a copy of the public key on
the DNS. The private key is
installed in the outbound e-
mail servers. On receiving it,
the public key for the
domain name in the ‘From:’
field is obtained from the
DNS. Using this, the private
key’s signature is verified. If it
doesn’t match, the e-mail is
dropped; if it matches, the
mail is delivered.

■■  HHooww  wwiillll  iitt  hheellpp??
If all companies enforce rules
that need all e-mail to be
signed using DomainKeys,
then spam could fall
drastically. Spammers would
need a valid domain address,
and wouldn’t be able to
spoof addresses.

hypethesis

Google shocked the world
with their 1000 MB free e-

mail announcement on April
1. And no, it was not an April
Fools’ joke. With Google
threatening to wrest the
world’s most visited Web site
status from Yahoo! and MSN,
the former had to do some-
thing, quick.

So, it came up with a 10
per cent me-too solution—
Yahoo! will soon upgrade all
its users to 100 MB of free e-
mail space, along with Yahoo!
Photos and Yahoo! Messenger.
Yahoo! may have a headstart,
though, thanks mainly due to
the leader in the 1000 MB free
space, Spymac.com, showing
signs of glitches, and

subscribers are getting disillu-
sioned too soon.

But guess who won the
race for the most reliable 1 GB
inbox. The almost forgotten
Terra Lycos network that
breasted the tape.

Hotmail, meanwhile,

continues to be arrogant. It
has not budged from its 2 MB
free inbox service for years,
and announced recently that
it will open its inboxes to
“friendly marketing commu-
nication”, which essentially
means more spam.

The question, then, is:
With so many sites offering
hundreds (and now, thou-
sands) of MB of free space, can
Hotmail afford to stay
behind? Our guess is that it
will have to shape up, or ship
out. Soon. 

■ Sony cuts down PS2 prices to US$150. HP to start offering customised gaming PCs  ■ Japan’s eAccess to buy over AOL Japan from AOL Time Warner Inc. 

Yahoo!: 100 not out. Hotmail:
Still on 2. Lycos: Already 1 GB

Online groceries
worldwide will see
sales of 2.4 billion
dollars in 2004,
which is 0.4% of
the total grocery mar-
ket of 570 billion
dollars

snapshot

Source: CNN

➜

Not now, honey. I am playing my video
game

By the Way, which is your
favourite free e-mail service?
Post your comments on the
Forum on www.thinkdigit.com.

Illustrations: Mahesh Benkar
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W32/Lovgate.ab
This worm attempts to reply
to all messages in Microsoft
Outlook. It scans files for e-
mail addresses, and uses its
own SMTP engine to send
itself to the address it finds.
The ‘From’ line of the e-mail
is spoofed. It also attempts to
copy itself to KaZaA shared
folders, and all computers on
a local network and
terminates processes
belonging to anti-virus
programs. 

Version 1.1.6 of the
W32.HLLW.Lovgate@mm is
available for downloading at
the Symantec Web site
www.symantec.com

Sasser Scare
W32.Sasser.B.Worm is a
variant of W32.Sasser.Worm.
It spreads by scanning
randomly selected IP
addresses for vulnerable
systems. Interestingly, no
more than one instance of
the worm can run on a
computer at any time.
Symantec’s removal tool is
available at http://security
response.symantec.com/avcent
er/FxSasser.exe. 

redalert

Most Relevant Search Result 
(Determined by % of Search Engine Users)
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■ Samsung to launch phones that can receive satellite TV ■ Danger to offer Yahoo! Messenger services on its popular Hiptop handheld device

➜

Sony recently launched the
its Connect online music

store in the US with the prom-
ise of “a better selection than
any other legal download serv-
ice”. However, the Washington
Post slammed what it called an
“embarrassment to the parent
company” and its “control-
freak behaviour”.

It has only 5,00,000 titles,
compared to Apple iTune’s
7,00,000. Like iTMS, Connect
supports a limited array of
portable music players, in this
case Sony’s MiniDisc machines.
Connect encodes songs in its
own 132 Kbps ATRAC 3
format, offering them for 99c a
track, or at $10 an album. 

Sony is not going to find it
easy in Europe, though, espe-
cially since it’s likely to merge
with another music giant,
Bertelsmann Music Group
(BMG). A Sydney Morning
Herald reporter, incidentally,
has discovered a Russian site
that offers downloads for as
little as 5 cents a track (or Rs 3
per song).

How cheap
can a down-
load be?

Microsoft has, for obvious
reasons, been on the fore-

front of the oppose-open-
source campaign. Not
anymore. If officials of the
Redmond-headquartered soft-
ware giant are to be believed,
Microsoft will let the world
peek into the world’s highest
selling desktop operating
system. Last month, Microsoft
posted the Windows Template
library at SourceForge
(www.soundforge.net). 

This is the second time that
Microsoft has shared bits of

Windows. Earlier in April, the
company revealed the source
code for its Windows installer
XML software, WiX. 

WiX builds installation
packages for Windows software
using XML (eXtensible Markup
Language). Of course, in typical
Microsoft Janus-faced
approach, it has revealed quite
a bit of Windows to countries
such as China, to assuage thier
security concerns. 

The current program
includes only a few countries,
only after signing of confiden-

Intel claims that it can
employ wireless sensors to

track the lifestyle of 11
patients in the early stages of
the Alzheimer’s disease.

In its new project, Intel will
place off-the-shelf sensors
that wirelessly trans-
mit data to a
c o m p u t e r — i n
kitchens, bathrooms,
phones and comput-
ers in households The
data will then be
crunched to measure
the amount of time a
patient spends on the phone,
talking to visitors or e-mailing.
Intel will then formulate a
‘sociability index’, primarily to
gauge cognitive decline.

Intel pledged $1 million
when it created a consortium
with the Alzheimer’s Associa-

tion last July called Everyday
Technologies for Alzheimer
Care. ETAC is now reviewing
40 applicants from academia

and hopes to raise a total $4
million (Rs 18.5 crore) in June
from other technology
companies.

If the system works, the
technology will be placed in
200 US households by 2005.

Let the air in; open the
Windows!

Alzheimer’s patients, take
heart. Intel’s inside

Source: iProspect, Survey Sampling International, WebSurveyor, and Stratagem Research
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Most Popular Non-Work Related
Web Sites Accessed at the Office

statattack
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■  CISCO source code leak; sample code posted on IRC. FBI and CISCO to investigate ■  Microsoft releases Office 2004 for the Mac platform

It wouldn’t be an exaggera-
tion to say that Larry Page

and Sergey Brin changed the
way we use the Internet. But
are they gonna change the
world, too?

The company’s pre-IPO
document specified the setting
up of Google Foundation, an
institution that will strive to
“make the world a better
place”. The document was
meant for stock market regula-
tors to be introduced to many
undisclosed details. 

Google informed potential
investors in the document sent
to the Securities and Exchange
Commission (the American
counterpart of SEBI) that they
“intend to contribute signifi-
cant resources to the founda-
tion, including employee time
and approximately one per
cent of Google’s equity and

profits in some form.”
The two Stanford

PhDs wrote: “We
hope someday this
institution may
eclipse Google itself
in terms of overall
world impact by
ambitiously applying
innovation and
significant resources
to the largest of the world’s
problems.” Noble intentions
ooze from Google all the time
(remember “We don’t do
evil”?), besides a foundation
would also add another level of
public disclosure to the world’s
largest search company, which
has, for the last six years,
enjoyed the relative secrecy of
a privately held corporation.
Google earned nearly $106
million last year. For the three
months ending in March 31,

2004, they earned $64 million
on revenue of about $390
million, 30 per cent of which
was derived from outside the
United States.

Which is not bad for a
company that put Sherlock
Holmes to shame with its
search algorithms.

Normally, movies create a
stir because of excess sex,

or violence, or even racial
abuse. But a Web site meant to
promote the film Godsend has
raised the heckles of those
opposed to human cloning.

The film stars Oscar nomi-
nee Greg Kinnear and Rebecca
Romijn-Stamos (whose ex-
husband John Stamos starred
in Full House) as a couple who
lose their son. With the help of
fertility expert Dr Richard
Wells (played by Robert De

Niro), they try to clone their
son. The Web site—godsendin-
stitute.org—promotes a ficti-
tious fertility clinic. The confu-
sion arises because it
d o e s

not mention the movie.
Web sufers have petitioned

on the grounds that it is insen-
sitive to those who have lost a

loved one, and are
seeking to clone. 

Tom Orten-
berg, president of
film releasing for

Lions Gate Enter-
tainment claims, “Every-

one who goes to the site
thinks it's real, but by the

time they leave, most have it
figured. Some even applaud it.”

heroes

Net-banking
At an online survey, 75 per
cent said they were less
likely to shop online
because of phishing. Over
65 per cent expressed fears
about their bank’s online
service. Only a third of the
650 respondents felt they
could distinguish between a
real e-mail and a fishy one. 

Corel WordPerfect
12
Corel’s new WordPerfect 12
update is hardly worth the
$150 price it demands. It
has a cluttered interface,
non-intuitive menu
structure and an extremely
buggy compatibility feature
that fails to handle
Microsoft Office and HTML. 

zeroes

E-mail users
Web portal Lycos has
followed Google and Yahoo!
in the race to provide e-mail
users huge storage. 
Lycos is upgrading its
service in the UK to give
consumers 1 GB mailboxes.
But users will have to pay a
monthly fee of Rs 275.80.

While Google’s Gmail is
still in a test phase, Spymac,
a Web-hosting company for
Macintosh aficionados, has
also announced a free 1 GB.

Fedora RedHat
Fedora Beta 1.92, release
3, has a fundamentally
different security model.
Fedora Core now includes
Security Enhanced Linux.
SELinux is disabled by
default. To enable, type
‘selinux’ at the Boot
prompt. 

Before doing that, it is
imperative to memorise the
Fedora Core SELinux FAQ.

Google presents: The new, improved world

Hum Aapke Hain Clone

I want my MTV online! 

Popular television network
MTV is now girding its

loins and getting ready for
the big battle. And this time,
it WILL be big.

Right now, as industry
pundits would tell us, the
biggest music battles are

being fought not in the
studios, but on the Internet.
After the super-successful
launch of Apple’s iTunes, it
was only a matter of time
before others got into the
ring. With television
industry leader MTV tying

up with RealNetworks and
three other labels, the share
for the music downloads pie
may get smaller by the day.

The partnership is called
MusicNet, and the service will
charge $1 per song, while a
month’s usage will cost $10.

Do you think Google should
stick to search, or should they
heal the world? Tell us at
www.thinkdigit.com
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■ Opera v7.5 released, new features include support for RSS feeds  ■ The FBI is looking into child pornography file-sharing over P2P networks; has made several arrests

Spammers of the world
unite—the Mafia is now

after you. But the Mafia
being the Mafia, it won’t
bump the spammers off
(damn!); instead hire them
to write viruses to enable
them to send spam. 

If Eugene Kaspersky,
head of anti-virus research
at Moscow-based Kasper-
sky Labs, is to be believed, the
advent of forthcoming laws
that make spamming illegal
has increased criminal interest
in spamming. “If you have a
profitable, illegal business,
sooner or later, you pay taxes
to the Mafia,” said Kaspersky.

Though there is little to
support his theory, Kaspersky
reckons that if organised crim-

inals take control of spam-
ming, they may reduce in
number. However, the odd
attack may be leathal.

Kaspersky has word of
consolation, though: “It is
unlikely that criminals would
take over anti-virus and anti-
spam companies, as the family
“needs effective anti-virus and
anti-spam too.” 

Microsoft India has
announced a tool to

help organisations automati-
cally remove the Sasser worm
(W32.Sasser.A, and its vari-
ants). The tool is available free
of cost, and can be down-
loaded from www.microsoft.com/
india/security.

Microsoft also informed

customers that they can
protect themselves against
these attacks by first ensuring
that their firewall is in place,
and then installing Microsoft
Security Update MS04-011.

Customers can alterna-
tively call Microsoft India’s
Free Virus-support Helpline at
1901-333334.

Godfather@spammers.com

Have a virus? Call Dr Bill

Spam Warnings
A US court quashed a
restraining order passed against
SpamCop.net that prevented
the anti-spam service from
warning ISPs of spam
originating from their networks.
SpamCop, now owned by
IronPort Systems, is a service
that has worked actively with
ISPs warning them misuse of
their e-mail services. 

An online marketing
company called OptInRealBig.
com filed a case saying that
with SpamCop squealing away,
OptInRealBig lost contracts with
ISPs and customers. The courts
initially passed a restraining
order against SpamCop, and
after reviewing SpamCop’s
reply to it, the order was
dissolved. 

The US Federal Trade Commis-
sion (FTC) has filed charges
against a spammer in the US
and his associate in the Nether-
lands who used spam to drum
up business for an adult site
called ‘Married But Lonely’. The
defendants are to pay
$112,500. 

However, they could not be
tried under new anti-spamming
regulations since the spamming
occurred before the legislation
came into effect. 

In its complaint, the FTC
pointed out that the consumers
were not expecting adult related
content with such subject lines,
and that work place rules could
have been violated.

Spam
Married, lonely
and now poor

➜

OK, it was only a matter of
time, so we are not

surprised. A group of 2,000
cellphone owners have
formed an “Excuse and Alibi
Club” in the US, where one
member lies on behalf of
another. The club is modelled
after its German founder,
known only by the name
‘Numbrrrs’. 

Here’s how it works: Cell-
phone users download back-
ground noise of traffic jams,
and then play them when
they call their bosses, or
spouses to say that they're
late. While someone close to
the club admitted the ethics
surrounding that application
is a bit dubious, the software’s
creators, a company named
SounderCover insist that
people are only having fun.

The software is compatible
with certain Nokia phones,
which mainly run on the
cellular-phone networks in
Europe. In India, where
numbers of mobile phones
are increasing by the day,
mobile phone ethics are a
serious problem. The scenario
will get further aggravated
with sophisticated technol-
ogy. Will the user wait for
stringent legislation, or will
we be ethical while there’s
time?

Time Magazine, as
mentioned in a story earlier,
missed one more reason for
failed marriages!

Let sleeping
slobs lie

82 per cent of
all US e-mail is
spam 

snapshot

Source: MessageLabs Inc

Microsoft's affair with Wi-Fi
has ended. 

In what is considered to be
a total U-turn on its wireless
policy, Microsoft has decided
to discontinue its entire line
of Wi-Fi gear. Microsoft had a
complete line of Wi-Fi prod-
ucts including base stations,
laptop cards, and USB and
PCI add-ons for desktop
machines. 

It had entered the Wi-Fi

market only last year and
notched up an impressive No
2 position. But soon other wi-
fi manufactures caught up and
MS 's delay in delivering for
the "g class routers" resulted in
its fallen market share. 

Although Microsoft claims
to have accomplished its goals
of using wi-fi on security, ease-
of-use and performance, the
real reason may somewhere lie
in "G Products".

Goodbye Wi-Fi, says
Microsoft

By 2009, 43 mil-
lion handheld gamers
will be generating
revenues worth 2.7
billion dollars

snapshot

Source: Jupiter Research
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“It's a bug.”

Google spokesman Nathan
Tyler, denying rumours that
Google was offering Gmail
users one terabyte of storage
space. Testers of the free e-
mail service discovered on
Wednesday that their
accounts claimed to have
one million megabytes of
storage space. 

“I was using Minix
when I wrote Linux,
but that’s in the
same sense that
you are using
Windows when you
write your columns.
Do your articles
contain Windows
source code
because you use
Windows to write
them?" 

Linus Torvalds, in an e-mail
interview to CNET
News.com, refuting claims
made by a report from a 14-
person Washington DC think
tank, that he may have
gradually replaced Minix
code with Linux

“There’s been an
endemic problem
with people logging
in with unpleasant
or racist names.
Also blokes chatting
up girls. Not bad in
itself, but some are
doing so in a
profane and very
persistent manner."

Stephen Goddard, co-editor
of Ship of Fools, the webzine
behind the online chapel,
Church of Fools. The Internet
church, launched last week,
is funded with £5,000 by the
Methodist Church in UK.

quoteworthy

Bendable PCs with OLED
displays that could be as

thin as 0.2 mm—the size of
credit card—are just about
five years away, according to
Sony researcher Carsten
Schwesig. 

Sony’s Gummi Project is a
testbed using a TFT display,
with no buttons: You hold it
with both hands and twist. In
place of clicks and drags, are
five states—neutral, up, down
and two transition states. 

Gummi enables you to
select an object, follow a
hyperlink, or start playback,
with a transition down
mapped to a zoom. Because
the zoom is so natural, navi-
gating large hyperlinked
documents is faster, and
selecting objects doesn’t
require precision. Clever use
of opacity allows users to
blend different maps together,
or leaf through discrete, but
overlaid Web pages. 

Bendable Computing

Downloading music,
movies or software ille-

gally might become less
appealing, if every third song
or film scene was suddenly
interrupted by white noise or
announcements urging “next
time, pay for what you take!” 

This technique—circulat-
ing flawed, or reproving digi-
tal copies of songs on the
Internet—has been tried by a
few pop stars hoping to thwart
online music piracy. Two
weeks ago, a University of
Tulsa professor—John Hale—
and a former graduate student
of his—Gavin Manes—won a
patent for software that analy-
ses and monitors illegal music
swapping on file-sharing
networks, and then systemati-
cally inserts decoy files into
the mix.

The music industry in
India, which is plagued not just
by piracy issues, but copyright
wrangles seems to be the ideal
place for low-cost, foolproof
technologies such as this,
rather than the sophisticated,
technology intensive ATRAC,
AAC or DRM–protected WMA
files used by big MNC players
such as Sony or Apple.

The time seems just right
for a measure such as this.

Add noise to
combat Net
pirates

China has shut down more
than 8,600 cyber-cafes in

two months, fearing that it will
corrupt young minds. The
government claims it’s a crack-
down on unlicensed cyber
cafes that spread “unhealthy
online information”. 

Authorities also ruled that
Internet cafes are not to oper-
ate in residential areas, or

within 200 meters of primary
and high schools.

Big  Brother is surely big in
China. As the Pink Floyd song
goes: “Mama’s gonna make all
of your nightmares come
true...Mama’s gonna keep you
right here, under her wing, She
won’t let you fly, but she might
let you sing, Mama’s gonna
keep baby cozy and warm.”

Dragon burns over 8,600
cyber cafés

■ Security firm Secunia announces critical weaknesses in Mac OS X ■ US based Wi-Fi pioneer Cometa suspends operations following financial problems

World-wide Internet

Population 2004:

945 million

Internet Population

in India: 39.20 mil-

lion

snapshot

Source: Computer Industry Almanac

tomorrow’s technology

Thank you for calling,
Have a nice day!
Little does Kavita who

becomes Karen at her call-
centre job know about the
bumper stickers declaring
“Opportunity Indiana”, “Keep
Jobs in Colorado Act”. 

Indian politicians and exec-
utives of companies that
provide offshore services are
surprisingly sanguine about the
controversy. But it’s election
time in the US, and every triv-
ial issue is raked up. Economics
dictates business, and for every
dollar spent on outsourcing,
the US economy receives $1.12

to $1.14 in return. 
And, if Gary Endelman, a

lawyer at BP America is
believed, 3 million out-
sourced jobs in the next 15
years represent only two per
cent of total US employment,
this year. 

The best way to counter all
backlash is to provide accurate
information according to
most Business Processing
Outsourcing (BPOs). This only
means one thing—it would be
business as usual for India. So,
keep smiling



Hewlett-Packard India Pvt. Ltd., the
leader in inkjet all-in-ones, have

launched a new revolutionary all-in-one
armed with printer, fax, scanner, copier
and a phone. The OJ 4255 all-in-one
promises an end to conventional faxing
and comes packed with innovative
features. Capable of 6-ink colour
printing, the OJ 4255 with a high speed
fax-modem allows colour faxing and has
a 100 page fax memory. It also comes
with upto 72 hr backup to ensure that

your incoming
faxes stored in
the memory are not lost in case of a
power failure. Priced at Rs 9,999, this
ultra-compact all-in-one with well-
integrated multifunction capabilities is a
steal for any customer.

H P Officejet 4255 all-in-one
printer / fax/ scanner/ copier/ phone
Next generation 5-in-one from HP. 
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If you feel the need to buy a second
PC, you should first consider +One

PC—the  most effective way to add
more PCs to your existing PC. With
+One PC, two or more users can work
simultaneously and independently on
any application. Both can access all
attached peripherals and share an
Internet connection. This also results
in low maintenance costs. +One
consists of a PCI card, connector box
for connecting keyboard, mouse, and
easy-to-use +One PC software. It also
contains a 15 foot extension cable to
let you work from a distance. +One PC

is compatible
with both Windows XP and Windows
2000. Adding users is limited only by
the amount of free PCI slots you have.
+ONE PC is the perfect product for
offices, schools, Universities, cyber
cafes, SoHos, stockbrokers, etc.—
wherever there is a need for more PCs
at minimum cost.

Contact: Adline Systems 
Price: Rs. 6,500 +Taxes
Phone: 011-25720911, 011-51547279,
Fax: 011-25720441
E-mail: adline@del6.vsnl.net.in

Contact: Hewlett-Packard India Pvt. Ltd.
Price: Rs 9,999 (taxes & levies Extra)
Phone: 1600-444 999 (toll free)
e-mail: in.contact@hp.com

+ONE PC
The least expensive way to add more PCs

New ArrivalsNew Arrivals

Toshiba’s 1.8” HDD
Small yet powerful
Toshiba has introduced its latest 1.8”
HDD Removable Storage Compliant
with PC Card Type II Standard. It has a
5.0GB capacity with a dual-interface
PC Card ATA and 68-pin ATA. It has an
average seek time of 15 ms and a
latency of 7.52 ms. It comes with a
warranty of one year.
Phone: 022-24328586/24328686
E-mmail: neesan@vsnl.net                          

Plextor PX-708UF
DVD±R/RW Drive
Zeta Technologies Pvt Ltd and Plextor
have announced the launch of PX-
708UF—the first DVD±R/RW CD-R/RW
8-in-1 external IEEE 1394 and high-
speed USB drive that offers all the
advantages of Plextor DVDRW drives,
along with dual format capabilities.
The PX-708UF supports 40X CD-R
write, 24X CD-RW rewrite and 40X CD-
ROM read speeds. Users can create a
4.7 GB disc on DVD media in about 8
minutes flat!
Plextor is also offering a one-year
warranty on parts and labour and
unlimited technical support.  
Contact: Shubhendu Nath 
Phone: 022-33495276, 98925 92597

ASUS Motherboard
Enhancing Intel
ASUS launched the P4R800-V Deluxe
Motherboard that supports Gigabit LAN,
Serial ATA and RAID 0,1,0+1 functions. It
also enables an 800 MHz system bus, and
a dual-channel DDR 400 memory design
for the future Intel Prescott processor. It
has flexible input/output features for an
excellent home entertainment system. It
comes equipped with one IEEE 1394 port
behind, and another onboard for high-
speed digital data transfer. It comes
equipped with the exclusive Wi-Fi slot,
which supports the ASUS Wi-Fi@HOME
platform. The motherboard also
incorporated the revolutionary ASUS
Intelligence (AI) features of Net and BIOS.
Contact: Mr Pankaj Pamani
Phone: 98200-10267

‘New Arrivals’ is an advertiser-sponsored section that showcases the latest launches in the Indian market. 
All product specifications featured here have been obtained from the contacts listed, but have not been verified by

the Digit Test Centre. You can look forward to reviews of some of these products in our Test Drive section soon.

Digi Giga Systems Ltd. has
introduced the SiS 760 chipset

Gigabyte GA-K8S760M motherboard,
the very first integrated solution
supporting the AMD Athlon 64
processor. The GA-K8S760M is
equipped with a new Mirage 2 Graphics
engine and world leading Local Frame
Buffer (LFB) design. The high speed Fast
Ethernet interface is equipped for

establishing the efficient broadband
connection to the internet, with up to
150MB/s data transfer rate making it an
ideal choice for multi-functional system
used in home and office environment.

Contact: Digi Giga Sytems Ltd.
Phone: 022-26526696 / 56902210
Web site: http://www.digigiga.co.in/

Digi Giga Systems - Gigabyte Chipset
Empowering AMD Athlon 64
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This stunning beauty from Tech
Com is a sure heart stealer . This
multimedia keyboard offers a

choice of three colours—white , black &
silver-black . To add to its looks, this
power-packed keyboard comes with 18
hotkeys which are sure to make web
surfing smoother, movies turn into a
new experience, and all those MP3s are
all the more fun.

The ergonomic looks are
complemented by ease of key access. All
special keys are grouped by their
applications—Internet , multimedia and
office applications.  The keyboard comes

ready for all versions of windows and
has a PS/2 interface. At Rs. 395, this is
one sure buy for anyone who needs a
good keyboard, be it at home or office.

Admit it—you’d love wireless
networking if it’s affordable. Yep, its

possible without looting banks. Thanks
to Simple Marketing, we have ZyAIR B-
1000 v.2 wireless LAN access point and
ZyAIR B-220 wireless USB adapter
combo, which delivers a highly secure,
reliable, and easy-to-use wireless LAN
solution for residential and business
applications at a very modest rate. The
features include powerful security
mechanisms such as IEEE 802.1x user
authentication and Wi-Fi Protected
Access (WPA), which allow users to
communicate and access data with
efficient link quality and high-level
network security. Additionally, Wi-Fi
certification ensures interoperability
between the ZyAIR B-1000 v.2 and any
Wi-Fi 11b compliant wireless devices.
The ZyAIR B-220 802.11b Wireless USB
Adapter/AP, works as client and AP(Dual
mode, Wi-Fi certified to ensure

interoperability, WHQL certified to
ensure compatible with Microsoft
Windows, adapter for USB-compliant
notebooks and computers. 802.1x client
software embedded, Wi-Fi Protected
Access(WPA)support,128 bit WEP
support. Uff, heavy stuff. In spite of all
the features, it’s a truly Plug-and-Play
device and the good thing is that the
whole combo costs Rs 5,999.One 
word—Wow.

ZYXEL- Wireless Networking At Easy Prices

Contact: Mr Amit Kedia
Distributor: Shree Sagarmatha Distribu-
tors Pvt. Ltd.
Phone: 011-51618545
Price: Rs 395
E-mail: techcom@touchtelindia.net
Web site: www.techcomindia.com

Price: Rs 5,999
Contact: Simple Marketing Pvt Ltd
Phone: 011-26431795, 0-98102 90962
E-mail: simple@vsnl.com
Web site: www.onlinesimple.com

Cyber Space Abacus Pvt Ltd, the
National distributors for

ANTEC, is now launching the
CoolerMaster range of products at
India.  “The Cooler Master all
Aluminum “Wave Master Mid-
Tower Case”. This is truly in a class

by itself. It is the flagship of the
Cooler Master range of well-
designed quality aluminum
cases. Wave Master breaks

traditional square casing design

to bring you a more sensational
experience. The durable lightweight
aluminum alloy greatly reduces its
weight (34% in comparison to casings
made of iron). It comes with a stylish
curved front plate design. It has a
sophisticated machine processing for an
exotic smooth finish and removable
motherboard tray for fast and easy
assembly.

CoolMaster

Contact: Shunmugavel Yogan 
Phone: 044-24917667 /24917675
Fax: 044-52154188
E-mail: sales@theitdepot.com
Web site: www.theitdepot.com

Zenith Launches ‘Topper’,
India’s First Education PC 

Zenith Computers has launched the
‘Topper Desktop’ for students, in
association with Intel, the world’s
largest chip manufacturer.  

Topper, priced at Rs. 23,000, is a
multimedia PC with a CD-writer,
modem, speakers, free Internet
connection and a Topper 18-CD pack.
The CDs include ‘Career Launcher’,
and other software such as Vedic
Mathematics, Learn to Speak
English, Programming languages,
Webster’s Encyclopedia, Chess,
Hutchinson Library and many more.

To encourage academic
excellence, Zenith will also gift the
‘toppers of major certified Indian
exams,’ a Zenith Topper each. High-
scoring students will also receive
scholarships, awards and higher
recognition from Zenith.  

Zenith Topper is available at over
780 dealers, at 140 exclusive ‘Zenith
PC World’ retail outlets at convenient
locations across the country. 

Contact: Devita Saraf
Executive Director, Marketing
Zenith Computers Limited.
Tel: 91-022-28377300
E-mail: dsaraf@zenith-india.com

For  any  new  product  announcements
in  this  section,  vendors  /
manufacturers  can  get  in  touch  with

BANGALORE: Bibhor Srivastava, 
E-mmail:
bibhor_srivastava@ jasubhai.com, 
Phone:  5325670/88, 37629285 
CHENNAI: Sahayaraj Prabhu, 
E-mmail:
prabhu_sahayaraj@ jasubhai.com, 
Phone: 28235186/89, 33629282 
KOLKATA: Jayanta
Bhattacharyya, 
E-mmail: jayanta_bhattacharyya@
jasubhai.com, 
Phone: 22345100, 33629284 
MUMBAI: Saurabh Pandey, 
E-mmail:
saurabh_pandey@ jasubhai.com, 
Phone: 56310515/14, 33629278 
NEW  DELHI: Arvind Prabhakar, 
E-mmail:
arvind_prabhakar@ jasubhai.com, 
Phone: 51608658/59, 33629279 
PUNE:  Vinayak Inamdar, 
E-mmail:
vinayak_inamdar@ jasubhai.com, 
Phone: 24482059
SECUNDERABAD: Vinayak
Inamdar, 
E-mmail:  vinayak_inamdar@
jasubhai.com, 
Phone: 55221051, 3362980
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The HOTtest Keyboard



Star struck
I am a 17-year-old college

student, and I must admit

that though your magazine

stands out in the market

place, there is still an iggly-

wiggly complaint about

you guys. 
The wallpapers, movie

trailers and numerous

games that feature on your

Playware CD are indeed

superb. But really, why

don’t you guys include

wallpapers of Hollywood

superstars on your CD? I

am sure that pictures of

Cameron Diaz, Leonardo Di

Caprio, etc, would look

better on the desktop.  

Poornima Menon

Mumbai
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Your vote counts

Rediffmail     15.4
16.2 62.8

5.6% 
Indiatimes 

Yahoo!

Responses: 7046

Gmail for mail
I was astounded to see the response to the May 2004 survey question.
Majority of the participants have shown preference for Hotmail orYahoo! over Google Mail. I feel that there will be a big variance if thequestion is framed this way: “Taking into consideration the overallfeatures and the underlying technology along with 1 GB space, which e-
mail service provider will you choose.” I am sure that Gmail would then get more points. I also doubt if the
users know about the complete features announced by Gmail. I feel Gmail will be preferred more, because of its underlyingtechnology and its obligation to perform well, especially after Google has
announced its firm plans to go public. I might sound very optimistic here, especially since only a few people
have seen the e-mail service yet, but I am confident that there will be no
goof ups by the Google team with regards to their service. The onlyminus point with Gmail is Google’s announcement of not launching its
e-mail service with a POP3, HTTP or IMAP support. Surya Prakash Pasupaty

Kissa Kursi Ka 
I live in a small city, and a magazine like

Digit is the only reliable source of technolo-
gy information to me. But surely, be it for big
city guys or small city denizens, the one big
problem that is common for both is the ques-
tion of which chair to buy while working on
the PC. Wrongly selected, the chair could be
nothing less than hell. So what should be the
right chair to buy? Tarun Shrivastava

Dear Surya Prakash
Gmail’s 1000 MB service in itself will be a point of attraction for several e-
mail users. Imagine having 1000 MB of mails with search capability! Yes,
the lack of POP3 support may be a drawback, but the success of Gmail
does no just depend on just its features, but its reliability. In case you were
not aware, www.spymac.com already has a 1000 MB free e-mail service, and
yet, it is yet to be even talked about because of its unreliable e-mail engine.
Hence, for those unlucky people who have not been allotted a Gmail
account, it will be still be a wait and watch strategy.

Dear Tarun,
There are three ways of tackling this problem:
a) Improve your posture
b) Select the chair has good lower-back sup-
port, and...
c) Keep moving out of your work area as
often as you can

The straight-back posture is the best
because the human vertebral column is not
geared to bend for long periods of time,
which is how most people sit while working

The lower part is always the worst
affected when it comes to back problems.
The human back requires the most support in
the lower portion, and any chair that gives
you enough lower-back support should be a
good one.

Try and move out of you work area a bit.
Bend down, stretch a bit every half hour, or
take a five-minute walk every couple of hours.

Believe us, your back problem would be
cured just by doing these little things.

Fast, but serviceless

Yo Digit! In a previous edition of Tips and Tricks,

I saw the several tips that would make my PC

work faster. Now, here is the problem: I tried

your suggestions one by one, and boy were my

games fast! But (and there is always a but) ever

since then, I have had a real tough time trying

to start the services all over again, in order to use

dial-up networking. 

There is a sequence in which you have to

start these services (I haven't figured it out yet,

but trial and error worked for me) as most servic-

es are dependent on each other. How could you

guys not give the correct tip? 

Arun Thilak

Dear reader,
The box ‘At Your Service’, in the May 2004 Tips and Tricks
article, details how to go about creating hardware
profiles for each specific use of your PC. If you notice we
had specifically asked you to “Use different hardware
profiles for different service configurations.”

pulse ■
■ letters

Who among the following biggies, if they offer a free 1 GB mailbox, would
you prefer the most

Dear Poornima
Wouldn’t we love Tom Cruise or
Penelope Cruz on our wallpaper,
too! We will try and incorporate
your suggestion soon.

Gmail

Illustrations: Mahesh Benkar

Which of these five technologies do you think will make it big in
the next 12 months?

Computing Convergence E-paper Bayesian Spam
Filters

Sub-15,000 PCs P2P VOIP

This month’s question...

Log on to w w w.thinkdigit.com and vote
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E-mail: readersletters@jasubhai.com
Send your letters marked ‘Readers Letters’ to the Digit office: 

D-222/2, Om Sagar Building, MIDC, TTC Industrial Estate,  Nerul, Navi Mumbai 400 706 
Phone: 022-27629191/9200  Fax: 022-27629224

The price of the CMV
CT529 (Pg 61) is Rs 20,000,
and CMV CT722A (Pg 66)
is Rs 27,000, and not 
Rs 16,500 as mentioned in
the May issue.

We missed out providing
the contact details for
NEC. They are: 
Shiba Comp Pvt. Ltd.
Tel: 011-26413437
E-mail: nkjain@
shibacomp.com
Web site: www.necmitsub
ishi.com 

Regretfully, we goofed
up on the price of the
inkjet cartridges on page
130. Here are the real
figures:

A colour refill cartridge
costs Rs 310, and the
original cartridge costs Rs
1,100.

A black refill costs Rs
110, while an original black
cartridge costs Rs 800.

That’s a total (colour +
black) refill cost of Rs 420,
as compared to Rs 1,900
for both original cartridges.

Notice any goof-ups? 
Write to goof@jasubhai.com

Pick a TV
Hi, I have a peculiar

problem. We want to buy a

television for our house. I

want to buy a Samsung

Megabass, but my dad

wants to buy a Sony 3-D

Woofer model. So now, we

are quarreling. To solve

the problem, we decided

to accept whatever Digit

says? What should we do?

I want you to send me a

letter so that I can show

it to my father as proof.

Sachin Vadnere

Hi Sachin,
Your problem is not peculiar. Thanks to the enormous
amount of choice the Indian consumer has these days,
these situations are not rare anymore.

In the good old days, the lack of choice worked towards
keeping familial harmony. Alas! Not any more. At Digit,
unless we test the product thoroughly, we refrain from
recommending any particular brand to our readers.

We suggest that you and your father resolve your
argument using the old-fashioned, time-tested way—by
talking to each other!

Safe before sorry
If you ask me, most spam is a result of our own

mistakes. We type our e-mail IDs at every flashy site
we see. We sign up for offers such as “Win a 40-
inch plasma television”, without realising that it
has spam written all over it.Internet users should make it a point to read the
privacy policy of any site before signing up. Any
decent Web site has an ethical privacy policy. Try
using a different e-mail ID for posting at forums, or
guestbooks, or signing up at unknown sites. It's easy to keep spam away with a little logic.Karan Prasad

Dear Karan,
We are pretty sure most of our
readers know this at the back of their
minds. But rarely do we ever imple-
ment these thoughts. We hope this lit-
tle bit of prodding on your part will go
a long way in stopping spam hitting our
inboxes.

cyberator
Joined:
15 Dec 2003
Posts: 69
Location: Cyber-
shire

jetru
Joined:
19 Mar 2004
Posts: 28
Location: Banga-
lore, India

wow! wat a news! i hope tum fenk nahi rahe! but i don't understand how r they
goin 2 give virtually unlimited capacity, r they goin 2 use the hard disks of the
subscribers 2 store msgs?! neway, google has certainly revolutionized the mail
capacity fight.

“virtually” unlimited. Not “practically”. They’ll probably use compression. Text
can compressed very nicely. Atleast 50 to 75% And better algorithms can do
atleast 80%. But you still gotta pay. I’m not going to pay US$ 50  for unlimited
space. I’ll do fine with even 20 to 30MB. I don’t get much e-mails. Its quality
that we want, not space. Of course, business dudes might need space...

Hotmail takes a lot of time 2 load. I’m waiting 4 gmail 2 b opened 4 public.
but I don’t think it’ll b b4 next 1 or 2 months

Posted: Mon May 17, 2004 7:53 pm  Post Subject: Google offers 1 GB mail

Posted: Mon May 17, 2004 8:18 pm  Post Subject: 

Posted: Fri May 21, 2004 1:29 am   Post Subject: 

From the Forum (www.thinkdigit.com/forum)

Goof Ups

cyberator 
Joined:
15 Dec 2003
Posts: 69
Location: Cyber-
shire

JUNE 2004



features ■
■ technology next

38 JUNE 2004

The Basic Input Output System
(BIOS) has been around for quite
some time, and you have proba-
bly seen it on every PC you have

powered on. Press [Del] or [F1], and there
it is—the blue screen with all those excit-
ing tweaking options. You probably know
what the BIOS does—it makes your
computer evil.

No, seriously, the BIOS does things
such as checking the hardware, checking if
the RAM is functional, and so on. But as
just another piece of software, it’s seriously
limited in features, according to industry
experts. And the same experts also say
we’ve lived with it long enough, and it’s
time to move on.

Enter Microsoft and Intel
Extensible Firmware Interface, or EFI, is the
new framework that Intel and Microsoft
have worked on. It will perform all the
functions that the BIOS does, and pitch in
some more. The two companies will start
an industry forum this year to officially
murder the BIOS as we know it, and cause
the impending birth of EFI. The first PC
with the EFI interface—a Gateway PC—has
already shipped, in 2003.

Essentially, the EFI specification is a
pre-boot environment, which allows a

computer to run diagnostics, scan
for viruses, etc.

If the BIOS is an interface
between the OS and the platform
firmware and hardware, the EFI spec-
ification defines a new model for
this: It comprises data tables holding
platform-related information, as well
as boot and runtime service calls
available to the OS and its loader.
These provide a new, standard envi-
ronment for booting up an OS and
running pre-boot applications.

Intel believes that promoting
the specification as a standard will
help PC manufacturers and please
PC users—by making computers
start up more quickly; by improving
the ability to manage PCs and
servers remotely; and by helping
hardware makers cut manufacturing
and support costs. For example, EFI
PCs will be able to run diagnostic
utilities before loading their OSes. 

Why EFI?
To quote Mike Richmond, of Intel’s
Software and Solutions Group: “In
the long run, we can bring boot time
down, because the EFI framework

Adios,
BIOS!
The familiar beep

you hear when you

turn on your

computer may soon

be gone. Here’s its

new incarnation

Atul Deshmukh

➜
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only has to touch the things it needs to
boot. It also helps the overall reliability of
the computer. In the PC world, we put up
with that stuff, and we shouldn’t.”

Long ago, the BIOS was relatively
straightforward in its design, but over the
years, it’s morphed into a tangled mess,
being changed and updated as and when
new technologies came up. The BIOS
hangover is causing more and more prob-
lems, feels Mark Doran, Intel’s principal
engineer behind EFI.

There are no standards for how a BIOS
is created or configured. An example of the
chaos that exists is that it’s not uncommon
for extension boards from different manu-
facturers to clash in their use of the BIOS.
And if people do use the BIOS to change
configurations or diagnose a problem,
there’s often not much help: Even experi-
enced support staff are often perplexed by
the BIOS. 

EFI promises to change all that. It’s a
tiny OS in its own right. The first differ-
ence you’ll see is in the splash screen:
Unlike the BIOS, EFI supports high-resolu-
tion displays. It can run with a proper
graphical user interface, rather than the

text-only, DOS-like interface. And EFI also
has its own networking, so it can be used
for remote diagnostics. 

There’s a significant change from the
coding point of view as well. The BIOS is
the last place on the PC where program-
mers have to code in assembly language.
EFI is almost entirely written in C, and
allows additions to be created using stan-
dard programming tools. Such additions
can include much more detailed and
useful diagnostics, self-configuration
programs, and ways to sort out problems
even if the OS has hung. For example, if
the OS hangs, you can look at the state of
the machine, change the configuration,
load a different driver, and restart.

And naturally, there will be legacy
support: EFI can behave exactly like a
BIOS, if required.

Intel’s Framework
Intel recently introduced an innovative
concept in BIOS: the Platform Innovation
Framework for EFI. This is a modular, plat-
form-independent architecture that
performs boot and other BIOS functions.
The Framework allows PC makers to write

pre-boot software modules, similar to
Windows drivers. When used with the EFI,
the Framework eliminates the need for a
BIOS. Intel thinks of this as a key boot
architecture that will be modular, flexible,
and scalable enough to last for the next 
20 years or so.

BIOS vs the Framework
Components have changed several times
since the BIOS was first developed. Process-
ing power has increased 600 times, and
hundreds of new peripherals have been
introduced. Over the years, the BIOS has
grown to deal with new components,
larger and more complex chipsets, add-on
cards, and so on. As it grew, it became
increasingly unwieldy. The humble BIOS
simply cannot handle the demands of
cutting-edge architectures.

Intel’s answer to BIOS limitations has
been EFI and the Framework, a modular
architecture based on low-level drivers. It
sits beneath the EFI, and performs boot
and other BIOS functions in a faster,
modular, more flexible way. It’s stored in
firmware, so it’s more secure from viruses
and other types of attack than past BIOSes.

On 27th May 2003, Phoenix Technologies
and Softex unveiled anti-theft software
that uses BIOS-based technology to
disable stolen machines, wipe data and
trace the thief remotely via the Internet. 

TheftGuard is software developed by
Softex, and certified by Phoenix to work
with its FirstBIOS chips and Core Managed
Environment (CME) software. It aims to
give computer makers—and their PC
buyers—a more secure choice of anti-theft
technology. 

Unlike other, though somewhat similar
anti-theft solutions, TheftGuard resides
both in Phoenix’s FirstBIOS and in the
host-protected area (HPA) section of the
hard drive. Removing and replacing the

hard drive, a tactic that can be used to
circumvent some anti-theft concepts,
doesn’t get the thief anywhere with Theft-
Guard in place.

Another trick that can eradicate anti-
theft software—running FDISK to reformat
the drive—is also foiled by TheftGuard’s
place in the HPA section of the hard drive,
which is immune to such reformatting tools.

After a TheftGuard-equipped machine
is reported as stolen to a special Web site,
the stolen PC can be detected when it
next connects to the Internet. At that time,
the computer can be disabled, all data on
its hard drive wiped clean, and an IP trace
put on the connection to determine the
physical location of the system. And

because TheftGuard is integrated with the
BIOS, it can cripple the computer by not
allowing it to boot.

In addition, a simple re-flash of the
BIOS would not thwart TheftGuard: One
would have to be extremely tech savvy to
remove TheftGuard. So much so that most
people who would know how to do this
work for Phoenix! The part of the BIOS
where TheftGuard resides is not updatable
through a flash upgrade.

There are, of course, the privacy
concerns of companies and end-users over
putting a tracer on their machines. Theft-
Guard, however, is optional, and is not
included with every BIOS that Phoenix
produces and ships.

Stop, Thief!

We’ve been through four OS generations and multiple bus
generations, but we’re still on the first version of BIOS. It’s
become, increasingly, a barrier to innovation in the industry.

— MIKE RICHMOND
Manager of platform software in Intel’s Software and Solutions Group

““
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And, it is platform-independent.
Intel’s goal in creating the Framework for EFI was to help BIOS

vendors support the speed, power and innovations of today’s system
architectures. This solution offers full legacy support through the use
of a compatibility support module, or CSM. For systems that do not
as yet have EFI, the support module takes the place of EFI so that the
Framework can communicate with the traditional OS.

The Framework has obvious benefits over traditional BIOS. It: 
■ Improves the reliability of the boot
architecture
■ Shortens boot times
■ Offers full legacy support
■ Eliminates VGA dependency
■ Can be used with any Intel architecture

Because the Framework has a modular, driver-based architecture,
developers can create each BIOS more quickly, and with fewer errors.
Each new BIOS can be built with modules that are already tested 
and verified.

A side benefit to being modular is that the Framework reduces
BIOS size and improves boot reliability. This is accomplished through
firmware. With the Framework, settings are no longer stored in the
CMOS map. Instead, new settings are stored on the firmware chip.
Extra or additional drivers and code functions can be stored on the
hard drive, and accessed there. This makes it easier for OEMs (Origi-
nal Equipment Manufacturers) to add systems features that can differ-
entiate them from other products.

Some of the interesting benefits of the Framework are that it: 
■ Breaks through fundamental BIOS barriers. For example, pre-boot
RAM can now be greater than 1 MB, which means developers can
control how RAM is allocated, and the Option ROM space crunch 
is resolved
■ Allows a developer to compile pre-tested modules into a working
BIOS that is more likely to be efficient and error-free

Insyde Software, a leading global provider of BIOS firmware and
software services, announced its next generation PC firmware tech-
nology. Insyde also announced a product line aimed at replacing the
traditional BIOS. Using 21st century software engineering techniques
and tools, Insyde’s software, which is based on the driver model,
eases the difficulties encountered by PC designers in adapting and
advancing their platform-level firmware. And further, because the
software is written in C, PC makers will have a wider pool of soft-
ware engineers to draw upon (BIOS software has always been writ-
ten in assembly language).

Based on the EFI, this new product line from Insyde debuts
under the brand name, InsydeH2O, representing the 
next generation ‘Hardware-2-Operating System’ firmware inter-
face. InsydeH2O is aimed across a range of market segments,
including Desktop, Mobile, Server and Embedded computing.
Amongst the benefits that InsydeH2O provides to ODMs (Original
Design Manufacturers) and OEMs are:  
■ Compatible firmware and development environment across an
OEM’s entire product line
■ A streamlined method for testing and qualifying PCs in manufac-
turing line
■ Greater productivity and lower costs to developing and main-
taining firmware technology

InsydeH2O

1/2 Page V AD
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■ Allows OEMs to add pre-boot features 
Because the Framework is flexible,

BIOS vendors can also use it to support
pre-boot features for implementations:
For example, BIOS vendors can add differ-
ent types of application that run before
the system boots. Consider what these
could include: 
■ A shell feature that can be used for a
system test
■ A shell feature that boots from shell to
Web browser, directly to an intranet
support page, so that developers have
instant access to information about solv-
ing problems while building the 
current configurations
■ A pre-boot Web browser that automati-
cally goes to a port site and downloads the
latest upgrade files for that server or system 

In the future, the Framework 
could allow: 
■ Self-configuration of systems using 
the Web
■ Call-home-after-crash capabilities
■ The instant-on feature

Phoenix’s TrustedCore NB
Phoenix is not enthusiastic about EFI,
and says it will wait until it becomes a
standard. Meanwhile, Phoenix has its

own plans: The biggest maker of BIOSes
has released the first entry in a line of
next-generation products that it prom-
ises will:
■ Drive utility computing
■ Make PCs more secure
■ Prevent unauthorised users from misus-
ing protected intellectual property

Phoenix believes that rather than
serving just to boot the operating
system, the BIOS of the future should do
much more than just recognizing hard-
ware components.

“The BIOS was designed for stand-
alone devices”, said Michael Goldgof,
senior vice president of marketing for
Phoenix. “Today everything is
connected. Now there are new require-
ments. This is why created the Core
System Software initiative.” 

In addition to trusted computing,
Phoenix plans to build new features in
the software, which is loaded when a
computer system is turned on. CSS,
which extends and replaces the BIOS we
know today, will serve as a component for
network, security, authentication and
system management features.

The Content Management Engine
(CME) TrustedCore NB for notebooks and
tablet PCs is the first product in the CSS
category, designed to extend the BIOS
utility. TrustedCore NB is designed to
allow businesses to keep their mobile
computers safe from identity theft, unau-
thorised network access and uninten-
tional data loss. Future versions hope to
target servers, desktops and embedded
systems such as consumer electronics,
with plans to introduce digital rights
management (DRM) and integrate the
BIOS closer to Windows.

Phoenix’s Core System Software (CSS)
is a next-generation BIOS with a more
sophisticated integration of OS and hard-
ware—for example, it’ll be easier for

system administrators to remotely moni-
tor hardware configurations. It’s built on
a framework that Phoenix calls Device-
Networked Architecture, or D-NA, and is
part of a trend on the part of Microsoft
and Intel to introduce ‘trustworthy
computing’ into their products at a more
basic level. 

A cryptographic engine is inbuilt in
the TrustedCore NB. It can be used to
authenticate digital signatures and
protect the Core System Software, while
the BIOS allows manufacturers to create a
protected area for the secure execution of
inbuilt applications, which is protected
from attacks by malicious code. 

“Through our Core System Software,
Phoenix is making a dramatic change
that will become the basis of networked
computing for the next two decades,”
said Phoenix chief executive, Chairman
and President Albert E Sisto, in a state-
ment. “Today, nearly all digital devices
are connected to a network, whether to
conduct global commerce, or just to
access regular e-mail. This requires an
advanced foundation for implementing
an extensible and flexible architecture
designed specifically for the age of
networked computing.” 

Manufacturers will be able to protect
system recovery and virus protection
applications from malicious code. Self-
management and self-authentication
can be built into devices and servers at a
basic level. 

In a controversial turn, manufactur-
ers will now be able to prevent users from
tampering with areas of the system used
for copy protection. And Phoenix
recently said it is planning a BIOS with
inbuilt DRM technology. 

Phoenix has emphasised that the D-
NA architecture is designed to fit neatly
into Microsoft’s plans for ‘trustworthy
computing’, part of which is the contro-

Booting: The process of starting up a
computer by loading the operating
system. This takes place under the
control of the boot loader program,
usually located in a ROM chip.
Firmware: A term for software embed-
ded in hardware. Such software cannot
be modified.
CMOS: The part of a PC where perma-
nent, un-erasable data resides.
Identity theft: The act of stealing some-
one's personal items, such as laptops
and credit cards, and then masquerad-
ing as that person for personal gain.
Digital Rights Management: This
refers to the control of who has access
to what digital content. For example,
when you download an e-book to read
in Acrobat, Acrobat’s DRM module
checks whether you have the necessary
permission to read that e-book.
Digital signature: A code used to 
verify that someone is indeed who he
or she claims to be. This can be used in 
an encryption scheme to send and 
receive messages.

Jargon Buster

The transition will be from a relatively dumb blue screen to a cleaner, friendlier environment,
where virtually everything pre-boot can be managed effectively and more powerfully

The Impending Change



versial ‘Palladium’
s c h e m e — n o w
renamed Next-Gener-
ation Secure Comput-
ing Base—for build-
ing copy-protection
and security features
tied directly to
computer hardware.

The company is
marketing the Trust-
edCore NB BIOS to
laptop system design-
ers and contract
manufacturers, and
it’s expected that IBM
is a likely customer.
Fujitsu and Samsung,
too, have endorsed
the technology.

The next evil
empire?
If EFI-based software
is accepted broadly, it

could prompt the first major change in pre-boot software in the
history of the PC industry—even though some critics say the
transition may take a while, or may not even happen at all. But
Microsoft will support EFI in Longhorn. Intel will support the
technology in future chipsets.

However, not everyone is jumping on the EFI bandwagon.
Historically, PC makers have been reluctant to change. Also,
some companies might see EFI as a way for Intel and Microsoft
to push their own ideas for the future of PC design.

Intel says such suspicions are unfounded—companies that
decide to go with EFI will be able to use it any way they like,
by picking and choosing different features. EFI users don’t
necessarily have to work directly with Intel, either. They can
work with companies such as Insyde, for example, or use tech-
nology developed by the forum, once it gets started.

In the meanwhile, Phoenix’s plans have been criticised as
crippling PCs’ capabilities, solidifying the Microsoft OS monop-
oly and even, in cases where DRM is introduced, extending copy-
right holders’ power into areas that have traditionally remained
under the control of consumers.

Although EFI may take several years to get up to speed, Intel
chipsets will offer the Framework as an alternative to a BIOS in
2005. The company’s chipsets will support BIOS software for
many years longer. However, as time passes, some chipset features
may be accessible only via EFI.

“After 23 years, it was time to start from scratch,” said Intel’s
Richmond. “There’s a certain life-span
for every technology. You can
expand it and grow it, but at
some point you will have to
start over.”

RAM MOHAN RAO

ram_mohan@thinkdigit.com
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On 19th March of this year, Phoenix
announced a software that enables
notebook users to access their
Outlook data without booting their
PCs. FirstWare Assistant is an
example of how the company wants
to extend the features of the
traditional BIOS and replace it with
its CSS.

It’s installed as an Outlook plug-
in. Before exiting the e-mail
software, the software saves the
most recent status of contacts,
calendar and e-mails in a file that
can be accessed in pre-boot state.
So instead of booting the system,
you will be able to launch 
the FirstWare Assistant upon system
start and access the file within a 
few seconds.

Who needs a Boot?!

1/2 Page V AD
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Sony PlayStation
Portable

The build-up to the launch
of the PlayStation Portable
widescreen has reached
fever pitch. And with the
demo of its capabilities
with Gran Turismo 4
(GT4) at the Electronic
Entertainment Expo (E3),

held in May, the
PlayStation is out to take all

gamers for the ride of their
lives. With 32 MB of main

memory, 4 MB embedded
DRAM, a 4.3 inch, 16x9 widescreen

TFT LCD and 480x272 pixel (16.77 million colours) display, it
flexes some serious brawn.
Price: US$149

▲ ▲

Gizmondo from 
Gizmondo Europe 

At the heart of this neat gadget is a 400
MHz ARM9 processor running Windows
CE, along with a 64-bit graphics
accelerator. This pager-sized gadget
provides 3D Mophun™ gaming,
multimedia messaging, MPEG-4
movie playback, a digital camera, and
a GPRS network link for wide-area
network gaming. Additionally, it contains
a GPS chip for location-based services,
Bluetooth for multi-player gaming, and accepts
MMC card accessories. The pocket-sized game can play on five
continents, thanks to its GSM tri-band capability. 
Price: US$ 351.88

features ■
■ droolmaal

Face the five gladiators in the hand-held
gaming arena

Play
▲▲
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Nintendo DS Metroid 
The closest rival to the PlayStation Portable, if ever
there can be one, is the Nintendo DS Metroid. With the
sounds turned off, it can actually pass off as a PDA. One
of the two screens is touch-sensitive and can be written
on with a stylus. This, combined with Wi-Fi features,
enables you to play such games as Hangman.
Demonstrated recently at E3, this neat device with its
bland design, camouflages seriously high-tech features.
The DS, by the way, means Developer’s System! 
Price: NA

Tapwave Zodiac wireless 
gaming console 
In terms of performance and looks, the Tapwave Zodiac
gives the competition quite a chase. The 480 x 320 screen
powered by the ATi Imageon graphics accelerator delivers
advanced 2D hardware graphics performance. And the
FatHammer X-Forge 3D graphics engine delivers advanced
console-quality 3D games, and other rich 3D content.
Tapwave Certified or Tuned titles, such as MicroQuad,
Hellfire: Apache vs Hind, Orbz and Acedior are available.
Price: US$ 299.99

Nokia N-gage QD Mobile 
Game Deck 
The Nokia N-gage QD is Nokia’s attempt at
wooing gamers away from PlayStation and
Nintendo. It comes with all the features of
a high-end mobile such as SMS and MMS,
etc. The e-mail client can handle the
POP3, IMAP4, SMTP, and MIME2
formats. It comes with WAP XHTML, a
176 x 208 pixel screen with 4,096
colours, and a four-way keypad for
gaming that also doubles up as an
eight-way keypad, depending on the
game. 
Price: US$ 199

▲ ▲
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The Six Degrees of Separation theory,
by sociologist Stanley Milgram,
declares that you are just six steps

away from any person on Earth. Mahen-
dra Sonje, an entrepreneur, experienced it
recently. As the CEO of a software
company, he was seeking an expert in
Assembly language ZAT for his embedded
design project. He met Ram Rao, another
businessman, who fit the bill—not at a
cocktail party, or a corporate luncheon—
but on Ryze, a social networking Web site. 

Welcome to social networking, where
business deals are clinched through an
online profile and offline meetings. Ryze
(www.ryze.com), Linkedin (www.linkedin.com),
Spoke (www.spoke.com), Friendster
(www.friendster. com), Tribe (www.tribe.net), etc,
are just some of the popular Web sites
fuelling this communication exchange.

In the Bible, the Tower of Babel never
got constructed, but contact, communica-
tion and cooperation have been the buzz-
words for centuries. Social networking is the
process of connecting individuals via a one’s
‘personal network’. These networks then
branch out, and allow friends to connect
with people inside their accepted circle.

These Web sites are merely putting
this need to practical use. Big players such
as Google.com and Ebay.com have also
joined the networking bandwagon, and
set up Web sites that allow people to build
contacts online without the fear of

misuse—Google started Orkut.com. So
then what is their modus operandi?

How they do it?
Social networking Web sites build on the
belief that everyone has a network bigger
than they assume. This means that if you
have 10 friends, and each in turn has 10
more, you know 1,000 people indirectly. 

Basic membership is free, and you are
given a Web page to describe yourself and
provide basic information. Ryze allows you
to state what you have and what you want,
while Tribe classifies it into personal and
professional information. Once you regis-
ter, you can view the details of a person,
and decide on adding him or her as a
friend on your page. When your invitation
is accepted, mutual contacts are automat-
ically added as a part of your network.

There are a large number of affinity
listings on each Web site. Ryze calls it its
‘networks’, while Tribe simply calls it
‘tribes’. Web sites such as Friendster and
Emode (www.emode.com) have dating as
their primary agenda, whilst Ryze and
Spoke are mainly for business purposes. 

So you’ll meet small business owners
and SoHo workers, with whom you can
share diverse interests as drama or Reiki.
Register with a group, and widen your
network. The bulletin boards of networks
has posts about jobs, house and product
sales, as well as new venture start-ups.

Has the Web

netted you

friendship,

love, and

possibly

marriage?

Why not

spread the

Net for

business too!

Mahendra Sonje, 
CEO Webatrium Infomedia

3. Krishnan Unni,
Founder Pigtail PunditsSucheta Kelkar, 

Software Developer

4. Vishwas Kasat, 
Proprietor, 

Pioneer Plastic Products
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These Web sites also offer classified
services, so you need not scan the news-
paper for a great deal on a second-hand
car, or a job listing by your dream
company. Ryze also has an offline meet-
ing called the Mixer. Such meetings capi-
talise on online introductions and, with
frequent interactions, develop the begin-
nings of a long business relationship. 

Premium membership offers the
advantage of your own network and the
ability to manage your contacts. 

Ecademy (www.ecademy.com) offers a
whole range of services, right from
managing your meetings, to overseeing
your schedule. Indeed, social networking
Web sites provide just the very platform
to widen contacts that might be the key
to your success. But, are they successful?

Professional benefits
Debjyoti Das, Founder, CEO and President
of Zytes Inc, California, US, and a Linkedin
member, shares his experience, “Suppose I
wish to meet Venture Capitalists (VCs) to
help fund my startup—Zytes. Normally, I
would start asking friends and colleagues if
they would introduce me to VCs. With
online social networking sites, I can simply
look up VCs, research them, make my
plans and then find out who in my
network can help me reach them.” 

Business networking sites are a boon
to entrepreneurs and freelancers. Samir
Jhaveri—an industrialist from Mumbai—
swears by Ryze. He’s a member since
October 2003, and is already reaping
benefits. “I have generated reasonably
big business, especially from offshore
clients. The network has no geographical
boundaries,” he emphasises. Ditto for
Prashant Poladia of Mumbai, who has

bagged five big projects for his software
company, Blue Spot Technologies,
through online networking. 

Konstatin Guericke, Vice President
Marketing Linkedin, California, says,
“We are business-only, and have
5,00,000 members who have uploaded a
total of 20 million qualified business
contacts into the network.” 

Linkedin boasts of over a million
users in software development, telecom-
munications and IT industries. Adds
Mehul Patel, Director, KIPL Net, Mumbai,
“Social networking makes sense for so

many small, mid-sized and SoHo compa-
nies to advertise. They can have their ads
running, for one-tenth of what they
would spend on a search engine, portal,
contest Web site, etc.” Does that mean
that these Web sites are a sure-shot
means to procure instant business?

Krishna Unni, Founder of Pigtail
Pundits, (www.pigtailpundits.com) a Web-
based company, and head of the Mumbai
Business Network Mixer, vehemently
denies this. “An online introduction is
just the beginning—it’s not like you regis-
ter today, and expect crores of business
tomorrow.” Even offline meetings cannot
guarantee instant riches. “One has to
build a relationship and only then can
one expect potential business.” 

Sucheta Kelkar, a freelance software
developer from Mumbai, agrees, “You
never do business with strangers, and the
online profile is just a way to reduce the
strangeness.” She makes it a point to be in
touch with the message boards, and be
present for as many gatherings as possible.

There are many who still haven’t made
a business deal through these Web sites, but
this does not deter them. Rather, they are
confident of the long term gains, and that’s
what keeps them inviting more friends and
acquaintances to such networks.

Headhunters also frequent these Web
sites. According to Patel, “Name the indus-
try, and you have freelancers ready to work
at affordable prices.” Vishal Verma, CEO,
Innovision, a Gurgaon based company
into Web designing and multimedia serv-
ices, also posts regularly on networking
Web sites, when in need of skilled people.
Guericke believes, “Whether you are hiring
an employee, or closing a business deal,
introductions are key.

I have access to three
important people

through just three phone
calls—the US President,
the Russian President
and the Pope!

“
RAM GOPAL RAO, Managing director, Argosy,
Inter Search India Ltd

“
PHOTOGRAPHS: Jiten Gandi
IMAGING: Atul Deshmukh

Rajesh Khanna, 
Founder, Pigtail Pundits

Shreerang Athalye, 
Director & CFO 
Exatt Technologies Pvt Ltd

Harish G Thaker
MD, Harish Exports

Sanjiv Swarup, Manage-
ment Consultant Synergy

Consultants
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However, without an online business
networking tool such as LinkedIn, it’s hard
to know who to ask for an introduction,
and it places a burden on the connector,
which in turn makes it less likely that you
get an introduction.”

Companies have realised the effec-
tiveness of such Web sites for job listings
over conventional job Web sites. The
advantages are obvious—both the
recruiter and the applicant are spared the
harrowing task of going through innu-
merable pages of listings, and the person
is also known to someone or the other in
the network. A certain headhunter claims
to have generated business worth lakhs
just through Ryze. But this does not sound
the death knell for job Web sites—in fact,
these have begun to form groups within
their Web sites for effective searching.

Value to self
Ramgopal Rao, Managing Director, Argosy
InterSearch India Ltd, a global recruitment
firm, declares on his Ryze page, “I have
access to three important people with just
three phone calls—the US President, the
Russian President and the Pope! I am
confident of reducing the phone call to
just one.” Before you begin to be awed
about the person’s address book, you too
can be like him. Surprised? That’s an addi-
tional advantage of social networking—
the six degrees of seperation can be
reduced dramatically.

All networking Web sites let you regis-

ter your personal interests and hobbies.
Ramrao, a businessman, met Abhijit Bam,
another budding entrepreneur, and discov-
ered a mutual passion for cars. The Ryze
Mumbai Business Mixer has an eclectic mix
of a florist, a social activist, IT professionals,
marketing consultants, as well as people
with small businesses. And they are not the
sole such mix. Sridhar Krishnan, Founder

and Chief Technology Officer at
Encover.com, California, also has friends
from India on his network. 

The Bangalore Business Network also
boasts of professionals working in India, as
well as from abroad. Says Deepa Thomas, a
PR professional at Marico, “As a communi-
cations person, I view these Web sites as a
quicker way to reach many diverse people
at the same time—something that even a
concrete association might not offer.”

Verma finds it easier to approach
people online, and is confident of the
support of his fellow networkers for his
new venture. 

The business rationale
Business Developer 2.0, a Fortune Group
magazine, hailed social networking as the
‘Technology of 2003’. That says it all.
Friendster reportedly received $14 million
as venture capital, whilst Spoke was in for
$9 million. Google,the world’s favourite
search engine, has also jumped on to the
bandwagon by launching its social service
engine—Orkut.com.

LinkedIn has almost four million regis-
tered users, while the San Fransisco based
Tribe has 1,40,000 registered users according
to its Public Relations Manager, Valerie
Garing. Ryze has over 200 networks
constantly interacting with each other.
Amazingly, the founders of Yahoo!, eBay
and Netscape are all users of LinkedIn.  

An online
introduction is just

the beginning—it’s not
like you register today,
and expect Crores of
business tomorrow

“
KRISHNA UNNI, Founder, Pigtail Pundits

Mobile phones may be the
answer to enhance social
networking. According to
Ashwyn Kumar Attarwar,
Executive Director, Gametrix
Entertainment Pvt Ltd,
Hyderabad, mobile phones
offer anytime interactivity,
and hence, they will become an
important tool to manage contacts.

With technological advances in both
mobile handsets and network
capabilities, data services are expected
to grow exponentially. 

Gametrix is already engaged in
developing games, animations and
related media content for wireless and
Internet-capable devices. So the next
time you network with a friend in Delhi,
you can invite him to play  chess on
your cell phone!

It’s happening…on
your cell phone

Introduced online, meet offline—the Mumbai Business Network Mixer meeting

“



But is business fool-proof in chat
rooms that run amok with fake and
multiple identities?

According to Verma from Innovision,
“One loophole that is emerging on Ryze is
fake identities. People put up fake infor-
mation and pictures, and derive some kind
of vicarious pleasure from the responses
they get. Another issue is that several
members—especially women—are getting
a lot of unwanted, and at times, lewd
messages from people who use a business
Web site, such as Ryze, as a dating forum.
That is causing them to take their pictures
off their page, and not participate as much
as they would have liked to.”

Rao also talks of networking spam
that floods his mailbox. So, how do Web
sites maintain privacy and prevent spam?

Most Web sites have a strict privacy
policy, which states that the user informa-
tion will not be shared with any private
party. Business networks, such as Ryze and
Spoke, see to it that information isn’t
misused. Spoke, for example, checks a
participating company’s e-mail archives,
contact lists, address books and calendars
to create a detailed map of the organisa-
tion’s internal relationships, as well as
those emanating to other companies.

However, sceptics say that the day
won’t be far when Web site owners will be
tempted to share that private information.

The Register (www.theregister.com) talks of a
dangerous similarity between the privacy
policy of Orkut and Microsoft, which
allows the Web site to share, publish, or
use a user’s information as deemed by the
company. Is this the harbinger of a new
invasion of privacy, where our profes-
sional, as well as personal details, become
publicly accessible?

Present and future
According to Tribe’s Valerie Garing, “Social
networking can capitalise on a quick and
easy process to uncover new information
from one’s social circle, by leveraging
personal and affinity networks to get things
done in their daily lives. This is where we
see the future of social networking—a key
ingredient to a local, online classifieds serv-
ice.”

Das from Zytes affirms, “My value
derivation from Linkedin has crossed a
point where I can even pay for this kind
of service." Some cynics have termed
social networking as a one more Internet
bubble. How long the Web sites will
sustain, is a question worth considering. 

Patel is concerned that the growing
popularity of these Web sites might result
in them restricting replies and providing
exclusive services to paid members. Krish-
nan perceives a threat of fragmentation—
when there are two many functional or
regional groups that crop up and people
tend to gravitate towards the most
subscribed. Rao is also worried about this
kind of online balkanisation—the
confrontation of technology and commu-
nication would be inevitable.

Another likely problem would be
managing contacts. After registering, you
will observe that you suddenly have more
than 100 contacts—including your
friends. How will you manage to keep in
touch with so many? Does this mean that
we need something more to help us
sustain a network of this stature?

Thirty years ago, e-mail invaded our
lives. Today, we chat across continents with
ease, and write our own blogs. Now, the
Internet goes a step further by helping us
make use of our relationships for business
growth. Social networking helps establish a
global contact which would make rela-
tionship guru Dale Carnegie proud.

So, give your business a shot in the
arm, and make sure you don’t get left
behind by your competitors. Start
networking now!

APARNA KRISHNAKUMAR

aparna_krishnakumar@thinkdigit.com
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www.zerodegrees.com 
ZeroDegrees aims to bring people closer
and emulate social behaviour. It plans to
charge its users in the near future.

www.konnects.com 
Founded in 2002, Konnects allows you to
network industry-wise. Your profile here
includes both, your skill sets and your
expectations of future business partners.

www.entremate.com 
Founded in 2003, EntreMate is the
premier online resource that connects
entrepreneurs to start up businesses.
Like a dating Web site, EntreMate lets
you post one or more profiles and
search the database for others that
share your business interests.

www.privinfo.com 
A one-stop-shop that you can use as a
navigator through various business
networking Web sites. Privinfo classifies
these as corporate, business contacts,
job hunting, etc.

More sites to visit

1 col AD



Technologies come and technologies go,
and there are those that make it big...
Here’s a list of 10 that could make a
splash in the next 12 months
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Digital Desi Music 

If you swear by
Hindi music,
and want to

download digital versions of Indian music,
there’s good news for you—downloading
your favourite music will soon be easier.
Music company, Saregama India has tied-
up with Loudeye, a Seattle-based provider
of media services, to distribute its music cat-
alogue to online music stores globally.

And that’s not all. More such tie-ups
with US portals are likely to happen in the
coming months, to
offer digital down-
loads of Hindi music.
The Indian Music
Industry (IMI), the
apex body of the
nation’s music com-
panies, is also plan-
ning a Web site ded-
icated exclusively to
Indian music.

How it works
Napsterism has been
with us for some time now, even if the orig-
inal Napster hasn’t been around. Since
2003, pay-per-download music is big. Web
sites such as Apple’s iTunes have tie-ups with
record labels—these labels share their cata-
logues to be displayed online. One-song
downloads at iTunes cost less than a dollar,
and the money is shared between music
companies and the artists. Royalties are
based on the number of downloads a par-
ticular song sees. There is tremendous busi-
ness potential here—Sony, Wal-Mart, and
even MTV have jumped on the online-
music pad.

Why online music?
How many times you have bought an
entire music CD, or cassette, just for one
song? That’s a major advantage of online
music—you only pay for what you want.
Web sites also allow you to burn CDs, share
your playlists via e-mail, and import music
to Windows Media Player, Music Match,
and any other application that uses MP3,
WMA or Advanced Audio Coding (AAC).
And, as in the US, the cost for downloading
a song in India will soon be far less than
that of an audio cassette.

The Indian music industry
Vijay Lazarus, President and Managing
Director of Universal Music, feels it’s an
encouraging trend for the Indian music
industry to gain international accessi-
bility. Shridhar Subramaniam, MD,
Sony Music India, believes this would be
a demonstration of the global appeal of
Indian music. Even Narendra Kusnur,
music reviewer with Mid Day, a
Mumbai-based daily, feels that avail-
ability of online Hindi music is a

good sign for
an industry
riddled with
piracy and free
music down-
loads.

O n l i n e
music is almost
10 per cent of
business for all
global music
c o m p a n i e s .
Sony has already

made its interna-
tional repertoire available to a number of
content providers, and is available on a
number of sites. The next phase is to digi-
tise and make its global repertoire available.
The Indian repertoire will be officially avail-
able by the end of 2004, on at least two net-
works, according to Subramaniam.
Similarly, the IMI also plans  on having an
iTunes-like Web site that will be a one stop
shop for a whole bunch of Hindi songs.

The IMI estimates that non-physical
formats of music sales contribute five per
cent to the bottom line of the music com-
panies, and is likely to increase to as much
as 30 per cent in the next three to five years. 

The future
The online Hindi music industry is in a
nascent stage. But everyone is opti-
mistic. As Subramaniam says, “The key
task will be to get consumers to start
paying for music online. This will come
with only with a combination of the
right pricing, ease of download, the
right experience, and consumer aware-
ness.” With increased broadband pene-
tration, online music seems all set to
sing some happy tunes.

In a company that indexes 4.5 billion
Web pages, and employs hundreds
of software engineers, you’d never
expect to find a smiling Indian PhD
with a penchant for news and
journalism. However, India-born and
Georgia Tech educated, Krishna
Bharat is not an ordinary
programmer. As Google’s principal
scientist, he developed Google News
in 2003, a service that is as popular
as the world’s favourite search
engine itself.

His latest assignment, however, is
a lot closer to home—Krishna will
head Google’s first offshore
development centre in Bangalore,
which begins operations soon. India
can now officially claim to be
on the world’s search
algorithm map.

PEOPLE TO WATCH

Indian music going digital

Krishna Bharat,
HEAD, GOOGLE INDIA

Saregama India is set to be India’s version of iTunes
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The Great Search Engine War

Wh e n
y o u
t h i n k

search, you think Google! Though Google
has undoubtedly ruled the roost thus far,
they may have to fight for dominance
soon—if Yahoo! and MSN have their way,
that is. Both Yahoo! and MSN are taking
this war seriously.

US-based market researcher WebSide-
Story recently rated Google as the best
search engine, ahead of its rivals. According
to the survey, as of March 23, 2004,
Google accounted for 41
per cent of all Web
referrals—up from 36
per cent in March
2003. Yahoo,
launched in 1994,
and the Web’s
oldest directory,
came in second
at 27 per cent,
down four per-
cent from a year
ago. MSN was placed third at
just under 20 per cent. 

WebSideStory claims to have
sampled 25 million unique
browsers on March 23, and that the one-
day results are indicative of search activity
for the entire month.

Earlier this year, Nielsen/NetRatings
reported that in January, 39 per cent of
active Internet surfers—that’s about 59.3
million unique viewers—used Google
search, while Yahoo and MSN attracted
approximately 30 per cent each.

SearchEngineWatch.com rates Google as
numero uno, based on reader reviews.
Google’s additional features such as cached
links, spell checks, access to dictionary def-
initions, stock quotes, maps, telephone
numbers, etc., have made it popular among
netizens. Yahoo! ranks second again.

In October 2002, Yahoo! shifted to
crawler-based listings for its main
results—these came from Google until
February 2004. Like Google, Yahoo sells
paid placement advertising links through
Overture, a company it purchased in
October 2003. Overture, combined with
Inktomi—another Yahoo! subsidiary—
developed the current Yahoo crawler.

Yahoo! recently unveiled the Yahoo!
search platform—YST. Yahoo! representa-
tives claim that use of their search engine
had increased dramatically due to the
new technology. And Yahoo! has also tied
up with Macromedia to use Flash content
in its search results.

Keep an eye on MSN Search as well. Pre-
viously powered by LookSmart, MSN had
its own team of editors that monitored the
most popular searches being performed to
hand-pick the most relevant sites. Today
MSN has developed its own crawler-based

technology, and plans
to enter the search

engine market in
a big way. 

The Surface
and the
Deep
The Internet is a

lot more diverse,
and its volume con-

siderably larger, than is com-
monly believed. Most people are

aware only of the content presented to
them via search engines, or directories

such as About.com. The largest growing cat-
egory of new information on the Internet,
the ‘deep Web’, is a massive collection of
databases, schedules and research data—
about 90 terabytes of data that don’t find
their way onto a typical search results page.

Yahoo! recently introduced its Con-
tent Acquisition Program, to index the
billions of documents on the deep Web.
It’s collaborating with the Library of Con-
gress, the University of California at Los
Angeles, the University of Michigan, and
Project Gutenberg, amongst others, to
begin populating its index with fresh,
searchable, thus far, unavailable material.

Google isn’t resting on its laurels, either.
They’re said to be working on a project
called ‘Puffin’, which will bring Google’s
search technologies to your desktop. This
move will put it at loggerheads with
Microsoft, rivalling the Windows file system
search—ensuring Google.com remains your
default search engine, and not MSN.com
that Microsoft would connect to. Wait and
watch as the search superpowers battle it out
for world domination.

Is Google’s dominance under threat?

64-Bit Computing
AMD fired off the first salvo by
getting the Athlon FX—the first
desktop PC 64-bit processor.

Intel doesn’t seem to be following
suit, but Microsoft has announced
that they will be launching a 64-bit
version of Windows XP. 

Early days yet, but gamers can
rejoice—upcoming games will have
support for 64-bit processors. Apple’s
G5 is a 64-bit processor, and MacOS
10.3 supports 64-bit computing. PC
software will move to 64-bit as well,
over the next couple of years. It’s a
step into the future.

WAITING IN THE WINGS
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PieCIng an Express

Sunday, 9th
May, 2004:
“ATI readies

PCI-Express versions of X800 Pro, XT.”
13th May, 2004: “SiS has announced that
several motherboards based on their
SiS965L chipset, which features PCI-
Express technology, will be available in
June.” It’s all happening for PCI Express,
and 2004 will be the year when it 
really takes off. But
what is PCI-Express
anyway?

Think of PCI-
Express as an ‘evolu-
tionary’ upgrade to
the PCI bus. The PCI
bus has been with us
for a long time, since
the early 1990s. In
terms of I/O, your
PC hasn’t progressed
much since the 486.
All the data that is
passed by and
between your LAN card, hard drive, PCI
graphics card, sound card and so on, still
uses the same I/O system—the PCI bus.
And all traffic between these devices must
share the same bandwidth.

Why does this need to change? It’s
because of emerging technologies, and
the need for more flexibility in compo-
nent design. The patience of the SCSI,
RAID and Gigabit Ethernet data transfer
technologies is being tested by the PCI
bus, which typically operates at 33 MHz,
and transfers a maximum of 133 MB of
data per second. There are different stan-
dards for the PCI bus, but these speeds are
typical. And the aforementioned tech-
nologies can transfer data at much faster
speeds than that, but they aren’t being
allowed to.

PCI-Express was approved as a stan-
dard in April 2002, introduced by Intel
in partnership with companies such as
Microsoft, IBM, Dell, HP and others. It
is fully backward-compatible with the
old PCI bus standard. Data on the PCI-
Express bus will travel in packets, like
it does on Ethernet. The bus will not be
a parallel bus connecting everything
like a single highway, and through

which all data of all kinds passes at
one, fixed rate, which is what happens
on the PCI bus. PCI-Express will consist
of an assembly of serial—not parallel—
lanes, wired from point to point, and
clocked individually depending on
device. Each lane will consist of two
pairs of data lines, and each lane will be
capable of 32X data transfer rate in each
direction—1X is 2 Gbps. Slots for

graphics cards will
be modular—16X
slots will replace
the AGP 8X stan-
dard. You’ll be
able to plug in a
16X card into a
32X slot, because
of the modularity
of the standard.

What does this
mean? Try and
imagine it this way:
whereas previously
your computer was

a fixed-speed highway with homes all
along the way, it’ll now be a town with
homes, and roads of different widths
between them. To go from one house to
another, you wouldn’t need to traverse
the highway, coping with other traffic—
you could take a shortcut. You could
choose a less clogged road. You could
drive at different speeds, too.

This translates to more flexibility,
more bandwidth, more speed—all of
which stem from the basic architecture of
the standard. Intel has even hinted at a
futuristic vision for servers and desk-
tops—one that would separate the com-
puting unit from the monitor, interface
devices and external drives using PCI-
Express cable connections as a go-
between. Think of this as a computer
more like a stereo system, with compo-
nents stacked one on top of the other,
with cables going between them. 

Intel’s Grantsdale chipset supports
PCI-Express. So will Longhorn. In fact,
graphics cards, chipsets, motherboards,
operating systems, you name it—they’ll
all be jumping on the PCI-Express band-
wagon, because it simply will be the PC
bus standard for some years to come.

Indian-American Tapesh Yadav,
Founder and CEO of NanoProducts
Corporation, Longmont, Colorado,
has 28 patents in nanotechnology,
and more than 30 pending. Dr Yadav
obtained his PhD from MIT; his thesis
in carbon nanotechnologies and
related deliberations provided the
inspiration for NanoProducts
Corporation (NPC). NPC offers a
wide range of nanoscale powders
and nanoscale powder-derived
products, manufactured using
patented processes.

“The first generation of
nanotechnology will just be
performance enhancements to
existing micro-materials, but it’s the
second generation, in about three
years, that will start employing
nano-materials in much
more significant quantities,”
says Yadav.

PEOPLE TO WATCH

This year, bits and bytes are in for some lane driving…

Tapesh Yadav
CEO, NANOPRODUCTS CORPORATION
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Bayesian Spam Filters

The issue of
spam has
been get-

ting bigger over the years, with more leg-
islation, more discussion, and more solu-
tions. Suggestions range from strict anti-
spam legislation, to Bill Gates’ penny-a-
mail proposal. Whatever turn the issue
may take next, it’s certain that spam fil-
ters will play a role in the much-talked-
about battle. And in spam filtering,
Bayesian seems to be the way to go.

Spam filtering is ideally suited to
Bayesian methods in general, which use
past knowledge to predict future events.
Bayesian spam filters
are radically dif-
ferent from other fil-
ters in several ways.

An example of
the this would be a
pure keyword-based
filter, which only
looks at the occur-
rences of words in e-
mails to determine if
a sample is spam or
not. In contrast,
Bayesian spam filters
see causal connec-
tions, amongst other
things. Thus, for
example, even if the
word ‘debt’ is evi-
dence of spam, and the phrase ‘get out of’
is not, a Bayesian filter would learn from
experience, without human assistance,
that the phrase ‘get out of debt’ is indeed
indication of spam.

Another plus is that Bayesian filters
evolve with spam, which means they
won’t be outdated even as spammers
devise newer techniques. And they are
robust—they learn both from positive
examples, as well as negative ones. Thus,
the fact that ‘Bayesian’ hardly occurs in
spam, which is a ‘positive’ example,
makes as much difference as the fact that
‘debt’ frequently does.

An example of a simple Bayesian filter
is a Naïve Bayes Classifier (NBC). An NBC
takes just two factors into account while
filtering spam. The first is the number of
spam e-mails you receive. The second is

the ratio of probabilities of a given word
being a ‘spam’ word to it not being one.
For example, if the word ‘debt’ occurs in
spam with an 80 per cent chance, and in
genuine e-mail with a 2 per cent chance,
this second factor would be 40. 

Surprisingly, NBCs are pretty effec-
tive, even though their working is as
simple as this! PopFile, an open-source
spam filter, uses an NBC. There are
Bayesian filters that use more advanced
techniques, and also combinations of
techniques, but they’re all based on the
same premise—that of learning from the
past, that is, learning from spam and non-

spam e-mails
that have been
analysed earlier.

On one
level, it may
seem intuitive
that Bayesian
methods would
be the most
effective against
spam: we learn
to delete spam
quickly from our
inboxes only
because we’ve
seen such e-
mails in the
past. We learn
from the subject

lines, which are typical, and the senders’
names, which are not. And Bayesian
methods do something of the sort—
learning from past experience. Of course,
they analyse the entire message, not just
the subject lines and senders’ names, so
they have a lot more to draw upon. As a
matter of fact, certain Bayesian spam fil-
ters are actually better than humans at
detecting spam.

From many indicators, it’s clear that
Bayesian spam filters are here to stay.
And probably the best testimony to this
is the fact that Paul Graham, designer of
the Arc language, and a major crusader
in the battle against spam, has this to
say: “Of all the approaches to fighting
spam, from software to laws, I believe
Bayesian filtering will be the single
most effective.”

Analyse, learn, evolve

Longhorn
The much-hyped next generation of
Windows will come with a hefty
hardware requirements tag, but
offers several improvements.
Better access to infomation with the
search-focused WinFS, and a central
Contacts service that recognises the
primary role of PCs as communi-
cation tools are the most significant.

A prettier interface based on 3D
technology and organised around
Tasks is likely to be the most
visible update.

Longhorn promises to change our
idea of how useful an operating
system can be, but by
the time it debuts in 2006, it’s
innovations may already be available
elsewhere.

WAITING IN THE WINGS

The Reverend Thomas Bayes: the Church 
minister behind Bayes’ Theorem
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Computing Convergence

It had to hap-
pen, of
course. Over

the past couple of years, all the hype
about bringing computers ‘closer’ to you
has led companies to realise a couple of
things. First, the PC is a very important
part of family and personal entertain-
ment. Secondly, PDA and smart-phone
sales are skyrocketing, which shows
that people want to be con-
nected on the move.

For a couple of
years now,
s h e l l i n g
out big
money for
h i g h - e n d
PDAs will get
you a device
that works as a
handheld com-
puter and doubles
up as an entertain-
ment device—playing
music and videos from
flash memory. Now, it’s
getting even better. Devices, such as the
Archos AV380 Jukebox, come with full-
fledged 80 GB drives, a large clear screen
and the ability to play hours of high qual-
ity MPEG-4 video, or DivX movies. For
example, Sony’s VAIO Pocket, with  an
inbuilt 20 GB drive and a 320x256 LCD
display can store all your music and even
display your pictures. The Thought per-
sonal video player with a 20 GB hard
drive can give you three hours of non-
stop movie playback.

Add a camera, and it becomes a per-
sonal camera recorder; add an adapter,
and you can rip video straight from a
VCR. Needless to say, you could also
enjoy hundreds of hours of music in
several compressed formats, or store
thousands of pictures.  

Even the big boys have got into the
act—Microsoft’s Portable Media Centre
idea has been eagerly adopted by the
likes of Creative. At CES2004 the Cre-
ative Zen Portable Media Center
received rave reviews, and won the Best
of CES award. Bill Gates featured it in
his keynote address as well.

So what does it offer? Portable Media
Centers are designed to give you easy
access to video, music and pictures on the
go. You can add album art, playlists, con-
tent ratings…the works. The really inter-

esting thing is OS
compatibility—all

versions of Win-
dows XP support
the Media Center
Edition. You’ll
also get the
f a m i l i a r
M i c r o s o f t
in te r f ace—
though it’s
the Portable

Media Center
Platform edition. 
Beyond the hype,

the Creative Zen will fea-
ture a 20 GB or greater hard

drive, a 3.8-inch TFT colour LCD,
rechargeable Li-ion batteries and sup-

port for most audio, video and image
formats. Convergence? It’s already here!
Keep an eye open for the Zen Portable
Media Center device, releasing soon.

Watch Lord of Rings: Return of the
King, as you wait in the admission
queue, or visit an Apple store to
create a home movie. Sounds
farfetched? If Steve Jobs has his way,
then that day isn’t far away. iTunes
and the iPod have revolutionised the
global music industry. Jobs has
moved beyond computers,
and now thinks of a
converging digital world.

PEOPLE TO WATCH

How long will it take for every device we own
to be able to communicate with each other?

Steve Jobs
CEO, APPLE COMPUTER

While digital television delivers
a picture that is clear and
sharp, without the reception
problems associated with
analog TV, High-definition
Television (HDTV) offers you
the best in both visual and
audio quality.

The NTSC format’s
resolution of 480 x 440
(2,11,200 pixels) is miniscule in
comparison to HDTV’s
resolution of 1,920 x 1,080
(20,73,600 pixels)—nearly 10
times the resolution. 

Television networks select
particular Digital Television
(DTV) formats, used by their
respective networks to transmit
HDTV broadcasts. The data is
transmitted by digitising and

compressing the images, which
are then decompressed when
they reach the TV. 

Though HDTV offers better-
than-DVD quality moving
images, it hasn’t made much of
an impact on the consumer
segment, primarily because of
price barriers. Let’s hope that
changes soon, so we can really
being to enjoy our movies.

High-Definition-Television
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Modern Talking…

P2P networks
took off
with Nap-

ster, and you’ve seen a lot of them, as well
as P2P clients, over the past few years—
the Gnutella network, eDonkey, KaZaA,
Shareaza, Morpheus, to name a few.

However, VoIP (Voice over IP) never
really got off to a start. The reasons cited
for its failure range from poor sound
quality, to calls not lasting long enough.
From systems unable to get calls past
firewalls to the big NAT problem.
Dubious as it may sound,
Network Address Transla-
tion (NAT) renders over a
whopping 50 per cent of
home PCs unable to com-
municate with older VoIP
software.

Then there is Skype, a
brainchild of the people
behind KaZaA—Janus Friis
and Niklas Zennstrom. It’s
VoIP over P2P now. The rev-
enue reduction that has jolted
the recording industry may
have the same impact on
telecom companies, if everyone with a just
a computer and a modem began talking to
each other!

“Best of all, Skype does not require
you to reconfigure your firewall or
router—it just works!”, boasts the Skype
Web site. Imagine the magnitude of reper-
cussions. As you are reading this, you
could be downloading Skype for free, and
within a minute, be talking to anyone
else who installed Skype, anywhere in the
world! And Skype even promises that
voice quality is “better than your regular
telephone.” So the bells are tolling for the
telecom industry, right?

That is, admittedly, too drastic a con-
clusion, since there are several other
things that need to be weighed. However,
three things are for sure: P2P is here to
stay; Friis and Zennstrom’s new idea may
be more revolutionary than their first;
and, of course, the telcos aren’t breathing
easy since Skype entered the scene.

So how exactly does Skype work? It
works on the same principle as KaZaA,
and similar clients do. No single server

maintains a database, or is responsible for
the collection and broadcasting of data.
It’s all distributed. Your voice data gets
carried to a computer close to you—a
neighbour. Immediately, this machine
finds another neighbour closer to your
destination and transmits the data there.
The relay carries on until your data packet
gets to the Skype user you are calling.

Actually, it is not as simple as that, of
course. There are issues to be tackled, such
as Firewall and NAT traversal, hurdles to
be dealt with. In this case, Skype uses ‘The

Global Index’ technology,
which is a multi-tiered net-
work. It works around supern-
odes, a special type of nodes
that communicate in such a
way that every node in the
network has full knowledge of
all available users and
resources. So one major
problem, that of a user
knowing that another is
online, is done away with.
Within seconds of your log-
ging on, the activity is propa-
gated all over the network.

There are other concepts involved too,
such as the fact that as more users are
added to the network, the computational
and bandwidth resources of the system
increase proportionately.

Interestingly, while you fear privacy
and security concerns, every packet on
the Skype system is encrypted end-to-
end. It effectively nullifies chances of
eavesdropping.

Well, the story does not end with
Skype. VoIP competitors are about to join
in the race as well. Voipster, an Ams-
terdam-based company, is all set to launch
a corporate competitor to Skype this
month-end. Apart from targeting business
users, the company will charge a monthly
fee for unlimited calls, four-way confer-
encing, voicemail and sharing documents.

So, will Skype live up to its hype?
Probably, yes. As of now, the Skype Web
site reports close to 12 million down-
loads. In fact, Skype is the self-reported
“fastest-spreading software on the
Internet.” Whether it will pass the test of
time—only time will tell.

Is the time ripe for Skype, or is it all just hype?

How broad is your band?
Broadband: (Adjective) A data transmission
technique allowing multiple high-speed
signals to share the bandwidth of a single
cable via frequency division multiplexing.
Bandwidth: (Noun) A data transmission
rate; the maximum amount of information
(bits per second) that can be transmitted
along a channel.

Now you’re probably wondering why
Digit is telling you the meanings of these
two words. Because no home-user in India
has ever experienced this elusive thing
called ‘broadband’.

Cable operators and ISPs shamelessly
display this prominently, on hoardings, on
the flyers, everywhere. The truth of the
matter is that not a single ISP, so far, is
offering speeds that would rival what even
dial-up users in the US take for granted. If
the US is the bandwidth capital of the
world, then we’re a remote village on the
outskirts of civilisation.

Does this mean there’s no bandwidth
in India? No, it means that there’s no such
thing as ‘affordable bandwidth’ here. Stop
dreaming of streaming video, and consider
yourself lucky to be able to download that
200 MB game demo in two days—there
are people worse off you know, and all of
them in a small town near you! 

The only hope we have is that MTNL’s
flat rate Internet scheme forces other ISPs
to give you your capped ‘broadband’
connection for even cheaper.

Welcome to bandwidth hell!

WHINE LIST



61 JUNE 2004

Think Small, Dream Big….

Once upon
a time,
making a

call required the use of a grandfather of
an instrument called the telephone;
watching a movie meant the theatre, or
patiently waiting for good old Doordar-
shan to show one; and for reminders, you
circled your calendar.

Companies have always wooed cus-
tomers by introducing features
that would compete
with our age-old
devices. The future
seems to be very dif-
ferent though. The
emphasis is on tinyness,
and the shift is towards
multi-tasking. All devices
target the individual, who
has grown up with tech-
nology, and is willing to pay to
talk, touch, hear, see and sense at
the same time. 

Giving you a glimpse of what’s in
store for you are four devices that will
change your life forever.

PDAs
Personal Digital Assistants (PDAs) are digi-
tal diaries, albeit a much superior version.
PDAs come with processors, RAM and also
add-ons such as modems, wireless key-
boards, expansion cards, etc. They manage
your address book, remind you of impor-
tant tasks, do necessary calculations, and
have a ready notepad for you to take notes.
The high-end PDAs enable you to access
your Outlook e-mail, browse the Web and
chat. If you are bored, some PDAs have
MP3 players and 3D games. Palm OS, an
old horse at handhelds, has many options
suitable to the varied needs of economics. 

Personal entertainment devices
The Apple iPod can store upto 10,000
songs and it fits in your palm. Marvel-
lous, isn’t it? The days of Sony Walkman
and MP3 players seem passé as compa-
nies such as Samsung and even Microsoft
vie to bring out pocket-sized audio and
video. For the entertainment and music
industry, these are important innova-
tions as they will influence the manner

in which entertainment companies sell
their music and movies. 

Smart Phones
Mobile phones have invented the need-to-
stay-connected professionals, and they just
got smarter. Check out Nokia’s 6600 or
Sony Ericsson’s P900, and you’ll never set-
tle for less. All smart phones work like mini
PDAs with e-mail, Internet and the Inter-
net Messenger using such technology as
Mac iSync software, WAP 2.0 and html

browser. The Symbian Operating System
allows you to add other third-party
software of your choice. These inno-

vations have affected other indus-
tries such as PCs, gaming and Web

Services, who will now make
devices and applications com-

patible with cell phones.
Does this mean a PC less

future? Let’s wait and
watch.

Gaming
Machines
According to
Jupiter Research

forecast, the audi-
ence for portable

gamers will grow from 23 million in
2003, to 43 million in 2009. This means
gaming companies have to incorporate
newer technologies for their loyal fans.
And no one wants to lag behind. Ninten-
do has already unveiled a prototype for
its next generation DS hand-held model,
which will include additional capabilities
such as dual screens and voice recogni-
tion, intended to make game play more
compelling. Sony, on the other hand,
believes that high screen resolution and
fast processors in its upcoming PSP
(PlayStation Portable) will attract players
beyond the age range of children and
adolescents—currently the largest users of
portable video game players.

There is also Nokia’s handheld and
Microsoft’s Xbox. Today’s gaming plat-
forms are already realistic and these inter-
active gaming consoles are all set to usher
in a gaming community that’s up and run-
ning, blowing away their next target as
they travel to work.

LCD Screens
LCD price are falling! Today, an
entry-level 15-inch LCD costs about
Rs 18,000. Though much higher
than CRTs, at least they’re within
reach of the Indian PC buyer.

MFDs
94,000 inkjet-based MFDs and 20,000
laser-based MFDs were sold in India in
2003. Today the entry-level inkjet-
based MFD costs as little as Rs 5,000.
However, most laser-based MFDs are
still out of reach of the Indian buyer.

Digicams
A two mega-pixel digital camera
costs about Rs 5,000—pretty
affordable. It’s no wonder that the
Indian consumer bought 1,05,000
units in 2003, and this figure is
expected to nearly double this year. 

CHEAPLIST

Four mini-gadgets following that line of thinking…
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The Store Age
SACD
The Super Audio
CD (SACD) manu-

factured by both, Sony and Philips Elec-
tronics, can accommodate more than four
times the information of the current CD
format. The extra capacity provides space
for two-channel stereo data, an area for up

to six-track multi-channel data, storage
capacity for text and images, disc varia-
tions, copyright protection, et al.

Launched in 1999, SACD is a new
approach to audio recording and repro-
duction. The extra storage capacity and
better sound quality are likely to make
SACDs a rage among music aficionados, in
the coming months.

SACD uses Direct Stream Digital (DSD)
recording technology to record and play-
back results, at a frequency response of over
100 KHz, and a dynamic range of over 120
dB across the audible frequency range. DSD
increases the resolution of music by fol-
lowing its original waveform more closely.
This results in music reproduction that's
astonishingly true to the original. 

Super Audio CD players can playback
SACDs and all the current CDs. However,
normal CD players can only play hybrid
SACDs-those containing a CD layer. 

SACD captures sound at the full DSD
bit rate, with DSD quality. Producers may
also use the additional channels to faith-
fully reproduce the precise acoustic signa-
ture of the performance space.

Dual layered DVDs
HP, Dell and Philips will start marketing
their double-layer DVD recording devices
in a few months. Discs on these systems
are expected to hold 8.5 GB—that’s four
hours of DVD-quality video, or 16 hours of
VHS-quality video. These companies are

also working on dual-layer recording,
which involves writing data on two sepa-
rate surfaces of a DVD. 

Single-layer recordable DVDs can hold
up to 4.7 GB of data. Retail DVD movies
have the data written on two layers, but
the discs are stamped, not burnt with a
laser, as DVD-Writers do. 

Dual-layer recording has not been
available to the average consumer in the
past. Philips’ Optical Storage division has
announced that their dual-layer DVD
recorders slated for PC use will hit the
markets later this year, along with dual-
layer recorders targeted at the consumer
electronics market.

Paper Discs
Storage has gone from floppies to zip discs,
CDs, DVDs and now, paper discs! Sony
and Toppan Printing have announced a
25 GB Blu-ray disc—51 per cent of the
disc’s weight is paper. Data can be printed
directly on the disc, and it can store more
than two hours of high-definition video. 

The paper discs are easily disposable—
you can shred them with a scissors. They
are also environment-friendly, as they use
an easily recyclable resource.

The Blu-ray disc format uses a blue
laser, and is considered the current red
laser technology’s successor. Blu-ray discs
store more than five times the capacity of
current DVDs—that’s 25 GB of data!  

Discs using organic materials are also
being developed by other companies:
Sanyo’s MildDisc, launched in early April,
is made from polyactic acid derived from
corn kernels. The disc is currently only
available as a CD. This method has
been developed to replace the
polycarbonate used in most
discs today. Also, polycar-
bonate discs aren’t bio-
degradable. 

According to Sanyo,
their MildDisc can be
broken down into water
and carbon dioxide by
micro-organisms in the earth.
They also claim that no harmful
dioxins are released during incineration,
which can be achieved at much lower tem-
peratures than for polycarbonate discs.

At 29, both Larry Page and Sergey
Brin, directors of Google Inc, have the
Web revolving round them. After
having changed the way the world
uses the Internet, they have finally
decided to go for the kill with a series
of new business techniques and an
Initial Public Offering (IPO) worth $2.7
billion (Rs 12,150 crore).

In a letter to the Securities and
Exchange Commission, they said, “The
standard structure of public ownership
may jeopardise the independence and
focused objectivity that have been most
important in Google’s past success, and
that we consider most fundamental for
its future. Therefore, we have designed
a corporate structure that will protect
Google’s ability to innovate and retain
its most distinctive characteristics.” In
effect, subscribers to the IPO will be
offered Class A shares that carry a single
vote per share, while insiders to the
company will retain a right of ten votes
per share.

Though a serious search engine,
Google is notorious for its sense of
humour, visit http://www.
google.com/intl/xx-piglatin/ to get an
idea.

PEOPLE TO WATCH

Upcoming storage technologies to keep an eye on

Sergey Brin and Larry Page
FOUNDERS, GOOGLE.COM
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Next stop: 10K!

You can buy
a simple
TV for less

than Rs 10,000, or a music system with a
DVD, MP3, VCD and CD-R. Seems like
the day of sub-Rs 10,000 computers isn’t
far.

A few months ago, Raj Saraf, MD,
Zenith Computers, commented in an
interview given to CRN, the magazine,
that the ‘sub-10k PC’ is, in fact, a not-too-
distant reality. With hardware prices
plummeting and the government’s go-
ahead to massive duty cuts on imports,
the market was conducive for entrepre-
neurs such as HCL, Zenith, Wipro and
Bitsy Infotech to target the middle-class
consumer base. And it told on NASSCOM
numbers and MAIT projections.

The cheap PC, however, is not any-
thing new: the average PC offered by the
assembler next door has shown a steady
dip in prices since early 2000. It might
not have undergone rigorous perform-
ance tests and quality checks, but it

worked, and no matter how many times
the vendor had to be called up, after-sales
service was always there.

The problem with branded PCs was
that they were focusing on quality, rather
than price.

Black Box, White Box
The trouble was with the software, espe-
cially the OS. For branded machines, the
OS needs to be licensed, while in India,
the assembled PC market runs almost
entirely on pirated versions. PC manu-
facturers devised a clever solution: com-
panies such as IBM and HP decided to
migrate to Open Source OSes such as PC
DOS and Linux. The Express series from
IBM, for example, offer Pentium 4
machines with 128 MB of DDR RAM and
the Intel 845GV chipset, running
Windows XP, at prices less than Rs
40,000. The corresponding multimedia
models with slightly slower processors
are even cheaper. A 2.4 GHz
ThinkCentre A30 with PC DOS bundled
comes at an offer price of Rs 26,900.
What’s more, these machines come with
three-year limited warranties.

But these are still expensive compared
to what home-grown companies have to
offer: Bitsy launched its sub-16K PCs a
few months ago, and Zenith is currently

offering its PCs at below Rs
15,000.

They all decided to go with-
out the OS altogether. This ‘white
box’ experiment has succeeded
in bringing the prices down to
seriously affordable levels. The
elusive 10K wall, however, is
proving difficult to breach. Says
Devita Saraf of Zenith Comput-
ers, “We’ve done a market survey,
and it (the 10K PC) is not possi-
ble, at least this quarter.” So what
will be the configuration of such
a PC, if it comes out? “I have no
idea,” she says. “We will have to
work on it. I can give you some-
thing for about Rs 12 - 13,000
right now.”

The day is nigh
The change in government at
the Centre has brought along a

note of caution among PC resellers. It
should not be too long, however, before
we see PCs being sold alongside televi-
sions and stereo decks. That will be the
day to look out for. Meanwhile, let’s keep
our fingers crossed.

We have done
a market survey,
and it (the 10K PC)
is not possible, at
least this
quarter…

I can give you
something for
about Rs 12 -
13,000
right now.

PCs have just gone below the 15K mark and plan to go down further...

Devita Saraf
ZENITH COMPUTERS

“

”

Mahesh Benkar
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Back to Paper

Wi t h
mounti
ng con-

cern over the depleting rain forest cover in
the equatorial regions, a significant number
of researchers, corporate entities and scien-
tists all over the world, have been working
towards developing a viable alternative to
conventional stationery.

In the early 70s, Nicholas K Sheridon,
then a researcher at the Xerox Palo Alto
Research Center, envisaged flexible com-
puter screens made out of flexible materials
such as paper. His contention was that bend-
able screens would have sharper, clearer dis-
plays, and consume less power. The idea
stuck.

At Gyricon’s Ann
Arbor, Michigan plant,
Engineer Mark Edmond
is working on a ‘display
image board’. The
product under develop-
ment by this Xerox sub-
sidiary is SmartPaper—
thin and flexible polymer
sheeting that can behave
precisely like a computer screen.

On April 8, 2004, IXYS Corporation
announced that its Micronix division had
unveiled the industry’s first standard
product driver for electronic paper displays
based on E Ink Corporation’s electronic
ink technology. The new display driver IC,
the MX834, is targeted at the emerging
market of displays that are easy to read and
consume less power at the same time.

The commercialisation of electronic
paper technology is the result of a collabo-
ration started in 2001 between EInk Corpo-
ration, Toppan Printing and Philips,
together with Sony. EInk uses a process sim-
ilar to Gyricon’s, and has been focusing on
the consumer electronics market.

Philips has come up with something
that uses a form of electronic ink devised
in 1998 by a team at MIT. Their e-ink con-
sists of hollow, transparent plastic cap-
sules containing black and white pigment
powders. Accordingly, they set up a com-
pany, Polymer Vison, to turn their
approach into an industrial process.
Polymer Vision is now setting up a 
pilot production line, and hopes to be

soon producing more than 5,000 e-paper 
displays a year.

Sales of flexible screens would be about
US$ 18 million by 2010 as opposed to US$
311,000 last year, a 60-fold increase,
according to California-based iSuppli Cor-
poration. However, this pales in comparison
to the 29 per cent compound annual growth
rate (CAGR) of LCD revenues to over US$26
billion by the end of 2005, according to Dis-
playSearch, the FPD market research and
consulting firm.  

Market turnstiles: Whose tables
will turn?
According to an American survey, the most
promising market for these new-age prod-

ucts is the sign-painting
market. E-paper could
also enable dailies to save
on publishing expenses.
Digital newspapers may
never get to broadsheet or
even tabloid size, reports
Newsweek, the magazine:
“Costs would be too high.
Initially, digital newspa-

pers would merely receive data from a PC or
a wireless hotspot.”

On a different note, EInk Corp intro-
duced an electronic book reader with Sony in
March, the Sony Librié.  This has the ability of
reflecting natural light—the most important
characteristic of paper—and its surface texture
has a semblance to newsprint.

Innovative use of electronic paper and
ink will help ease the predicament of the
publishing industry, now thoroughly
dependent on pulp paper, and danger-
ously at loggerheads with powerful envi-
ronment groups.

Companies such as Xerox, Eastman
Kodak Co, Royal Philips Electronics, Sony
Corp, etc, have already launched ventures
to get their share of the e-paper pie.
Researchers from Stanford University and
MIT have also expressed interest.

As Bruce Rutledge, President, Chin
Music Press, Seattle, suggests, the simple
pleasures of life will still retain their
appeal—it would be quite some time before
electronic books unseated printed ones
from libraries. Bookworms need not begin
digging burrows as yet.

The Affordable Solutions evangelist
and IIT-Bombay KReSIT (Kanwal Rekhi
School of Information Technology)
Head Deepak B Phatak, is
spearheading a move to get viable
computing solutions for Indians. 

Computing is a big part of this 
and Phatak has just started on his
dream project—that of getting final
year engineering students to work 
on developing useful, quality open
source applications. 

However, open source isn’t
everything in such solutions: “I’d work
with Microsoft if it means a more
affordable solution”,says Phatak, 
who was appointed to the prestigious
Subrao Nilekani Chair in the 
KReSIT School. Here’s to 
more of computing for the
common man.

PEOPLE TO WATCH

The future might resemble the past

Prof. Deepak B Phatak,
HEAD PROFESSOR, KRESIT

Contributors: Meera Vankipuram, Suprotip
Ghosh, Ram Mohan Rao, Aparna
Krishnakumar, Srinivasan Ramakrishnan

Update: In the ‘People to Watch’ box on
Page 52, Krishna Bharat’s designation
has been given as ‘Head, Google India.
Unfortunately, Google clarified after the
page went to print that Krishna Bharat
is, in fact, one of the leaders of a team
that is setting up the operation in
Bangalore. His official designation is
Principal Scientist, Google.
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Share ‘n’
Surf
Nothing brings a
few PCs together
like Internet
sharing software
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It’s your daily grouse. You need to send off an emergency mail,
and your kid, significant other, sibling, or other annoying
co-habitant is using the PC for a far less important task. We

will not recommend you use your fists to win this battle, instead,
we recommend using an Internet connection sharing software
to stretch the Net to your laptop. 

If you have an always-on broadband connection, you need
software with advanced features such as Network Address Trans-
lation (NAT), shared cache, users and groups, an IP list, etc., since
the chances of your system being hacked into increases.

If your work involves applications that deal with streaming
audio and video, online accounting, up-to-the-minute stock
exchange status or telephone conferencing, you need SyGate,
WinGate, or WinProxy, which provide NAT—so many comput-
ers can connect to the Internet, using a single public IP—as well
as the facility to proxy any port.

Suppose connection speeds drop in a largish network, say
your office, which has around 20 computers. You wouldn’t know
whether a colleague is clogging up the pipe, or if you’re getting
less bandwidth from the ISP. Then you need software that moni-
tors bandwidth, and also has the capability to restrict usage by
individual users. Two such are DU Meter and Bandwidth
Controller. Bandwidth monitoring and management tools can
help you towards making important decisions regarding the
packages you use—these software could provide you insight on
bandwidth utilised or unutilised.

Imagine yet another scenario: you’ve taken the initiative to set
up a small network, shared amongst your friends, in your apart-
ment building. You want to distribute an Internet connection
amongst all users. Here, too, you could use SyGate or WinGate.

The point is, whatever your scenario, you’ll find software
specifically designed for the purpose. Keep reading…

Home or small office users don’t use the Internet for anything
but surfing and downloading e-mails, and for them we pres-

ent… AnalogX.
AnalogX is the simplest software we’ve seen. This is indicated

by the interface, which can be worked without documentation—
although documentation is provided. There’s a red and green

signalling system. Green
means everything’s fine,
and red means the proxy
has stopped working for
some reason. 

You start or stop any
of the six services—
HTTP, FTP, SMTP, POP3,
NNTP and SOCKS—by
clicking the appropriate
On or Off buttons. The
logging feature, however,
is simplistic to a fault—
there’s only a text log,

with no auditing, nor history viewer.
There is a hitch, though. You need to configure the e-mail

settings into the Internet sharing aspect. This may be a good
feature for system administrators, but for a home-user, it can be irri-
tating if you have several e-mail accounts to configure.

The proxy binding feature reduces the possibility of misuse by
external users on the Internet to an absolute zero—the server
listens to requests only on the interface specified, which is unavail-
able to external users.

Just like the interface of the program, configuring client-side
settings is simple too. You just need to specify the proxy settings
in your browser with the IP address and default port.

AnalogX

Unlike AnalogX, this software can be run as a service under
Windows NT, 2000 and XP. Security enforcement is based

on the whitelist concept. Avirt Gateway is wizard-oriented,
and has wizards for each operation, right from installation, to
starting and stopping the server. Everything is taken care of
in the elaborate installation process: enabling and disabling
of services such as HTTP, FTP, POP3, SMTP, HTTPS, SOCKS,
NNTP, Telnet and even IRC proxy. There’s support for audio
and video streaming. 

In the advanced settings, you can enable and disable any of
the 20 ports supported. What’s more, you can change the
default ports on which the service runs. If you use a port
number of your own
choice, you reduce
the possibility of
hacking via known
vulnerabilities. You
can set up proxy
cascading in the
installation. Settings
may be customised
after installation.

This software
provides installation
for  the server and for
the client. The
advantage is two-
fold—you don’t have
to worry about the nitty-gritty of the settings, which are taken
care by the client installer; and when you have a client installer,
you need to explicitly set up a client, so an unknown user can’t
misuse Internet access.

Avirt Gateway

Price: Free 
Web site: www.analogx.com/con-
tents/download/network/proxy.htm

AnalogX

Performance
Features
Ease of Use
Overall

BB

Price: Single user – $139.95
Web site: www.avirt.com

Avirt Gateway

Performance
Features
Ease of Use
Overall

BB

The ‘Check if proxy is in open mode’ but-
ton, in conjunction with proxy binding,
helps you bind the software on the local
interface

You can specify either a single IP or a range
of permissible IPs

+ Free; includes proxy binding
– Logging interface insufficient

+ Client installation
– Lacks auditing as well as history
viewing capabilities
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SyGate Office Network (SON) is one of the best network
management software you’d come across. SON’s mixture of

features, as well as the simplicity of the interface, gets it our Best
Value award. The software has features a system administrator
would love, and it has more features than on any other software
on the board.

The ‘Disconnect Client If Idle’ feature is particularly useful:
the server keeps constant track of users, and if one of them is idle
for a certain time, the connection is freed up for someone else to
use. This indirectly helps reduce dial-up costs.

In the bandwidth management aspect, the enforcing system
provides creation
of groups, each
with different
priorities for
applications, such
as e-mail, Web,
Telnet, news-
groups and so on.
Groups can be
created based on
need, and priori-
ties assigned
according to
requirements.

Backup Inter-
net provision is yet another useful feature. If, for some reason,
your broadband connection fails, the software switches to the
dial-up connection, thus providing service with as little inter-
ruption as possible. In a similar feature, the software dials the
backup connection if traffic exceeds a threshold. This feature is
important for people who need up-to-the minute information.

The software supports client installation, and you can also
create a client-install floppy. However, client configuration is
limited to setting the gateway IP to that of the server.

Coming to security, you can install SyGate Personal Fire-
wall (SPF) with SON for free. SPF features Access Rules func-
tionality, by which you can enforce restrictions: you can add
any or all of the 40 rules defined, ranging from FTP, to access
to games such as Quake, and access to IM programs. You can also
custom-define rules.

The activity log is the best across the board, with real-time
monitoring and a history viewer in addition to auditing. The
auditing feature provides lists such as top 10 Web surfers, top 10
traffic users and top 10 sites visited. The activity log is the best
we’ve seen, with real-time monitoring and a history viewer, in
addition to auditing. The auditing feature provides lists such as
top 10 Web surfers, top 10 traffic users and top 10 sites visited.

With a range of abilities such as disconnecting idle clients,
provision for a backup Internet connection, bandwidth
management, etc., this is a true professional network manage-
ment software.

SyGate Office Network

SyGate Office Network

Performance
Features
Ease of Use
Overall

B+B+

Price: $199.95
Web site: http://smb.sygate.com/
products/son.htm

Looking at the top three of the Top 10 is an
excellent way to know who’s using up bandwidth

+ Great features
– No caching; no proxy cascading
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The unique aspect of WinProxy Pro is that in the imple-
mentation of shared cache, it provides the administrator

control over the size of the cache for each of the proxies sepa-
rately. There are separate limits for cache size, as well as for TTL
for HTTP, FTP and Gopher servers.

Security enforcement can be applied by creating users and
groups with each user having a username and password to access
the Internet. To extend security functionality, WinProxy Pro
supports an IP list, similar to the whitelist. This is a much better
approach towards limiting users, as Internet access will be avail-
able only to the IPs specified in the list.

The software records details of failed login attempts. This
information
can be used

by the system administrator to watch out for people trying to
break in. A slightly tweaked demand-dial is a great management
tool. Here, you can specify the time intervals during which
demand dial is enabled.

However, WinProxy Pro doesn’t allow a P2P application on
the client to get connected—which means most ports are
blocked. This could be troublesome to companies relying on
special programs that need some ports to be open.

WinProxy Pro

WinProxy Pro

Performance
Features
Ease of Use
Overall

B+B+

Price: $99
Web site: www.winproxy.net

+ User and group creation, mail
servers, time interval for demand dial
– No bandwidth monitoring and
management, no client-install

WinProxy lets
you configure
the time inter-
vals depend-
ing on day of
week for
demand
dialling

The most eye-catching aspect of WinGate is the clean layout.
With its monitoring features, it could be useful for small

offices. WinGate provides services under two categories—
system and user. System services are programs that provide
services such as DHCP, DNS, GDP, SOCKS, remote control and
Web server. User services do not provide a service of their own;
instead, they forward requests to other servers to get the work
done—such as WWW, POP3, FTP, Telnet, Streamworks and
RTSP proxies.

The software doesn’t have bandwidth management, but it
does provide excellent monitoring. Its assumed-user feature lets
you assign full names based on either the machine name or the
IP address, so all activity is logged under the person’s name,
rather than under the computer name or IP address.

WinGate also provides Traffic Monitor—a graphical inter-
face that shows traffic in real-time. This provides a bird’s-eye
view for the system administrator to monitor current usage. It
also has a history viewer, which helps track usage histories of
individual users. An administrator can administer the proxy
server from a remote location as well, using just a web browser.

The software brings along quite a number of goodies,
such as an integrated mail server and integrated VPN. Addi-
tionally, plug-ins for virus scans and content filtering are avail-
able separately.

A whole bunch of maintenance activities are pre-defined
within the software. With an in-built scheduler, scheduling
events such as ‘Roll over logfiles’, ‘Roll over audit files’, Purge
history database’, ‘Purge cache’, etc. is a piece of cake.

Though it lacks a few features such as proxy cascading and
doesn’t have a shared cache, it performs decently. The bundled
accessories are a bonus, making  it a decent solution for your office.

WinGate

Traffic Monitor provides a real-time picture of bandwidth usage

WinGate

Performance
Features
Ease of Use
Overall

B+B+

Price: $149.95
Web site: http://www.wingate.com/
product-wingate.php

+ Traffic monitoring; free firewall;
integrated mail server 
– No proxy cascading; no shared
cache

■ In port mapping, packets arriving at a particular port are
forwarded to another IP address, in conjunction with the

configured destination port. The configuration comprises five
components: a protocol, the listen IP, the listen port, the
destination IP and the destination port.

■ Network Address Translation (NAT), an Internet draft standard
protocol, is used for hiding your private network behind a single
address or multiple addresses. A similar technique known as IP
masquerading has been extensively used in the Linux world. 
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Squid is an Open Source project that supports HTTP and FTP
proxying and caching, as well as SSL ports, ICP, HTCP, SNMP,

Gopher, etc.
Like most Linux-based daemons, there’s no GUI for configu-

ration. Configuration is difficult, but the feature set is exhaustive.
Couple this with the inbuilt features of Linux such as ‘iptables’,
and you get an extremely powerful and secure Internet server.

There are parameters such as ‘http_access’ for security.
This particular parameter allows or denies access based on defined
access lists. The access list (or ACL) consists of a list of allowable
or not-allowable rules for users connecting to the server. There
are even parameters to restrict the passage of internal network
details to the outside world while proxying requests. By default,
a forwarded request has a header that exposes the internal IP
address to the external world. You can restrict this by modifying
parameters; in this case, the forwarded_for parameter.

Squid provides an effective-user feature, similar to that
WinGate’s assumed-user. By specifying the effective-user or group
in the conf file, you can reduce privileges, thereby reducing the
chances of a hacker receiving root privileges if some Web appli-
cation is hacked into.

Squid gives you ultimate control over all the aspects of Inter-
net connection sharing; you can manage details down to the
micro level, including details such as cache_mem, cache_swap_low,
cache_swap_high, etc.

To get Squid running easily, you have to change or add in a
couple of paramerters—define the visibile_hostname paratmeter
and set up a list of internal IPs on an ACL, then allow access via
the http_access paramter. Thats about it to get it runing,but we'd
recommend a more thougrough customisation of the config file,
to ensure that Squid cannot be misued. You could also set quotas
for users, and cap their bandwidth consumption with squid. 

Using Squid on a Linux box along with iptables, an inbuilt
DNS server, MRTG and more will give you all the functionality
you need, but at the cost of configuration time.

Price: Free
Website: www.squid.cache.org

Squid

Performance
Features
Ease of Use
Overall

BB

Squid

+ Free, provides a lot more control,
add-ons available for free
– Time-consuming configuration

The shared cache feature helps boost performance. So does
a DNS server. First, a DNS server keeps a cache of DNS
entries, thereby reducing DNS lookup time. The second
thing is that with a DNS server, you can create and manage
your domain or sub-domains. This could be useful for
companies that have more than one branch location: one
could create sub-domains such as mumbai.mycompany.com,
delhi.mycompany.com, etc., without needing to register
each separately.

Simple DNS Plus is one of the simplest DNS software.
You don’t need to configure anything, just set up the client
nodes to use the DNS service.

Maintain your own DNS
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Network Address Translation (NAT): With NAT, you get to
communicate with the external world, without revealing the
internal details of the network. The fewer the details
available openly, the more work a hacker needs to do.
Shared Cache: A shared cache can save recent site visits in
its internal buffer for some time. If another user visits the
same Web link again within this period, the software serves
the page from its own buffer, thereby reducing Internet
traffic and at the same time providing a performance boost.
DNS: Humans and computers refer differently to a Web site
location. So when you enter a web address—say,
www.thinkdigit.com—the browser converts it to a numerical
string like 207.68.171.233, which can point to the appropriate
host. This name-to-number mapping is referred to as DNS.
FTP (File Transfer Protocol): The language used by
computers to download or upload file via the Internet,
without the need for an intervening browser.
POP3 (Post Office Protocol 3): The language used by
computers to receive e-mail.
SMTP: The language used by computers to send e-mail.
SNMP: Simple Network Management Protocol; a standard
for gathering statistical data about network traffic and the
behaviour of network components.
Tunnelling: The process by which a request on one machine
is forwarded to another. It helps you secure your main server
behind a firewall.
Client install: The software module in some internet
connection sharing software that helps a user configure clients.
Assumed-user: Using the assumed-user principle, Internet
connection sharing software display client names instead of
the client’s IP, just as cellphones can display the caller’s name
instead of the telephone number.
Proxy cascading: If you need to set up one Internet
connection sharing software running under another, you
need to ‘cascade’ the second. This means the second
software does not have a direct Internet connection; it
depends on the first one.
Whitelist: A whitelist generally consists of names of servers,
clients, senders, etc., who can always be trusted, and
allowed access to the Internet.

Jargon Buster

■ A Proxy acts as an intermediate agent—it forwards
requests from the internal user to the external Web site and

then forwarding the reply back to the appropriate user.
■ HTTPS stands for ‘secure HTTP’. It is responsible for transferring
data on the internet securely—encrypted. 
■ Small Network and diagnostic utilities such as PingPlotter
provide you with graphical statistics that help you identify
problems associated with your network. This software is in turn
dependant on common tools such as ‘traceroute’, ‘ping’ and
‘whois’.
■ Such a enchmarking tool as NetCPS can help you perform a
rigors test of the network infrastructure.
■ A Forensic tool such as Netintercept can help you know how
information travels, or why it doesn’t, on your network.

MRTG is freeware, and is available for both Windows and
Linux. As with many freeware, you need to invest time

configuring. However, if the pre-requisites—a Web server and
PERL—are configured and working properly, the task is easy.

Once the program is configured as a service, it keeps on
updating an HTML file in a specified folder. The HTML file
shows two graphs, one for network traffic and one for
CPU load. MRTG does not provide any kind of management
or controlling.

MRTG

Price: Free
Web site: http://mrtg.hdl.com/
mrtg.html

MRTG

Performance
Features
Ease of Use
Overall

BB

MRTG shows, in graphical format, the current Internet bandwidth
usage, as well as the CPU usage of the server

+ Easy to configure if you have a
Web server and PERL installed
– No kind of management or control
provided

1/4th AD
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DU Meter (DUM) is a small, simple utility that can help you
keep tabs as well as set usage thresholds. It’s basically a meter-

ing application for small office users who wish to keep a tab on
available bandwidth and used or unused bandwidth. 

DUM keeps an eye on the amount of data going out or coming
into a computer. Apart from logging usage statistics, it provides for
a whole range of reports. It also gives you a projected report.

DUM alerts the administrator if traffic reaches a certain
limit or falls below a threshold, or if the dial-up time crosses a
certain threshold.

DU Meter

Price: US$19.95
Website:http://www.dumeter.com/
download.php

DU Meter

Performance
Features
Ease of Use
Overall

BB

This meter shows downloads in red, uploads in green, and both in yellow

+ Simple; administrator alerts
– Low on features

This software is a great tool to split bandwidth into equal pies for
users of a shared connection. The essential element of Band-

width Controller is filters. Once you create the filters, you can view
the statistics over that filter, and also set data transfer rates.

Each filter comprises six components—direction, maximum
data rate, protocol, source IP, source port, destination IP and desti-
nation port. If, by some chance, the filters overlap, the software

indicates a conflict as
well as a way out. You
can then follow the
advice provided, or
make your own rule.

The only disadvan-
tage here is that all
restrictions on data
transfer and viewing of
statistics can be applied
on the IP, and nothing
based on type of appli-
cation used.

Price: $49.95
Web site: www.bandwidthcon-
troller.com

Bandwidth Controller

Performance
Features
Ease of Use
Overall

A-A-

Bandwidth Controller

You can restrict the amount of data that
flows either in or out

+ Precise rate control, detailed sta-
tistics, intuitive user interface
– Restrictions can be applied only
on IP
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If you have Windows 2000 Server, you don’t need proxy
or gateway software: Windows 2000 has inbuilt support
for Internet connection sharing. 

By default, when you install Windows 2000 Server, the
routing component is automatically installed. However, the
Routing and Remote Access service is installed in a disabled
state. To set it up, start Routing and Remote Access, right-
click on the server and click ‘Configure and Enable Routing
and Remote Access’. Now, follow the wizard to set up
Internet sharing. Open Routing and Remote Access by going
to Start > Programs > Administrative Tools > Routing and
Remote Access.

If you want to set up just Internet sharing, with no
routing, right-click on the connection, within dial-up
networking, which is to be shared. On the Sharing tab, select
the ‘Enable Internet connection sharing for this connection’
checkbox, and you’re done!

Windows XP, too, provides ICS functionality, but the
difference is that in Windows 2000, ICS will get enabled only
on dial-up connections; so if you want to share the Internet
connection on two IP addresses or two Ethernet cards, you’ll
need to set up a routing protocol, either IGMP or OSPF. But
in XP, you can enable ICS on the Ethernet card, although you
need at least two Ethernet cards, or alternatively, a pair of
dial-up connections and an Ethernet card.

Additionally, Windows 2000 Server has integrated DNS,
Telnet, FTP, SMTP, POP3 as well as DHCP servers, thus
providing you with everything that you require to set up a
small Internet server.

Inbuilt capabilities of Windows
OSes

WinRoute Pro (WRP) provides excellent NAT functional-
ity, and it’s a strong contender for the title of ‘Most

Secure Software’ for people with an always on broadband
connection.

System administrators would love the control they get over
the dial-up connection. The connection can work on a

d e m a n d - d i a l
basis, or it can be
persistent; it can
also be manually
operated. It
could even be
customised by
time intervals.

To restrict
Internet use to
be work-specific,
you can set up
the Web sites
that are allowed
by the manage-
ment to be
accessed by

users. You can create groups and specify different sets of sites
for each group.

The proxy server bundles along a full-fledged mail server
module with anti-spam capabilities. The software allows for
cache size and TTL to be specified separately for HTTP, FTP and
Gopher. There’s a history viewer as well as half a dozen differ-
ent logs—Debug, Error, HTTP, Mail, Security and Dial log.

WinRoute Pro

WinRoute Pro

Performance
Features
Ease of Use
Overall

BB

WinRoute gives you full control over the
parameters related to caching such as  size,
TTL, etc.

+ Lists of allowed sites, mail server
– No bandwidth management and
monitoring

Price: NA
Web site: http://www.kerio.com/
kerio.html

By default, proxy software binds itself to all the TCP/IP
interfaces present on the machine. The disadvantage of

this is that it will also service requests coming in from the
Internet. This could lead to misuse. By forcing the proxy to
bind to one of your local IP addresses, you can avoid
undesirable side effects.

1/4th AD
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The last word
Whether it’s security for your home
computer, or just a question of sharing
a single Internet connection in your
office, the software mentioned in this
article can do the job perfectly.

The problem is deciding what to
use, depending on your requirements.
Each software has specific and spe-
cialised uses, and to help you make an
informed decision, we’ve made a table
of the features that each software
offers—the table ‘Which One is Right for
You?’, on the left.

We suggest you read through the
table, try and identify your require-
ments, and choose one or a combina-
tion of two or more of the software to
take care of business.

Features/Software

Backup Internet Provision

Bandwidth Management

Installs the client

DHCP

DNS forwarding

E-mail proxy

Integrated Firewall

integrated mailserver

Limits and control user access

NAT

Shared cache

Tunnelling

User/Group-wise access

History viewer

AnalogX

✖

✖

✖

✖

✖

✔

✖

✖

✖

✖

✖

✖

✖

✖

Avirt
Gateway

✖

✖

✔

✔

✔

✖

✔

✖

✔

✖

✔

✖

✖

✖

SON

✔

✔

✔

✔

✔

✖

✖

✖

✔

✔

✖

✖

✖

✔

WinGate

✖

✖

✔

✔

✔

✖

✔

✔

✔

✔

✖

✖

✔

✔

WinProxy
Pro

✖

✖

✖

✖

✔

✔

✖

✔

✔

✖

✔

✔

✔

✔

WinRoute
Pro

✖

✖

✖

✔

✔

✖

✖

✔

✔

✔

✔

✔

✔

✔

Squid

✖

✖

✖

✖

✖

✖

✖

✖

✔

✖

✔

✖

✔

✖

Which one is right for you?

AD
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While installing SyGate, you need to
remember that there’s installation for

both the server side, and for the client side.
After installing the client and the server, the
rest of the installation is a breeze. In the last
step, you can manually configure the
software.

The settings here vary according
to need. We considered a couple

of scenarios.
Scenario 1: You have a broadband
connection wired directly to a hub, and at
the same time, the server machine—
henceforth, the machine that would act as
the Internet server—is also connected to the
same switch. This is called Single NIC mode.

To establish Internet sharing, enable the
settings for ‘Use Single NIC mode’. As soon
as you do this, you get a warning message.
Click OK. 

Scenario 2: If you have two separate
connections, one each for connecting to
the external network and the internal
network, then keep the ‘Use Single NIC
mode’ option unticked. SyGate will show
the appropriate connections in ‘Direct
Internet/ISP Connections’, as well as ‘1.’ in
‘Local Area Network Connection’.

The ‘Direct Internet/ISP Connections’
would have a ‘Local Area Connection’
if you have more than one LAN card or
dial-up connection. To share a dial-up
connection, you would first have to set
up one in Windows, and then add it
in SyGate.

Select the LAN card that connects
your PC to the LAN in ‘1.’ within

‘Local Area Network Connection’.

Once Step 3 is complete, your
configuration is done. But there are

further settings to look at, for better
optimisation of Internet bandwidth and
system resources.

If you have more than one connection,
you need to specify the order in which they
will be utilised, using the [Up] and [Down]
keys. The ones appearing first will be used
first, and so forth.

Dial-On-Demand and Auto
Disconnect are two settings that will

help you keep your dial-up costs to a
minimum. If Dial-On-Demand is enabled,
then each time a user wants to access the
Internet, one of the connections will be
activated depending upon precedence.
Auto-disconnect will keep a tab on no-
activity periods, and disconnect the call.

If you wish, you can configure the
software to set up additional connections if
bandwidth exceeds a certain threshold, by

enabling and specifying the threshold level
for ‘Connect additional line if…’

In the options section, ‘Enable
Internet Sharing At startup’, ‘Enable

Activity Log’, ‘Enable Bandwidth
Management’ and ‘Enable DNS
forwarding’ are recommended. Finally, if
you have set up your network with a
static IP for each PC, untick the ‘Enable
Address Server (DHCP)’ option. A static IP
means that no other machine in the
world has the same IP as yours, which
makes your machine uniquely
addressable. If you’ve manually assigned
IPs to each machine, you don’t need a
DHCP server.

You can modify some of the
advanced settings for DHCP server or

DNS forwarding by clicking on ‘Advanced’
in the configuration window.

If DHCP Server is enabled, you can
specify the IP range that should be used
while allocating IPs. This is particularly
useful if some machines have static IPs and
the others don’t.

If DNS Forwarding is enabled, you
need to specify one or more DNS server
addresses for forwarding to work. Here,
you can either use the DNS server your
ISP has provided—use the ISP’s helpline,
or look up the documentation.
Alternatively, you can use some of the
most commonly used ones, such as those
of VSNL—202.54.1.18 and 202.54.1.30.
You need not specify any settings if you

want to host a DNS server yourself.
The server-side setup, configuration
and optimisation ends here. Now,

you need to configure the clients to be
able to use the server. On all machines
that should have Internet connectivity,
specify the gateway as the IP of the
Internet server you just set up.

In Windows XP, go to Start > Control
Panel > Network Connections. Here, right-click
on the local area connection, and click
Properties. In Properties, click ‘Internet
Protocol (TCP/IP)’ from the list, and then
again click Properties. Now specify the
Default Gateway IP as that of the server IP.

Go to Start > Settings > Control Panel >
Network. Here, click on ‘TCP/IP’, and click
Properties. Go to the Gateway tab, and
specify the server’s IP.

MUSTALI KACHWALA

mustali_kachwala@thinkdigit.com

Eight steps to shared Internet

The configuration window of SyGate. The most
common and the most important settings are
specified here

We used SyGate to set up an Internet server in eight easy steps

Hub/switch

External Internet 
connection

Scenario 2

Hub/switch
External Internet
connection

Scenario 1
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We test the latest and the best hardware and software products available in the market 

➜

This is the latest from
Intel Prescott line, and

comes with a 200 MHz
boost. Apart from the
frequency increase, it also
comes with revised
stepping—hardware
revisions—to iron out the
few chinks that the 3.2 GHz
Prescott had. However,
this doesn’t change
thermal
ratings,
and it still
dissipates
more heat
than the
Northwood
CPUs.

The 3.4 GHz also
comes with 1 MB of L2
cache, 800 MHz FSB and a
new heat sink. It still retains
the 478-pin configuration,
making it compatible with
most Prescott-ready
motherboards.

We plugged the CPU into
an Intel 875PBZ
motherboard, with Corsair
512 MB DDR 400 MHz RAM,
a 120 GB Seagate Barracuda
SATA hard disk and a
Gigabyte 5950 graphics card,
running Windows XP. 

In the business
benchmarks, such as
Content Creation and
Business Winstone from Ziff
Davis, the processor posted
30.2 and 24.2 respectively.
The 200 MHz increase gives

the processor a 4.8 and 1.2
per cent boost respectively,
as compared to  the
Pentium 4 3.2 EE. This
clearly indicates the
advantage when running
applications such as
Photoshop, Maya, etc.

The gaming edge was
pretty close—it

outperformed the
older Pentium

4, including
the 3.2
GHz

Prescott.
However, the

performance boost
isn’t much to write

home about. 
In UT2003, the 3.4 GHz

gave a frame rate of 256 at a
resolution of 640 x 480. The
older 3.2 GHz ran dry at 242
frames. It 
was the same with Sam
Second Encounter.

Overall, the 3.4 GHz
Prescott is a good performer,
but doesn’t justify the price
hike. Why pay Rs 10,000
more for just a little more
performance, especially with
the new 915 chipset, made
specially for the Prescott,
just round the corner.

The BenQ FP991 19-inch
LCD monitor is worth

its price tag, considering its
features and performance.It
offers the highest possible
resolution in the 19-inch
category—1280 x 1024. The
display has both D-Sub and
DVI-D interfaces, along
with the necessary data
cables.

The bezel is just 18 mm
thick, so when you wall-
mount it, it looks like a
futuristic frame. It also has
landscape and portrait
modes—all you need to do
is tilt the screen about 30 to
45 degrees upwards, and
rotate it. The Portrait
PivotPro utility bundled
along adjusts the display so
you can view your

documents when you
rotate it. 

The BenQ FP991
performed wonderfully,
especially in the colour
scale test, where a slide
displays different
shades of a colour. It
managed to
differentiate between all
blocks—a difficult task
for most LCD panels. It
also passed the 16-
colour intensities test,
displaying all of them. 

However, the test
that involved coloured
text on a coloured
background saw it lag.

Magenta text  looked
terrible on most coloured
backgrounds. The reddish
text was not crisp enough
to be read on magenta and
yellow backgrounds—Web
designers and graphic
artists, stay away!

A couple of minuses are
that the panel doesn’t have
an in-built power adapter.
Nor does it have integrated
speakers, which are, these
days, considered standard
accessories. 

Price: Rs 23,990
Contact: SES TECH limited
Phone: 022-26824141
Email: kp@sesindia.com
Website: www.intel.com

Intel Prescott 3.4 GHz BB
Performance
Features
Build quality
Value for money

SPECIFICATIONS

800 MHz, FSB, IMB, L2 Cache,
478 pin, 125 million transistors

SPECIFICATIONS
0.294 mm pixel size, 25 ms
pixel response time, 300 cd/m2

brightness, 700:1 contrast ratio,
76 Hz vertical and 82 KHz hori-
zontal scan rate, 8.5 Kg, 40 W
power consumption

Intel Prescott 3.4 GHz

Price: Rs 47,000
Contact: BenQ India Pvt Ltd
Phone: 022-25705231
Fax: 022-25705235
E-mail: SalesEnquiryIn@benq.com
Web site: www.benq.co.in

BenQ FP991

Performance
Features
Build quality
Value for money

A-A-

BenQ FP991
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As long as the absence
of FM Stereo doesn’t
have you

complaining, the PCTV
Stereo is a good buy. The
new Pinnacle PCTV Stereo is
an entry-level TV tuner, with
a universal tuner: it can tune
to PAL, SECAM and NTSC
signals. It is a sleek, silicon-
based card, which, unlike
others, doesn’t interfere with
the adjacent PCI slot during
installation.

The Pinnacle PCTV Pro,
with its FM Tuner, still
remains one step ahead; this
one is cheaper, though, and
provides similar quality.

Hardware installation was
a breeze: all we had to do was
plug in the card and make
the necessary connections.
The software bit was just as
easy—the wizard hand-holds
you throughout. The card
scanned channels
perfectly—manual fine-
tuning to increase clarity
was not needed.

PCTV has its own
proprietary software, plus a
trial version of Studio8 that

lets you fiddle around with
captured content.

Performance was on par
with the other Pinnacle
cards we’ve reviewed—
content capturing was
almost as good as that of the
Pinnacle PCTV Plus and Pro,
and no frames were
dropped. The highest
resolution supported for
capturing is 720 x 576,
which is MPEG-II high-
quality. 

The enormous Brother
MFC8820D is

competitively
priced.
Looking at its
unique
features and
good
performance, it’s
best suited to busy
office departments
such as accounts,
Public Relations
and sales.

Apart from the usual
functions, the unit can also
do duplex printing, scan 50
pages using the ADF
(automatic document
feeder), and broadcast fax to
as many as 390 locations. 

The MFC-8820D is
supported by a 250-sheet
cassette, with an option to
plug in another. The output
tray holds 150 pages. 

The scanner turned out
decent images. It was quick
too—at 600 dpi, the test
image scan took just four
minutes; other MFDs took

well over six minutes. The
scanner can scan legal-size

documents at 600 x
2,400 dpi resolution. 

Fax is sent and
received at 33.6
kbps. The copier
scans at 1,200 x
600 dpi, and can

print 99 copies. You
can also make
copies of multiple
documents using

ADF, adjust contrast,
set quality and also enlarge or
reduce document size.

The copy function also
returned good results when
dealing with text-based
documents, but images
weren’t copied well at all.
This is probably the biggest
minus for the unit.

SPECIFICATIONS
PCTV Stereo low-profile PCI
board, max resolution captured:
720 x 576, audio cable, IR
remote control

Price: Rs 3,500
Contacts: Pinnacle India
Phone: 011-26445915
E-mail: mgupta@pinnaclesys.com
Web site: www.pinnacle.com

Brother MFC-8820D

Price: Rs 41,000 + taxes
Contact: Godrej & Boyce Mfg Co
Ltd
Phone: 022-55961609
Fax: 022-55961526
E-mail: nad@godrej.com
Web site: www.brother.com

Brother MFC-8820D B+B+
Performance
Features
Build quality
Value for money

SPECIFICATIONS

2400x600 dpi print resolution,
250-sheet paper cassette, 1,200
dpi resolution scanner, 50-sheet
legal-size ADF unit, 33.6 Kbps
fax modem, 40-speed dial, 
32 MB memory, 18.1 Kgs

Humongous! That’s what
pops into your head when

you see the new HP Business
Inkjet 1100D printer. Though
recent times have seen low-
profile printer designs, the
1100D distinguishes itself by

being the opposite.
This is certainly an

expensive printer, but business
pedigree sets it apart. Buy it if
your office prints about 5,000
pages a month.

Performance-wise, the
1100D was blazing fast and
displaced most of the printers
in our recent comparison. Its
unbeatable speed in most of
the tests saw it coming on
top. As far as quality 
goes, it wasn’t the best, but
managed to give professional-
looking prints.

The HP 1100D carries with

it all the features essential for a
business environment. The
printer has four ink cartridges,
and the print head for each
comes separately, for
maximum flexibility. These,
however, might add up to the
overall cost, increasing the
total cost of ownership. 

You get 8 MB of memory—
enough for most print jobs.

The printer is network-ready
and can be hooked up to HP’s
JetDirect print servers that
support many network
operating systems, not just
Microsoft’s suite of OSes.

Price: Rs 14,299
Contact: HP India Ltd
Phone: 1600-444999
Fax: 0124-2566112
E-mail: seema.dawar@hp.com
Web site: www.hp.com 

SPECIFICATIONS
1200x1200 dpi resolution, 
8 MB RAM, 150 sheet paper
tray, USB and parallel ports

HP Business Inkjet 1100D

Performance
Features
Build quality
Value for money

B-B-

HP Business Inkjet 1100D

Pinnacle PCTV Stereo

Performance
Features
Build quality
Value for money

B+B+B+

Pinnacle PCTV Stereo

➜
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The AHS-502 is a
headset caters to

the multimedia
enthusiast. It

comes in a
gorgeous metallic

and black colour
combination with a
cushioned headpad and
closed-cup earpads.

First off, this is not an
option for audiophiles—
don’t compare it with
Sennheiser et al. But it’s a
good option for the general
listener who wants good
sound-quality with a
microphone.

The closed cup earpad
design helps in eliminating
ambient noise to give you

clear and rich quality. The
cushioned headpad is a
welcome feature. 

The headset remote
control is attached to the
main cord. It has sound and
microphone controls.

We ran our usual
battery of tests, connecting
the AH5-502 to a P4 3 GHz
system with an Audigy2
Platinum sound card. It did
not disappoint. 

The bass reproduction
was nice, but at high
volumes, it overpowered
everything else, and sound
quality suffered.  Otherwise,
the bass is thumpy and
ambient, rather than just all

boom. Ideally, it could have
been a little less prominent.
Gamers though might like
this kind of bass. 

With Hindi songs, both
classical and film songs
were rendered faithfully
without any distortion, and
even at high volumes, the
quality did not suffer.

The microphone is good
quality, and showed good
sensitivity.

Altec Lansing AHS-502 headset with microphone

Fujitsu LBP 1120

SPECIFICATIONS
Transmeta Crusoe TM5800
800 MHz CPU, 256 MB
SDRAM, 30 GB hard drive, two
USB 1.1 ports, one VGA port
via adapter, 802.11b
integrated adapter and one
compact flash slot

Price: Rs 1,10,000
Contact: Aci Infocom Ltd
Phone: 022-2826 6031/32
Fax: 022-28250674
E-mail: desmond@aciinfo.com
Web site: www.fujitsu.com 

Fujitsu LBP 1120

Performance
Features
Usability
Value for money

B-B-

The Orite Music Cookie
packs the functionality of

an MP3 player, voice
recorder, FM radio and USB
storage into one tiny oval-
shaped glossy-red device.
With a reasonably good set
of features, jazzy looks and
an affordable price tag, the
Music Cookie can be
considered as an option by
youngsters. However, the 
FM radio performance and
menu navigation need
improvement, and should be
considered before purchase.

Playback quality is
average when headphones
are used; Hindi tracks play
reasonably well, but the
player lacks bass. Voice
recording quality is decent.
The FM radio had problems
catching signals even in

open areas. The 128 MB
solid-state memory is
sufficient for about 23 160
Kbps MP3 tracks at an
average of 5 MB each.
Tranfer rates are fast, and
battery life is quite good.
Music Cookie can display
lyrics inserted into the
tracks using the 2.91
version of Winamp and
Lyrie121. But here’s a
bummer—you can’t create
playlists! You can create
folders, but only MP3

tracks stored in the root
can be played.

The voice-recording
function uses the in-built
microphone to capture audio
in WAV format. The FM
tuner can scan the entire
frequency range, and you
can store eight channels.

Downloading music on to
the Cookie is simple. Plug
into the USB port  on your
PC, and it’s automatically
recognised as a removable
drive on Windows 2000, Me
and XP. You can use
Windows Explorer to
manage files.

SPECIFICATIONS
128 MB flash memory, supports
MP3 format, voice recording,
FM radio, USB storage, 1.5 V
AAA battery

Orite Music Cookie

Performance
Features
Ease of use
Value for money

AA

Orite Music Cookie

Price: Rs 5,450
Contact: Mediatech India
Phone: 022-26361111
Fax: 022-26312222
E-mail: sales@mediatechindia.com
Web site: www.orite.com.tw

Frequent fliers should find
the Fujitsu LBP1120 a

great
travel mate,
especially if they are
looking for an ultra-portable
notebook with decent
computing power. 

Measuring just  1.4 x 9.1
x 6.3 inches, and weighing
just 1.1 Kg, the LBP1120 is
light and ultra-compact by
any standards. 

The LBP1120, as
expected, performed below
par on our tests. But the
focus here is portability and
not computing power. The
battery dies after
continuous usage for two
and a half hours. 

The LBP1120 is
expensive. But If you can
put up with the niggles,
and just need a small
notebook that fits in your
suitcase, then this one fits
the bill.

SPECIFICATIONS
Frequency response: head-
phones—20 Hz~20 KHz; micro-
phone—100 Hz~16 KHz, micro-
phone sensitivity: -40 dB
V/Pascal +/- 2 dB

Altec Lansing AHS-502

Performance
Features
Build quality
Value for money

B+B+
Price: Rs 1,600
Company: Trifin
Information Technology Ltd
Tel: 011-26236061
E-mail: ashish@trifintech.com
Web site: www.altecansing.com
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We tested two cards
based on nVidia’s

latest chipset. The Gigabyte
FX5950, as the name
suggests, is based around the
NV38 core, and is a top-of-

the-line model that a gamer
could die for. On the other
hand, Gainward’s Ultra
1100XT model of graphics
card is based on nVidia’s
FX5900 XT chipset, which
in turn, is a souped-up
version of the NV 35 core.

The massive heat sink on
the Gigabyte card forms the
bulk of its design, and it

looks cool in its metallic
green colour over the blue
PCB background. The
cooling fan runs at two
speeds—it’s slow in the 2D
mode, but speeds up as you
use a 3D application. As

compared to the FX-
5800
cooling
system, the
cooling
system here
is barely
audible.
However,
the massive
heat sink

takes away
adjacent PCI slots. The

Gainward card has a
polished aluminium heat
sink with a two-step
regulated fan in the middle. 

The Gigabyte package was
much better than
Gainward—a welcome move
considering the price. You
also get a Video-In/Video-Out
connector module with the
Gigabyte, while Gainward
makes do with just a cable. 

The Gigabyte card falls a
tad short of winning the
crown from our

performance
winner, Gainward’s
FX-5950Ultra card
(refer to the graphics
card shootout, ‘In
Graphic Detail’, in
February 2004). 

The Gainward FX-5950
belts the Gigabyte card in
most of our benchmarks.
The Gigabyte card hardly
managed to reach within a
hand’s distance of
Gainward’s performance. 

On the other hand, the
FX-5900XT card from
Gainward is a
middle-
tier card

that tries to offer the
best of both worlds.
Although the core and
memory are underclocked
compared to the FX-5950
cards, the Gainward does
offer good performance.   

We played games right
from the good ol’ Quake III,
Serious Sam 2, to the more
recent Call Of Duty, Deus
Ex: Invisible War and
UT2K4, at all possible
resolutions up to
1,600x1,200. The game play
was great—no jerks, no
jagged edges—just pure fun.
Even at
1,600x1,200, all
games ran
smoothly. Turning
on effects to
enhance the

quality does take a toll on
any card, and these two
cards were no different, but
even then the frame rates
were above playable rate. 

Overclocking utilities
come with both cards, and
they allowed for an
incremental increase in
frequency. We overclocked
the Gigabyte card’s core to

500 MHz, which
resulted in a

12 per cent boost in its
score, and it was quite
stable when we did this. 

Priced at Rs 15,875, the
Gainward 1100XT offers the
highest bang for your buck,
offering good performance
at a terrific price. Gigabyte’s
offering burns a hole as
large as Rs 36,000 in your
pocket, but makes up by
offering terrific
performance, superb
overclocking capabilities
and good availability across
the country.

Price: Rs 15,875
Company: Mediatech India
Phone: 022-56396696
Fax: 022-22014083
E-mail: sales@mediatechindia.com
Web site: www.gainward.com

Gainward Ultra 1100 XT

Performance
Features
Build quality
Value for money

B+B+

Price: Rs 36,000
Company: Digi Giga Systems Ltd
Phone: 022-26526696
E-mail: sales@digigiga.co.in 
Web site: www.gigabyte.com.tw

Gigabyte FX5950 Ultra 
GT Edition
Performance
Features
Build quality
Value for money

B-B-

Gigabyte FX5950 Ultra GT Edition and Gainward Ultra 1100 XT 

Gainward 1100XT

450
780

256 MB DDR
D-Sub, DVI and VIVO
WinDVD, Arx Fatalis

Core speed
Memory clock

Onboard memory
Outputs offered
Bundled Package

Gigabyte FX-5950 Ultra

475
950

128 MB DDR
D-Sub, DVI and VIVO

Tomb raider AOD, Rainbow Six
Raven Shield, Arx Fatalis, PowerDVD 

Specs at a Glance

Gainward Ultra 1100 XT

Gigabyte FX5950
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The X4 is a 14-inch
monitor targeted towards

those who want the pleasure
of LCD, at as low as 
Rs 15,000. The price may be
low, but given the average
performance, opt for it only if
you are hell-bent on an LCD. 

Black and silver grey in
colour, the panel can be
tilted and swivelled. Soft
touch menu buttons are on
the right-hand side, but the
speakers are at the last place
they should be—the bottom.
And this is only first step on
its ladder of inadequacy.

We tested it using
different slides of the
DisplayMate Video Edition,
and the results were mixed.
In the colour and greyscale
test, as well as in the
streaking and ghosting test,
results were good. However,
in the white and black level
shift test, the edges appeared

blunt: a red tinge formed due
to the level-shift problem.
The colour purity test didn’t
impress either—red appeared
more like a shade of
magenta, and was darker at
the corners. Also, the
brightness varied between
the upper and lower half of
the screen when we weren’t
sitting upright in front of it.

At US$ 600—Rs 26,400—
OmniPage 14.0 is not

worth it.  First, it’s too 
much of a hassle to get
documents recognised
properly. And second, it’s
extremely sensitive to minor
scanning errors.

We used images of a
variety of types to be
OCRed: a regular Word

document, a fax printout, a
magazine page, and so on.
We found that without
manually setting almost
everything, OmniPage got
thrown off almost
everywhere.

The newspaper scan was
a total mess: the formatting
was askew, and the text in
the output was mostly

junk. The magazine
scan, too, was
disappointing. In fact,
the only document
OmniPage recognised
properly was the laser
printout, which
consisted of plain text
in Courier—a fixed-
width font. The
software even showed
up minor errors with

simple documents that
contained only text in
Times New Roman. Such
errors are not acceptable,
given that you have a
choice—ABBYY FineReader,
which also happens to be
much cheaper.

The price of the CX7300
puts it within reach of

most budget buyers.
However, given the image
quality, we suggest you
loosen your purse strings a
little bit and get a decent
quality camera.

This entry-level digital
camera from Kodak has a 3.2-
megapixel CCD capable of
generating images with a
resolution of 2,096 x 1,560. It
lacks optical zoom, but the
3X digital zoom helps you get
close-ups. However, the zoom
is practically useless, as the
focus gets completely lost,
and so does the colour
reproduction and crispness. 

We were also disappointed
by the image quality of
indoor photos. There was a
prominent green tinge all
over, and in spite of ample
light in the room, the image
was dark. To work around
this, we set the exposure
setting first to 0.5 EV, and
then to 1.0 EV to get a
brighter and detailed image,
but there was just a marginal
improvement. 

Night mode yielded
almost the same image
quality as the 0.5 EV setting,
leaving us with no other fine-
tuning option. You’ll have to

manually set a higher
exposure setting to get a
bright image. 

However, the CX7300
returned viewable images of
outdoor shoots. The image
quality was much better, but
when viewed at actual pixel
size in Photoshop, it had red
and green spots all over. 

The CX7300 has an in-
built memory of 16 MB, and
runs on two AA batteries.
You should be able to pack
as much as 30 to 32 images
of the 500 to 600 KB range
on the internal memory. 

The camera also has an
SD/MMC card expansion
slot—useful for those vacation
photographs that might just
be too much for the default
memory to handle.

Scansoft’s OmniPage 14.0

Kodak CX7300

SPECIFICATIONS
1,024 x 768 resolution, 
0.297 pixel size, 30 ms pixel
response time, 2 W x 2 speak-
ers, 42 W power consumption,
weight: 4.5 Kg

SYSTEM REQUIREMENTS
Intel Pentium III, Microsoft
Windows 98 SE or higher, Internet
Explorer 5.01 Service Pack 2, 128
MB RAM, 135 MB free hard disk
space, 800 x 600 pixel colour
monitor with 16-bit colour or
greater video card and a compati-
ble scanner with its own scanner
driver software

Umax X4 LCD monitor

Performance
Features
Build quality
Value for money

B-B-Price: Rs 15,500
Contacts: Neoteric Informatique
Phone: 022-24172600
E-mail: sales@neoteric-info.com
Web site: www.umax.com

SPECIFICATIONS
3.2 megapixel CCD, 3X digital
zoom, 16 MB internal memory,
±2 EV exposure setting, two AA
batteries, 10 seconds self-timer,
weight: 147 gm

Price: Rs 8,700
Company: Neoteric Informatique
Tel: 022-24172600
E-mail: sales@neoteric-info.com
Web site: www.kodak.com

Scansoft’s OmniPage 14.0

Performance
Features
Ease of user
Value for money

C+C+Price: US$ 599 (approx 
Rs 26,400)
Contact: HCL Infosystems
Phone: NA
E-mail: seigell@hclinsys.com
Web site:
www.hclinfosystems.com

Kodak CX7300

Performance
Features
Build quality
Value for money

BB

Umax X4 LCD monitor

OmniPage failed to recognise simple
words such as the one in this example 
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Attaboy ATi

ATi has launched their X800 series
of video cards, putting to rest the
long awaited anticipation of

their sequel to the Radeon 9700 series.
New technologies such as GDDR3, co-
developed by ATi and Joint Electron
Device Engineering Council (JEDEC),
along with massive changes and
improvements in the R300 graphics
core, have already been implemented 
in this new series, bringing real-
time cinematic effects closer to
consumer desktops.

ATi sent us engineering samples of
the X800 XT Platinum and the X800
PRO. These engineering samples are pre-
mass production cards, sent to various
reviewers to test and give users an
insight into the their architecture.
Remember, there may be differences in
the performance of engineering samples
and the end product you’ll actually
buy—not necessarily worse, the end
product could actually perform better!

The X800 XT features 16 pixel
pipelines, while the PRO version has 12
pipelines. The R420 core contains
approximately about 160 million

transistors, and uses the 0.13 micron
m a n u f a c t u r i n g
process. 

The power
consumption of
this card is on par
with the older
9800 XT and PRO
models. The core
clock speed of the
XT and the PRO
models are 525
MHz and 475
MHz respectively.
Both use 256 MB of
GDDR3, running at 560 MHz (1120 MHz
DDR)  for the X800 XT, and 450 MHz (900
MHz DDR) for the X800 PRO.

The number of VertexShaders in the
X800 has gone up to six, from the
previous four available on the 9800XT,
and it supports VertexShader 2.0. The
memory interface is divided into four
channels of 64 bits (total 256 bits) that
read and write data to and from the
memory at the same time—controlled
by a sequencer logic circuit for
optimum throughput. 

nVidia’s offering, the 6800 or NV40,
introduces shader model 3.0 features (DX
9.0c)—missing in the ATi X800 series. ATi
claims that since current generation
games are yet to implement PlayStation
2.0 features, it will take over a year for
PlayStation 3.0 to be implemented. This
seems feasible, but we feel nVidia is a
better future-proof solution.

Also, the 6800 is a gigantic chip,
with about 222 million transistors, and
requires a hefty SMPS to power it. The
original NV40 runs at a core clock speed
of 400 MHz, with approximately the
same memory clock speed 
(1.1 GHz) as the R420.

We tested the X800’s on both the
latest games, as well as older ones. Our
test-bed was an Intel D875PBZ
motherboard with a 3.2 GHz Pentium 4,
512 MB of DDR 400 RAM and a 120 GB
Seagate SATA hard drive. We used the
latest Forceware 56.72 drivers for the
5950 Ultra. 

We started with an amazing game
called Far Cry. Putting together a PC
that can shore up to its system
requirements costs as much as  buying

a car. We ran the default fort time demo
at both, maximum and minimum

details. This game is one of the
first to implement DirectX 9.0
features such as PS2.0. Even the
X800 couldn’t keep up when
everything was turned on.

We also tested Halo and
Unreal Tournament 2004 with

the default benchmarks. One
major problem is that the CPU

seem to become a bottleneck—evident
from the fact that when we changed the
resolution from 800 x 600 to 1024 x
768, in Call Of Duty, the difference in
frame-rates is negligible, but Halo and
Unreal Tournament 2004 show a drop in
frame rates.

In the Halo tests, the X800XT stood
out with a stellar performance, as
compared to the GeForce FX 5950Ultra,
which struggled at lower resolutions. Call
of Duty uses a heavily modified Quake III
engine. This game gave frame rates
upwards of 200 with both the X800 cards,
while it languished at 109 fps with the
5950—the X800XT out performed it by 88
per cent at the highest tested resolutions.

ATi has a winner on its hands with
the X800 series. The X800 XT and the
X800 PRO are two of the fastest cards
we’ve ever tested. Both cards performed
similarly, but you’ll need a high-end
machine to enjoy these cards to the
fullest, since the CPU and the system
RAM can easily become bottlenecks. 

Other mainstream models are in the
offing, and the pricing of the cards will
vary as mainstream and performance
cards will have different specifications.
ATi has once again set the bar with their
X800 series. For now, we’re dying to 
see the nVidia 6800 do battle with 
ATi’s X800!

BHASKAR BANIK

bhaskar_banik@thinkdigit.com

We got our hands on the hottest new graphic scorchers from ATi, and here is how they fared

Beastly beauties: the
X800 XT and PRO cards

*These games were run at highest quality settings

with 32-bit colour
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do the same?
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Atypical office has a fax machine,
copier, printer and scanner, all in
different locations—often the

first available space. Your daily excer-
cise routine probably involves scanning
a picture, going back to your PC to
print it, picking up the printout,
marching to the fax machine to send it
off to whoever needed it and then
huffing and puffing your way back to
your chair. It’s time you got yourself an
MFD (Multi-Function Device).

A regular MFD is a sort of all-in-
one, with a scanner, copier, and printer
in one package. Mid and high-end
ones also have a fax. An MFD could
have an inkjet or laser printer unit.

A mid-range inkjet printer costs
around Rs 8,000, a scanner about Rs
6,500 and a new fax machine will cost
about Rs 12,000. You do the math!
Instead of spending Rs 26,500 for three
units that use more space and
resources, you can buy a mid-range
MFD for about Rs 18,000.

If you’re looking for a colour copier,
you should opt for an inkjet-based
MFD. High end laser MFDs offer high-
quality copies, but are expensive.

An MFD is very often a viable solu-
tion, but the amount of work done
each day needs to be considered. You
can’t think of an MFD as a workhorse
for one particular type of work. It can
never match up to a dedicated device—
it’s a compromise, but one that could
be worth it.

There’s a Risk Involved
There’s a definite disadvantage associ-
ated with an MFD: if one component
of the device fails, you’ll have to do
without all of its functions while it’s
being repaired.

Another downside is the upgrade
option. You can’t upgrade just the
scanner unit or the printer unit. So
you’re stuck with it—either sell the
MFD and buy a new one, or look for a
buy-back deal from the manufacturer. 

Here are some instances where
buying individual peripherals would be
a better option.
The Printer Unit: Though the quality
of printing units in MFDs has improved

a lot over time, business users, and pro-
fessionals in specific fields such as Web
designing and publishing, will find that
an MFD lacks the quality of a stand-
alone device.

Also, most MFDs only support A4
size paper—so for A3 printing, you
can’t bank on an MFD.
The Scanner Unit: The same applies
for the scanner unit. An MFD’s scan
quality is comparable to a standalone
entry-level scanner. However, users
who need the quality of a prosumer
scanner may get a raw deal. 
The Copier Unit: The cost for a copy
taken on an inkjet MFD is higher than
that of one taken on a regular laser
copier. Also, an MFD takes longer for a
copy. If your work demands include a
large number of copies, it’s wise to
invest in a regular copier.
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First Things First
Remember: if any component of the MFD
fails, you’re going to have to send the entire
unit for repair. Check the warranty and
repair policies.

Printing
MFDs are available in both the laser and
inkjet varieties. The laser option is only avail-
able in monochrome. So, if you will prima-
rily use the MFD as a printer, with the fax
and scanner as secondary peripherals, opt for
an MFD with a laser printer sub-unit.

Copying
When copying documents, speed is impor-
tant, and the copying quality should be
acceptable. Copying a document involves

both the scanner and the printing unit,
which makes it important that they
both operate fast enough to make
for fast copying. Also, make sure

that the MFD can copy without
involving a PC.

If you’re buying a
colour inkjet MFD,
make sure it can scan
in either 24-bit or 30-
bit colour. Other

copying features
should include a range
of reduction and
enlargement settings,

the ability to print 50 to
100 copies at a time, and one-

touch single copies. 

Faxing
Most mid-end and high-end MFDs offer fax
capabilities. Opt for one that offers a sepa-
rate telephone handset. Also check the
capacity of the ADF (Automatic Document
Feeder), the memory presets it offers, and
whether it offers speed-dial. Can it broadcast

to different locations successively, or does it
need someone to manually do the task? Is
there a buffer where incoming faxes can 
be stored until paper is fed back into the
tray? Also, on high-end MFDs, check if the
unit supports features such as caller ID and
voice mail.

Resolutions
You need to look at both the printing and
scanning resolutions. An MFD scanner unit
isn’t meant to replace a high end scanner, so
a scanning resolution of 200 dpi should do
fine. A printing resolution of 600 x 600 is
preferred, though 720 x 360 should suffice. 

Don’t fall for scanning resolutions such
as 1,200 x 1,200 dpi, which are mostly inter-
polated, meaning that the image size is
adjusted in software. This results in disk
space wastage and slows down scanning.

Ink/toner configuration
If you’re opting for a laser printing sub-unit,
check the rated life of the toner cartridge,
since this varies. Opt for an MFD that has
separate tri-colour cartridge, and a separate
black one. It would be great if the MFD lets
you replace the colour cartridge with a black
cartridge, as and when required.

Speed
Check rated printing speed for black docu-
ments in pages per minute (ppm) since it
will affect copying as well as the receiving
of incoming faxes. Since black-ink docu-
ments will be more frequently printed than
colour documents. Scanning rates may or
may not be available, but if the printing
speed is fast enough, it’s safe to assume that
the scanner will function at a respectable
speed. Always keep in mind that colour
printing will be slower than black printing.
Also, the copying speed should be almost
equal to the printing speed. 
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Another aspect is the path the document
is put out through. If the MFD has two sep-
arate scanning and printing output trays,
then it can print the first copy while the orig-
inal is being scanned. MFDs that share an
output path must wait for the original to be
ejected before outputting the copy. Also,
make sure the device can handle enough
paper for your workload.

Cost Per Page
The cost per page is a hidden factor when
you purchase an MFD. The point is that you
cannot accurately determine this until you
begin using the MFD. However, you can cor-
relate; the cost per page mentioned by the
manufacturer will always be somewhat lower
than the real figure.

Memory
Memory can be used to store fax numbers
and to save fax pages when the MFD has run
out of paper, and also during broadcast
faxing. Also look for options such as memory
cards that can be read by the MFD. Compare
the claimed number of phone numbers and

fax pages the manufacturer advertises that
the MFD can store.

Optical Character Recognition
(OCR)
An Automatic Document Feeder (ADF) will
come in handy in situations where you want
to copy or OCR, say, 10 different documents
without manning the device. The ADF
should be able to handle at least 10 pages.
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Advantages
You free up office real estate.
MFDs usually have hotkeys and special

software that make them user-friendly.
Since all the functional units are

combined into a single machine, you
require only one USB port on your PC,
freeing up other ports and reducing wire
clutter.

You have lower running costs compared
to individual peripherals, where you need
to buy consumables for each machine.

High-end MFDs allow you to place the
device on the network without the need
for an intervening PC.

Disadvantages
All the components cannot be used

simultaneously, so if two people need to
use two different functions, they’ll have to
go about it taking turns.

If the printer or the scanner unit
malfunctions, you won’t be able to use the
copier and the fax functions.

Professionals may well turn a blind eye
to these devices as they don’t supply the
kind of print and scan quality they need.

These devices are generally fragile, and
proper handling becomes an issue.
Remember that if you drop this device you
risk losing three or more functional devices.

Advantages and disadvantages of MFDs

In

1998
HP introduced the

WORLD’S FIRST
ALL-IN-ONE

with
COLOUR FAXING

capability.
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Though Microsoft Fax comes bundled
with Windows, but it’s not installed
by default. To install it in Windows

XP, go to Start > Settings > Control Panel > Add or
Remove Programs, and then click on
‘Add/Remove Windows Components’ to
start the Windows Components Wizard. In
the Components list, tick ‘Fax Services’, and
then click Next. If you haven’t installed the
MFD yet, it starts up the Add New Hardware
wizard so you can do so. When prompted,
insert the Windows XP installation CD and
click OK. Finally, close all Windows.

If you’re running Windows 98, you can
install Microsoft Fax from the Windows 98
installation CD. Browse to ‘Tools\OldWin95\
Message\US’ and run Wms.exe first, and then
Awfax.exe. Configure Microsoft Fax by going
to Start > Programs > Accessories > Communications
> Fax > Fax console to bring up the Fax Config-
uration Wizard. Click Next on the Welcome
screen, and fill in the Sender’s Information

on the next screen.
This information will

appear on the fax cover
page. Click Next, and
choose the MFD that you
want to use to fax. Here,
choose the appropriate
option to specify whether
you want to use that MFD

only to send or to receive faxes, or both. If
you choose to receive as well, you will have
the option of manually answering the call,
or answering it automatically after a cer-
tain number or rings.

Click Next and type in the Transmitting
Subscriber Identification (TSID) that usually
consists of the sender’s fax number and name,
and appears in the header area of a received
fax. In the next screen, type in the Called Sub-
scriber Identification (CSID) that appears on
the sender’s machine and helps ensure that the
fax is sent to the correct recipient.

Click Next, and you’re asked what to do
when a fax is received. Choose ‘Print it’ if you
want the fax to be printed automatically. You
can also choose to create a local copy of the fax
by clicking ‘Store a copy in a folder’ and spec-
ifying the folder. Click Next, review the set-
tings you chose and click Finish to complete
the configuration.

You may change the settings anytime by
going to Tools > Configure Fax in the Fax Console.

Once you complete the Configuration
Wizard, the Fax Console opens up. The
Incoming folder in the Fax Console contains
faxes that are currently being received; the
Inbox folder contains faxes that have been
received; the Outbox folder contains faxes
scheduled to be sent; the Sent Items folder
holds faxes that have been sent successfully.
To create a new fax, click ‘New Fax’ on the
toolbar, or go to File > Send a Fax. This will start
the Send Fax Wizard. Click Next on the Wel-
come screen and enter the recipient’s infor-
mation, and click Add to add that entry to the
recipient list. You can add multiple recipients
and build an address book.

Click Next, choose a template and enter
the subject and note for the fax, to prepare
the cover note. Specify the priority of the
fax, and when you want to send it, on the
next screen. The final screen shows you the
fax summary and also gives you the option

Workshop:The fax of the matter

Make sure to set all the
respective settings correctly,
and you can make sending
and receiving faxes a snap

HP
ALL-IN-ONE

is the first to introduce

NETWORK CAPABILITY
in 2000,

BUILT-IN NETWORKING
in 2003.



to preview it. Click Finish, and voilà! You’ve
just sent your first fax.

What if you need to fax an MS Word doc-
ument? Use the Fax printer that’s installed
along with Microsoft Fax. To fax a file from
any application, go to File > Print, select the Fax
printer in the Print dialog box and click OK.
This starts the ‘Send Fax wizard’ that lets you
specify the receiver as mentioned above.
Coming to the receiving part, if you have con-
figured the machine to receive faxes automat-
ically, then you don’t need to do anything.
Click the Receive Now button on the toolbar
of the Fax Console, if you have configured it
to receive the fax manually. Alternatively, acti-
vate the Fax Monitor by going to Tools > Fax
Monitor and click Answer Now.

Network faxing
Though quite comprehensive, Microsoft Fax
lacks features such as network faxing. You will
need powerful software such as Symantec’s
WinFax Pro 10.0.  The setup is straightforward.
Once it’s complete, the first screen asks you to
enter the CSID (Called Station Identification),
your fax number and your phone number.
The second screen asks you to choose MFDs
and other devices that you want WinFax Pro
to use to send faxes. 

Next, the chosen MFD is tested to deter-
mine speed and other parameters. Once this is
done, specify whether you want WinFax Pro
controller to start up with Windows. You can
receive faxes via e-mail by enabling that
option in the next screen.

All you need to do is choose the e-mail
program and enter a password. If you wish
to skip the registration step, click Cancel.
Finally, Live Update starts to update WinFax
Pro—this can also be skipped by clicking on
Cancel. That’s it!

Sending a fax
Bring up the WinFax Pro Message Manager—
the centre point for all of your fax related
tasks—by going to Start > Programs > Symantec
WinFax Pro > WinFax Pro Message Manager. Go to

Send > Send New Fax…, or click Send on the
toolbar to bring up the WinFax Pro dialog box.
Here, click on an address book entry to insert
the name and fax number (or enter them man-
ually), and then click ‘Add to List’. 

Also, schedule the send time for individual
recipients by clicking on Schedule. Next, to
create a cover page, choose ‘(Other…)’ from
the drop-down list that’s located just below the
subject field, to bring up the ‘Select Cover
page’ dialog box. Choose from the many pre-
defined templates here, and add the note and
the subject that appears on the cover page of
the fax. Finally, click Send.

You can view the status of the fax—
whether it failed or was sent successfully—by
clicking Send Log in the Message Manager. If
you want to send a fax as an e-mail, click Send
on the Message Manager window to bring up
the Send dialog box. Here, click ‘Email’ on the
toolbar. A new
dialog box opens
where you specify
the address of the
fax recipient, the
subject and the
message. Next,
click Insert to
insert files, and
click Send when
you’re done. This
fax will be sent
the next time you
open your e-mail
client. 

The advan-
tage of sending a fax to e-mail is that your
Word files, etc., can be viewed by anyone, even
those who don’t have Word installed; sec-
ondly, it gets sent in an unalterable format.
When you send fax to e-mail, it is sent as a
self-executing file that can be viewed on any
Windows PC. 

Receiving a fax
Check whether automated fax receiving is
enabled by right-clicking the fax icon in
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Scanning multiple documents and running
them through OCR software one at a time can

be time consuming. To speed up this
process, you can get OCR software that
has a batch feature. Using this feature,
multiple documents can be scanned and
OCRed without wasting time. 

To use this feature, the MFD must
have an Automatic Document Feeder
attached to the scanner. The capacity of
the ADF will decide how many copies
can be scanned in one shot without user
intervention. We used ABBYY
FineReader 6 CE for this workshop—it
has the batch feature. Here are the steps
to get the batch feature work for you.

Scan all documents as an image into
a folder using the ADF. Go to File and
click New Batch. Now, create a new
batch on the hard drive.

Open this batch by going to File >

Open Batch, and in the dialog box that opens
up, select the batch folder from the location.
Now click ‘Open Image’ and click ‘Open
Image’ again. This will open up the dialog
box from where you can browse to the batch
folder where the images were saved.

Select all the images to be OCRed. Once
the files are selected, open them all—they
will show up on the left of your. Click the
‘Read all’ button, and sit back while the
images are read by FineReader.

Once the recognition part is over, click
Save, which will present you with the option
to save the document as Microsoft Word,
Excel, or text. Choose the file format, and all
documents will be saved accordingly.

If you have fewer documents—10, for
example—then there’s a feature called Scan
and Read Multiple Images. Using this feature,
you can scan the documents in the ADF, and
FineReader will read the scanned images. 
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your System Tray to show the controller
menu. If ‘Automatic Receive’ is enabled,
faxes will be received automatically. If it is
unticked, you’ll have to right-click the
System Tray fax icon, and click ‘Manual
Receive Now’ or go to Receive > Manual Receive
Now in the Message Manager window to
receive the fax.

You can customise the fax receiving
settings even further by going to Start > Pro-
grams > Symantec WinFax Pro > Program Setup >
Receive and then selecting Properties. Use
the options in the General tab to specify
the number of rings after which the call
should be answered. Specify the time when
you want calls to be answered automati-
cally by clicking on Schedule.

Decide the action that has to be taken
after a fax is received, such as playing a

sound or printing it, in the ‘After Receive’
tab. In the ‘Junk Fax’ tab, you can specify
what to do with junk faxes—faxes with a
missing or incorrect CSID. In fact, there are
lots of features that can be customised in
WinFax Pro. For this, you will have to go to
the Program Setup located in the Start > Pro-
grams > Symantec WinFax Pro group.

Here, you will find options for backing
up and restoring your faxes and logs, and
other things. That’s the way you get your
PC to double up as a fax machine. You can
also try setting it up using faxing software
that comes with the MFD driver installa-
tion CD. 

These software have made faxing less of
a tedious job. So the next time the boss
needs to send something urgently, all you
have to do is use the PC!

The Save Wizard lets you choose the for-
mat in which you want the file to be saved
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Learn how to put
the most
commonly used
printing
technology to
work—print 
T-shirts, share it
over a network,
and much more...
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■ Set the printer driver settings correctly. 
■ The best results will be achieved by
matching the printer, printer settings, ink
and paper.
■ Handle inkjet papers like photographic
papers, by the edges to avoid oil deposits
and fingerprints.
■ Be sure that you are printing on the ‘right’
side of the paper, that is, the coated side.
■ Best image quality (sharpness and colour
saturation) is usually obtained at the
printer’s maximum dpi setting.
■ Set your printer for the proper paper type
and weight. Fine art papers are heavier than
ordinary inkjet or bond papers. If possible,
set printer to thicker paper settings, or use
the ‘envelope’ setting.
■ Feed heavy/stiff paper one sheet at a
time. Placing a sheet of plain copier/bond
paper behind a heavy sheet sometimes
improves the feed.
■ Media settings on your printer

determine how much ink will be applied to
the paper. Thinly coated glossy films
require less ink, while plain paper soaks in
more. Coatings are designed to control ink
absorption and spread, producing brilliant,
sharp images with less ink.
■ Allow ink to dry completely to avoid
smudging. The time it takes to dry will vary
based on the ink and paper quality used as
well as the temperature and humidity
conditions.

How to Get the Best Quality
Printouts
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Who needs a PC to get a
digicam print out?
Well, that is exactly what the PictBridge is
here for. Developed by Camera and
Imaging Product Association (CIPA) in
Japan, the technology connects digital
cameras directly to the printer, doing
away with the PC. 

PictBridge cameras and printers can
be connected over a USB interface and
images printed directly. You can even
tweak the image settings from the
printer itself. Earlier, some printers

could print directly from a camera, 
but they were compatible only with
specific camera models.

With PictBridge, you can even select
a portion of an image and print it. You
can also define the size of the print from
the printer itself, before printing it out. 

Canon, Sony, Sanyo, Samsung, Fuji,
Nikon and Olympus have their products
PictBridge-certified. Visit http://www.cipa.
jp/pictbridge/CertifiedModels/PictBridgeCert
ifiedModels_E.html for a full list of
PictBridge-certified products.

PictBridge
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■ Opt for a printer with a USB interface,
which offers higher data transfer speeds.
There is nothing like a printer offering both
USB and parallel connectivity.
■ Consider the total cost of ownership (TCO),
not just the price. Vendors tend to sell printers
dirt-cheap. Prices of cartridges, though, are
skyrocketing. If you have tons to print, even a
minor difference in the cost per page will save
you a lot over the printer’s lifetime.
■ Check whether the printer supports extra
features such as ink status determination via
software, so that you can be sure of when
to change the cartridge.
■ Inkjets that use pigment-based inks are
better than those using normal dye-based
inks. Printouts taken with the former are
smudge-proof, water-resistant and last longer.
■ Choose a printer based on the kind of
print quality you actually require. Inkjet
printers offer excellent quality as far as
images and graphics are concerned,

whereas laser printers offer better quality
text printouts.
■ If you’re planning to buy an inkjet printer,
make sure to check the page per minute
(ppm) speed. Manufacturer-rated speeds are
always in accordance with the printer’s
fastest mode of printing, and you’re more
likely to be printing in Normal or Best
mode, which is much slower.
■ If you intend to share the printer over a
network, or print heavy images, look for one
with higher buffer memory. 
■ If you are buying a printer for photo
printouts, always take a test print to check
for quality. Some printers require a separate
ink cartridge for photo quality printouts,
while some don’t. Check for this, as it
affects the TCO.
■ Check the manufacturer’s Web site for the
type of support they offer, whether they
offer regular software updates or patches for
new operating systems.

If you are sharing your printer over a local
area network (LAN), you probably want all
users, running any version of Windows, to

be able to use it, right? If you are running Win-
dows 2000 or XP, you should install additional
drivers, so that Windows 98 users don’t have to
look for drivers to use your printer. 

Go to Control Panel >
Printers, right-click on the
printer icon and choose
Properties. In the Sharing
tab, click on the ‘Additional
Drivers...’ button.

Now you need to select
each operating system’s
drivers. For example, if
your host OS is Windows

XP, and you wish to share the printer for
Windows 98 and Me machines then select
Windows 98/Me. now all you need to do is
insert the driver CD and wait for the instal-
lation to finish. You might have to select
the exact path for each additional operating
system that you selected. Once done, any-

one running any of the
OSes that you installed
drivers for, can justdouble-
click on the printer to
install it. Do this by going
opening Network
Neighborhood, browse to
the computer connected
to the printer and double
click on it.

Installing additional drivers

Select the various Windows versions that
you want to install drivers for, and click OK

Buying Tips



Select the image file that you wish
to transfer onto your t-shirt. To
print the file, set the printer set-

ting to Best quality and paper type to
Transfer Paper. You also need to check the
Mirror option. Before you print the image
on your costly transfer paper, print it on a
normal paper in order to ascertain the
colour and size of the image. 

Take a T-shirt and place it on a flat
surface, so that the under surface
does not bend and provides even

heating to all parts of the paper.

Place the Iron-on transfer paper
with the printed side down on
the T-shirt and arrange it prop-

erly, so that the edges are parallel to the T-
shirt’s edge.

Set the iron to the maximum
heating possible and move it over
the iron-on transfer paper, such

that it receives even heating across the
entire area.

Take care not to over heat the
paper. Stop ironing when 

the paper turns slightly dark 
in colour. Start peeling the paper from 
one edge.

As you peel one edge off the
paper, check if the transfer has
taken place. Continue to peel

slowly, with one hand holding the T-shirt
in place.

After peeling the paper you 
will see a plastic coating over 
the printed surface. Don’t try 

to remove it; it will go once you wash 
the T-shirt.

Do-it-yourself: Printing on your T-shirt
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Make sure you iron the shirt on a flat even surface,
and check to make sure there are no wrinkles, or
you’ll end up ruining the print

Peel the sticker from one corner using a 
sharp blade

Don’t remove the plastic covering on the image—
this protects it till the first wash
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Jargon buster
Bleed: The outer region of the page that falls
outside the printing range of the printer. 
Buffer: The memory within the printer that
stores data from the PC until it is printed.
Currently, this varies from 16 KB to 16 MB. The
greater the buffer, the better is the handling of
large print jobs. 
PostScript: This is a page-description
language. It instructs the printer about where
to place ink. PostScript was invented by
Adobe. Currently in version 3, it supports
complex page layouts and provides excellent
quality. PostScript has become the de facto
standard in imaging technology.
Colour Balance: This term refers to the correct
combination of cyan, magenta and yellow
required to reproduce the colours of the
original scene or object. 
DPI: Dots per inch is a measure of the number

of dots printed per square inch. For example, a
300 dpi printer produces 90,000 dots on a
square inch. Higher dpi values produce sharper
printouts. The minimum dpi supported by any
printer today is 600.
Duplexing: This process helps you print on
both sides of a page, thus, reducing wastage of
paper. These days, many printers come with
this utility. 
International paper sizes: The International
Standards Organisation (ISO) categorises paper
into three sizes: A, B and C. Series A is used for
general printing, Series B for posters and charts,
while Series C is used for envelopes and
stationery. A detailed report on paper sizes is
available at http://www.cl.cam.ac.uk/~mgk25/iso-
paper.html.

Some of the latest printers
provide you with a special
slot for the memory card of

your digital camera. You can
download your pictures to the
printer, preview them on the
printer's LCD, choose the ones
that you want printed, make
adjustments, and then print
them. Quite a few vendors have
come up with printer models that
provide     you with this func-
tionality.

Some printers do not require
a memory card to be inserted; the
camera is directly attached to the
printer via a cable. Canon's Pow-
ershot series is one such example.  You can
customise photographs by using the

camera controls and the LCD, and print
directly to the printer.

Direct printing
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Ink Cartridges
If you are installing a new cartridge in your
inkjet printer, keep it in an upright position
for a few moments before fitting it in. This
ensures that the ink will be at the nozzle when
you are ready to use  the printer. 

Also, store the cartridge in an upright
position, in an air-tight plastic container.
If you feel that your prints are not as crisp
as they should be, run the printer’s head-
cleaning utility. This is necessary if you are
using your printer after a long time.

Using the Right Paper 
The regular paper that you use for printing,
ILU, is good enough for day-to-day print jobs.
However, at times, you may want to print on
special types of paper. Different types of paper
are available for different printing needs.

Photo Paper
This is similar to the paper used by film devel-

opers, and is
designed to
p r o d u c e
high-quality
images. They
come in both
matte and
glossy finish,
and in stan-
dard photo
sizes. Use
photo paper
for studio
q u a l i t y
photos.

Printing marked selection
When printing selected text, say on a Web
page, select the text, and go to File > Print. If
you’re using Internet Explorer 5 or higher,
choose to print ‘Selection’ in the dialog

box that pops up. Most of the newer
browsers have the Print Preview in the 
File menu.

This feature can be very useful if you
want to print only selected pages. Use the
Print dialog box in Internet Explorer to
choose what you want to print. Decide
upon the pages that you want to print 
in the Print Preview dialog box, and then
click ‘Print...’.

Now in the Print dialog box, enter the
page numbers and click OK. This procedure
is practically the same for most browsers,
including Netscape. 

Page setup
Most printing software provide you with 
a ‘Page Setup’ feature. This lets you deter-
mine how your page is going to print. 
The first thing that you can set is the
margin. This is the distance of the printed
material from the edge of the paper.  When
printing formal documents, you should
leave a bigger margin-especially on 
the left.

If you want smaller margins, remember
that you can’t set it to zero because your
printer just isn’t capable of printing from
the corner of a page. Thankfully, most
applications are smart enough to warn you
if you try to do so.

Next, you can set the gutter width—a
blank space on the paper that will be
trimmed off, or be lost while binding a
book. Set this option only if you plan to
bind the pages. You can set it to be on the
top or on the left of the page.

You can also choose the Page Orienta-
tion-landscape or portrait, depending on
the orientation you want. Landscape  is
when a document is wider than it is
longer, and portrait is the format that this
page you’re reading is in—height more
than width. 

Tips and Tricks

Selecting the correct photo paper from the list can give
amazing results especially while printing images
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MAINTENANCE

General Cleaning
If the printer is printing in streaks, and is
smearing, it means there is excess ink in
the carriage area. Follow these steps: Open
the printer and remove the cartridges. Fold
a letter-sized piece of paper in half, and
then in half again, so that it is quartered. 

Insert this paper into the regular feed
slot. Gently move the paper to the left and
to the right to remove excess ink under the
carriage. Once the ink is removed, the
printer should resume printing normally. 

Call your technician at least once a year
to get your printer cleaned thoroughly. There
are parts that are impossible to get at without
disassembling the machine. These need to
be attended to only by a professional.

Printing Images
There are a few general rules that should be
followed to print high-quality photographs.
The first rule is to use specially designed photo
papers. HP, Kodak and others have their own
brand of reliable photo papers. 

The second rule is to use a photo car-
tridge, provided your printer supports it. 

The third rule is to choose the correct
settings in the ‘Print’ dialog box. For this,
click ‘Printer properties’, and set the print
quality to the highest possible value.
Choose ‘photo paper’, if you are using one
as the paper type.

TROUBLESHOOTING

Inkjet Printers
If horizontal or vertical lines appear on
your printouts, run the print head-cleaning
utility three or four times, one after the
other. Check the paper if the printouts
appear faint. The paper might be damaged,
old, or loaded incorrectly. 

If you use special paper, such as photo
paper, make sure you are printing on the
correct side. Check the printer’s manual for
information regarding the compatibility of

the paper.
To unblock a cartridge’s print head,

place the print head in a shallow bowl of
hot water for 20 to 30 minutes. This will
soften the dried ink so that it flows through
the print head. You should see the ink
bleed out. If this doesn’t solve the problem,
repeat the procedure once again. 

Next, insert the cartridge into the printer,
and run the print head-cleaning utility. If
soaking the cartridge in hot water hasn’t
cleaned and dissolved the dried ink, you
should place the print head of the cartridge in
a shallow bowl containing an equal mixture
of very hot water and bleach—just enough to
cover the print head. Keep the head in this
mixture for two or three minutes. 

This hydrates the dried ink, making it
flow through the print head and you
should see the dried ink flow out. Now, you
can insert the cartridge into the printer,
and run the printer’s print head-cleaning
utility. This should solve your problem.

Economic printing
To save toner or ink, it’s a good idea to keep
your default print settings to Draft, or
EconoMode—especially for those of us who
don’t need high-quality prints all the time.
To do this, go to Control Panel > Printers, and
choose the printer properties by right-
clicking the printer icon. 

You can always change these settings
temporarily through the Print dialog of the
application that you are printing from. For
example, when printing from Microsoft
Word, just click on Properties and change
the mode to Normal or Photo.

You should also save paper by printing
on both sides of the page. If your printer
doesn’t support two-sided printing, feed
the paper manually, and flip it over to print
on the other side. You can also use software
such as FinePrint (www.fineprint.com) for
double-sided prints. Don’t forget to set the
page margins to the least value supported.
It allows more matter to be printed on
fewer pages.

haute gear >> inkjet printers
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■ Align the ink cartridge after you’ve
installed it. Use the software bundled with
the printer for doing this.  
■ Always store cartridges in their factory-
supplied containers or in a small, zip-lock
bag in a cool and dry place. 
■ To avoid paper jams, clean the inside
rollers with alcohol. Set your paper guides
carefully when placing paper in the in-tray.
Never mix paper types in the same tray. Fan
through the sheets to separate them before
loading the paper tray.   
■ Use the paper recommended by your
printer manufacturer. Use good quality
paper even for printing drafts as it prevents
paper dust from clogging the printer.
■ Always use your printer’s power switch
rather than the switch on a surge protector
to switch off your printer. 
■ Over a period of time, the prints you get
will become faint and there will be lines
running across the page. To restore the
original print quality, many inkjets come
with a nozzle clearing function 

that blows ink through the nozzles to
unclog them. Use this feature regularly,
especially if the printer has been unused
for weeks.
■ If you find a leak, don’t try to fix it your-
self. Call the authorised service centre. 
■ Air bubbles in the cartridge can cause
your printer to shut down. Never 
shake your ink cartridge as that creates bub-
bles.
■ If you remove a part of your ink system
such as the print head or ink reservoir,
remember to replace it. Opening the system
for even a few hours allows the ink to dry
out and clog the print head.
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The paper you use greatly determines the
print quality. Standard quality paper doesn’t
provide as crisp and bright an image as
paper made specially for a particular inkjet
printer. The main factors that affect paper
quality are: 
■ Brightness of paper: This is normally
determined by the smoothness of the paper.
A coarse sheet of paper will scatter light in
different directions, whereas smooth paper
will reflect more of the light back in the
same direction. This makes the paper
appear brighter, which in turn makes
images on the paper appear brighter. The
finish may be described as high gloss, gloss,

soft gloss, or semi-gloss, each reflecting the
amount of shine. 
■ Absorption: When the printer sprays ink
onto the paper, it should stay in a tight,
symmetrical dot. If the ink is absorbed too
much into the paper, the dot will spread
out in an irregular fashion and the result is
fuzzy images and text. The coating on
photo papers gives the printed photos the
look and feel of photographic prints.
Because the coating keeps the paper from
readily absorbing the ink, some glossy
papers dry slowly. However, quick-dry gloss
finishes are common today.

Selecting the Right Paper

Caring for Your Printer
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Here’s a brief
look at the one
portable device
everyone either
has, or wants 
to have
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In the 1970s, Alan Kay of
the Xerox Palo Alto
Research Center, Cali-

fornia, built the Dynabook.
It could handle most com-
puting needs and had wire-
less network capabilities.
1979: William Moggridge
designed the Grid Compass.
It had 340 KB of bubble
memory, a die-cast magne-
sium case, and a folding
e l e c t r o - l u m i n e s c e n t
graphics display.
1981: An India-born book
publisher, Adam Osborne,
came up with the Osborne 1.
This gadget had a 5-inch
screen, a modem port, two
5.25-inch drives, Battalion
software and a battery pack.
It weighed almost 11 Kgs
(some laptop!)  and cost
$1,795—about Rs 18,000 at
that time. The Epson HX-20—a battery-
powered portable computer, with a 20-
character by 4-line LCD display and
in-built printer—was also released.
1983: The Gavilan Computer was
released. It had 64 KB of RAM, ran the
Gavilan OS (also ran MS-DOS), had an
8088 microprocessor, a touchpad
mouse, a portable printer, and weighed
in at 4 Kgs. Radio Shack released the
TRS-80 Model 100. Microsoft wrote its
ROM programs—Bill Gates wrote a few
himself! It used standard AA batteries.
1984: IBM announced the IBM 5155
Portable Personal Computer, equipped
with 640 KB of RAM, two double-sided
5.25-inch drives, and an amber mono-

chrome monitor. Apple, the same year,
launched the Apple IIc model—a note-
book-sized computer that had a 65C02
microprocessor, 128 KB of memory, an
internal 5.25-inch floppy drive, two
serial ports, a mouse port, a modem
card, an external power supply and a
folding handle.
1986: IBM introduced its IBM PC Con-
vertible. It used an 8088 micro-
processor, and had 256 KB of memory,
two 3.5-inch floppy drives, an LCD,
parallel and serial printer ports, and
space for an internal modem. It came
with its own application software,
weighed 5.4 Kg and sold for $3,500
(about Rs 45,500 at the time).

La
pto

ps
Laptops, over the past 3.5 x 10-1

centuries
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External mice: It’s quite tiresome to
work long hours on a laptop, especial-
ly if it involves a lot of cursor activity.

Keep an external USB mouse for such ses-
sions. Optical mice for laptops are small, and
fit into your carry case with ease. They are
slightly uncomfortable, but still better than
the touchpad.

Carry cases: Laptops come with reason-
ably good looking and sturdy carry cases.
These usually have a pocket to accommodate
the power adapter. However, if you’re
a frequent flier, and carry other acces-
sories along, look out for specially-
made laptop bags. Elegant leather
bags with special pockets for the
power adapter, external optical
drives, etc., are more durable than the
resin bags provided by manufactur-
ers. Use hard-case bags to protect
your laptop from wear due to bumpy
roads, rain, snow, sleet, hail, etc.

External laptop coolers: The use
of desktop components in entry-level
laptops reduces costs. However, these
components dissipate a large amount

of heat, and strangely, hardly any laptops
have efficient-enough ventilation systems.
You might think of purchasing an external
cooling system. Antec’s laptop cooling solu-
tion has a plastic base with a brushed perfo-
rated aluminum surface that makes contact
with the laptop body. Two high-rpm fans
between the plastic base and the aluminium
surface draw heat away from the laptop.

External lights: You can use USB-powered
light sources that you can clip on to the top of
the screen.

Standby batteries: Laptop batteries usu-
ally last about 3 to 5 hours. So it makes sense
to carry a charged standby battery along
when travelling.

We recommend you purchase batteries
from the manufacturer, rather than from a
third-party vendor at a lower rate.

Other accessories: A Kensington lock is
a wire lock that can be used to secure a lap-
top to a desk. Protect your LCD screen using
a screen protector. These are thin plastic
sheets that can be stuck on to the LCD to pre-
vent scratches. Use lint-free fabric to clean
the screen.

Laptop Accessories
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Workshop: Lap Sync

You’ve just returned from a business
trip, and you start the process of
transferring files from your laptop to

your PC. With fingers and toes crossed, you
pray that everything goes well. Even as you
sit and search through folders to see which
files aren’t already on the PC, you contem-
plate quitting your job. Fortunately for you,
we’ve got a simple solution. All you need
do is let Windows XP’s Offline files feature
help you out of this predicament.

Enabling offline files
First, go to Control Panel > User Accounts >
Change the way users log on or off and
uncheck ‘Fast User Switching’. Next, open
My Computer, and go to Tools > Folder
Options. Switch to the Offline Files tab, and
ensure that ‘Enable Offline Files’ is ticked. Here,
you’ll also find options that let you decide
about synchronising while logging on and off.
Note that these affect all the network drives
you set for synchronisation.

Map network drives
It’s time now to create a network drive. Map a
shared folder over the network using a drive let-

ter. On the laptop, open My Computer, and
click Tools > Map Network Drive, choose a drive
letter, and enter ‘\\computername\sharedfold-
er’, where ‘computername’ is the name of your
desktop PC, and ‘sharedfolder’ is the folder
you’ve shared on the desktop computer. This
folder should have read and write access in order
to synchronise.

Networking offline
Click on the networked drive in My Computer
and go to File > Make Available Offline. A wizard
lets you set further options when you do this for
the first time. This option is available only by
going through the aforementioned path. To dis-
able synchronization for a mapped drive, select
the drive in My Computer, and go to File > Make
Available Offline and remove the checkmark. 

Synchronising 
When you first make a network drive available
offline, all the files are downloaded from your
laptop to your desktop PC. Whenever you re-
plug the laptop to the network and log on to
Windows, the network drive is synchronised.

Drives available offline are synchronised once you plug the
laptop into the network 

The Synchronisation Manager gives details of the process 



Synchronisation is done based on the date the
file was last modified. Say you created a file in
offline mode, named ‘somefile.txt,’ on May 13,
2004, which was not accessed thereafter. Say
another user created a file with the same name
in the target folder on the desktop on May 16.
If you plug your laptop into the network after
this, the file on the desktop replaces the one on
your laptop.

The Synchronization Manager
Access the Synchronization Manager by going
to Start > All Programs > Accessories > Synchro-
nize, or just enter ‘mobsync’ in the Run dialog
box. Here, you’ll see a number of network drives,
as well as Offline Web pages to be synchronised.
Select an item and click Setup. There are three

tabs where you can specify when to synchronise.
The Logon/Logoff tab lets you decide about
synchronising while logging on or off. Use the
On Idle tab for synchronising when the com-
puter is not in use. In the Schedule tab, set the
time at which synchronisation should start auto-
matically.  

The third-party way
Third-party software such as Second Copy
(www.centered.com), Folder Match (www.folder-
match.com), etc., also help you orchestrate har-
mony between your laptop and desktop PC.
They also throw in some nifty features such as
mass file renamers and duplicate file finders. 

With synchronisation, you can  say goodbye
to those backbreaking data transfer days.
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BATTERY USAGE: Be cautious, as several
manufacturers indicate the battery usage
time at the lowest possible power settings.
LEGAL SOFTWARE: Make sure your laptop
comes with legal software. Some vendors
who assemble or sell laptops may not pro-
vide you with legal copies of the software.
Verify that the software that comes with your
laptop is on an original CD, and has a soft-
ware licence or registration number.
UPGRADABILITY: This may not occur to you
when you purchase a laptop, but it’s impor-
tant all the same. Here are some options to
look for when upgrading your laptop—the
RAM, the CPU, the hard drive, etc. Are the
upgrades something you can do yourself, or
do they require visits to a service centre?
LOCATION: Make sure you can easily return
the laptop to the dealer if it proves unsatis-
factory. Also check if the dealer can service
your laptop. If he can’t, where’s the nearest
place your laptop can be serviced?
HARD DRIVE: Capacities range from 6 GB to
50 GB. Most users should find 12 to 20 GB
enough. In any case, you won’t save much

by buying a smaller capacity drive,
and will pay a lot more for a larger drive than
the one bundled.
PORTS: Most peripheral devices connect to a
USB port; make sure there are at least two
USB ports. You will also need parallel, serial,
and PS/2 (for keyboards and mice) ports.
SIZE AND WEIGHT: Weights range from 1.5
to 4 Kgs, and thicknesses could be as little as
1 inch. Many laptops offer large screens and
can work as desktop replacements. The larger
the screen, the more bulky your laptop
becomes. External power supplies and periph-
erals can add considerably to the weight.
Lightweight portables can become as heavy
as regular laptops when you add up the
weights of all of the components.
DISPLAY: This will require a compromise if
you decide on an ultra-portable model. Most
displays now support resolutions of 1024 x
768 pixels, and a 14-inch notebook display is
larger than most 15-inch desktop CRTs.
PROCESSOR: The Pentium III M, Pentium 4
M and Athlon mobile processors are available
for the laptop segment.

Be sure to look at this before you get a laptop!
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It’s a big bad world
Whether you lug your laptop all over the
world, or just from home to work and back,
the fear of physical loss of the laptop is ever-
present. Not all laptops are stolen and sent to
the local chop-shop to be re-sold; smart
thieves will target laptops to pick up data that
is otherwise inaccessible from workstations
behind company firewalls. Third-party soft-
ware tools that will restrict logins and encrypt
drives are your best bet against data thieves. 

The Bill Gates’ of the world probably have
a posse of security men guarding their laptops.
There are hardware locks available that will
let you secure your laptop as you would your
bags on a train. Also, using commonly avail-
able tools, you can ensure that even if your
laptop’s stolen, your data remains safe.

Hardware paranoia
Securing your laptop is best achieved by
locking it down… literally! Laptop manufac-
turers provide a little slot where you can
attach a lock. This slot is connected to a steel
rod within the chassis; taking apart the rod is
as good as breaking the laptop. The slot can be
identified by a little lock icon, with the letter
‘K’ on it. Hardware security devices available
in India range from the simple to the sophis-
ticated. At the bottom of the list are ordinary
devices that lock into the security slot and
have a tough steel cable to wind around a
table leg, or some permanent hook-like fix-
ture. This prevents a crook from just picking
up your laptop and walking away with it. We
looked at a mechanical device that has a com-
bination lock and comes with 1.5 m of tough
steel cable around it.

Setting it up is simple: attach the device
into the security slot, wind the cable around
a table leg—or use the supplied steel hook that
can be mounted on a wall—and lock it. This
device works great if you tend to be less

mobile. Short of sawing through the thick
steel cable, the table leg, or trying to break the
code on the combination lock, you can’t steal
a laptop with this device protecting it.

There are more sophisticated devices
available that work with inbuilt motion sen-
sors. We found that Targus’s DefCon 1 systems
(www.targus.com) allow you to set sensitivity
levels on a motion sensing equipped device;
one particular model, the PA 400, lets you
connect a clip-like device into the security
lock, loop a steel cable through it and lock it
into the motion sensing device. Shake the
laptop, or the motion sensing device, and an
ear-splitting alarm sounds.

This should be enough to grab the atten-
tion of everyone who isn’t already deaf, and
also give the potential thief a good scare. You
can only turn it off by unlocking the three-
digit combination
lock and undoing
the cable. An even
more sophisticated
DefCon 1 product,
the PA 430B, comes
with a motion
sensing device,
cables, a clip and
also a remote con-
trol that lets you
trigger the alarm by
proximity as well as
motion detection. Move the tiny remote con-
troller beyond 12m from the laptop and the
alarm goes off. You can also trigger the alarm
by pressing a button in the remote controller. 

This device is ideal for travellers, who can
secure their laptops whilst travelling in high-
risk public areas such as airports. Neither of
these security devices will allow you to access
the battery compartment until you unlock the
device, so somebody intent on stealing your
laptop cannot disable the alarm.

Do-it-yourself: Secure your laptop



108

haute gear >> Laptops

Keep in mind that while these devices are rel-
atively secure, there’s still nothing like total
security; at best they provide a deterrent.

Secure the insides
Corporate espionage is a growing problem;
the data on your machine may of immense
value to the competition. Even ordinary e-
mail can be a source of information. Your only
shield here is making sure that the computer
cannot be accessed by anyone but yourself,
and that the data is still unreadable, should
someone try to swap drives—BIOS and Win-
dows passwords are not adequate security. Use
a relatively more secure OS such as Windows
2000 or Windows XP, and patch the OS with
the latest service packs. Then use commercial
tools to further secure and limit access. To this
end, we tested SafeBoot Solo.

To run this tool, you’ll need a Windows-
based laptop and formatted floppy diskettes.
You’ll be prompted to create rescue diskettes
at installation, which can be used to recover
from hard drive failure, or from a corrupted
setup. These diskettes can be used to log in to
your machine, so store them securely.

SafeBoot Solo
SafeBoot Solo (www.safeboot.com) is simple, easy
to use and is shareware—after the trial period
expires, SafeBoot will delay boot-up by a
minute. Installing SafeBoot is a two-step
process—installation and configuration.
Once SafeBoot is installed, you are prompted
to reboot, after which a simple configuration
process starts. You’ll be prompted to enter a
username and password, which you will use
to authenticate, as well as change SafeBoot’s
settings. Now you can opt to encrypt all, or
some of your drives—you can choose either
partial or complete encryption. A partially
encrypted drive has 10 per cent of its drive
volume encrypted. Ideally, encrypt the entire
drive. After this, the installer starts copying
all the additional setup files.

If you chose to encrypt drives, SafeBoot will
conduct the drive encryption operation imme-

diately. You can choose to either reboot, or con-
tinue working with SafeBoot in the back-
ground; you can also stop and restart it later. To
view the encryption status, just right-click on
the SafeBoot icon and choose Show Status. 

With SafeBoot installed, you are presented
with a login screen when the computer is
turned on. On the login screen, you’ll find
additional options to boot from either hard
drive or floppy. Once you authenticate, Win-
dows boots up normally.

While you work with Windows, double-
clicking the SafeBoot icon in the system tray
launches your screensaver and locks your
computer. You need to re-enter your Windows
password to continue working.

While SafeBoot forces you to authenticate
before Windows loads up, you should encrypt
your hard drives to safeguard your data. This
will prevent someone from just removing
your hard drive and reading your data on
another laptop. SafeBoot’s encryption works
on a real-time basis—files read from an
encrypted drive are encrypted and decrypted
on the fly. SafeBoot uses the AES algorithm

(the Advanced Encryption Standard) imple-
mented with 256-bit security. If you didn’t
encrypt your drives during installation, you
can do so by right-clicking on the SafeBoot
icon in the system tray and choosing Con-
figure. You will also be prompted to re-use the
rescue disk you created earlier.

Encrypting drives using SafeBoot



109 JUNE 2004

Data about
slim media
that belie the
amount of
data they
stuff in...



Initially, we used the floppy disk to
carry home every important presen-
tation, office document, etc, that was

left pending at the end of the day. It held
just 1.44 MB of data and stopped
working randomly after a few rounds of
usage. Then came the CDs that stored
more data and were reliable too. With
CD-Writers getting cheap, CDs just about
replaced floppy disks as portable media. 

However, a few years down the line,
storage companies were at it again as
they tried to break through the 700 MB
limit. And along came the DVD. Today,
CDs and DVDs are treading the path of
co-existence. So, we have combo-drives
that cater to both. The ones currently
available read and write both, CDs as well
as DVDs.

So, what started as a mere 1.44 MB
has now reached 4.7 GB and this is not
the end. Some models, such as those
from Lite-On, are dual-layer DVD-

Writers. This writer, when used with the
correct media, write twice the amount of
data that’s normally written to a DVD.
Thus you will be in  a position to store
hundreds of MP3s and movies on a single
disc. For the business user, it translates to
approximately 10 CDs worth of backup
on a single disc. 

Speeds have increased too. From a
slow read speed of 1X to 52X for CD-
ROM and 16X for DVD-ROM, it's been
taking significant strides. The same is
true for the write speed of CD and DVD-
Writers—what took half an hour to burn
can now be accomplished in under 
three minutes. 

External drives is another interesting
category meant for laptop users and
people on the move. Their initial install-
ments were heavy and bulky, but design
improvements have made them light
and slim, hence carrying them around is
not a problem any more.
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■ Turn the screensaver off while burning a
CD, so that it does not hamper the flow of
data to the CD-Writer.
■ Defragment the hard disk before burning
a CD.
■ If you have a speedy CD-Writer but a slow
processor and hard disk subsystem (ATA 33),
it’s safer to burn the CD at a speed lower
than the maximum possible.
■ Use ‘Track At Once’ instead of ‘Disk At
Once’ to burn an Audio CD. This makes the
Audio CD look more professional since a 2-
second gap is inserted between each burned
track and the CD can then be mass pro-
duced error-free.

■ Always ‘finalise’ a burned Audio CD 
to ensure that it plays on your home 
music system.
■ Use branded CDs to burn critical data—
cheaper media are prone to damage and 
do not hold data for long. Moreover, 
there’s no guarantee that they will burn
everything perfectly.
■ Shut down all other applications while
burning CDs. Avoid using the PC for any
other tasks while a CD is burning.
■ Try to simulate a burn process if the
writer has just presented you with a
coaster. Most CD-Writing software allow
for this.

8 easy steps to burn that perfect CD
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Make music CDs using
Nero

■ Click on Start > Programs > Ahead
Nero > Nero Burning ROM.
■ Select the Audio CD option and
click Next.
■ Use the Finish button to confirm
all the details.
■ Select the songs you wish to burn
on the CD from the File Browser on
the right side of the screen. Drag
them to the compilation window
on the left by holding down the left
button on your mouse.
■ Once you have dragged all the files across,
you are ready to save (or 'burn') to a CD. Go to
File > Write CD… to launch the Burn CD Wizard.
■ Click the Burn button to start the writing
process.
■ Once your CD has been written, click Dis-
card. Retrieve the recorded CD from the drive.
■ Select File > Exit from the menu bar to exit
Nero, once the burning process is over. Click
No when asked to save the session.

Burn the boots

■ Get the bootable CD or the floppy 
of the operating system.
■ Start Nero v5.5 and select the CD-ROM
(boot) in the main window. The windows that
opens gives you the option to select the drive
in which the bootable floppy/CD is located.
Here, make sure the bootable floppy is in the
drive, otherwise the drive letter will not be
highlighted.
■ Put the blank media in the writer and leave
the ISO and Misc tab as it is.

Give the appropriate name in the label sec-
tion for the bootable CD. Select the Burn tab
and check ‘Write and Finalize the CD’. Select
the Disc-at-Once write method and click on
the New tab.

The bootable CD will be left with lots of
unused space, it can be utilised to burn drivers
and updates for your PC.
■ Switch to the Write tab and select the 
safe writing speed, according to your 
system’s configuration.
■ You are now ready to write the CD. Typi-
cally, the size of the bootable CD for Win-
dows 98SE will be around 125 MB and  it will
take around four to five minutes to complete
the process.
■ Check the CD by booting the system with
it.

Workshop: Of Boot And Sound Burns

Choose the Disc-At-Once method to burn the
bootable CD

Select the audio files you need to burn on your CD via the browser



Back-up: The essential job of saving and
storing data on a tape, CD-R, etc.

Copy Protection: Both discs and players come
equipped with hardware mechanisms to pre-
vent the illegal copying of DVDs. You will not
be able to copy the movie to a VHS tape, your
computer’s hard drive or any other data-
recording device.

DAT: Digital Audio Tape is a compact, high
capacity form of data storage, suitable for
archiving or backing up large amounts of data.

DVD: Digital Versatile Disc is a high-density
format for playing full-motion video. It pro-
vides a vast data storage capacity. Although
popular within the home market, DVDs can
also be used to hold computer data.

Hybrid DVDs: Nine leading consumer elec-
tronics manufacturers have jointly issued the
basic specifications for a next-generation, large-
capacity optical disc video recording format

called Blu-ray disc. These DVDs can hold six
times the data held by those of the current
standard. The new format will store more than
13 hours of film, compared to the current limit
of 133 minutes.

High Density-DVD is the enhanced form of
current DVD format. Blue lasers have a much
shorter wavelength than the red lasers used 
in current DVD players, allowing for much
greater disc capacity. The new high definition
format allows a capacity of 4.7 GB to 15 GB on
a single-sided, single-layered disc and a capacity
of 8.5 GB to 30 GB on a single-sided, double-
layered disc. 

This provides a cost-effective upgrade path
for media vendors and a backward-compatible
solution for all those who've already built DVD
libraries. Current DVD players use 650
nanometre (nm) red lasers, while CD players
use 780 nm diodes. It will not be possible to
play Blue-ray discs with existing DVD and CD
players, since these don't use 405 nm lasers.
Blue-ray drives need to contain 780, 650 and
405 nm lasers in order to be compatible with
CD and DVD discs.

Packet writing: Packet writing is a technique
by which a normal CD-R or CD-RW can be
used like a floppy or zip drive. Normally, when
a CD is burned, the table of contents (ToC) is
generated first, then the burning begins, and
finally the ToC is written onto it. This allows
the OS to retrieve the files from the CD the way
it is meant to be, but once the ToC is burnt in,
more data can't be written onto the CD. 

The idea behind packet writing is that if
one need not worry about the TOC, and write
data to a CD-R in blocks or packets. By writing
an appropriate set of functions into the OS, a
vendor can provide packet capability for writers
with suitable hardware and firmware. 

However, since the ToC will not be present,
its information has to be conveyed to the OS in
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What does this mean?
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some other manner. This is done by including
a header along with each packet that contains
the information on the file it represents,
including its length. This also tells the OS
where the next packet begins. In this way, the
OS can read the CD contents. However, adding
this additional information decreases the disc's
capacity.

Cross-talk: A measure of the amount of inter-
ference coming from neighbouring pit tracks
on a CD. As track pitch is tightened (when
tracks are packed closer together to put more
data on a disc), cross-talk increases. A max-
imum value of 50 per cent is allowed by Red
Book specifications.

Mastering: The process of creating a stamper or
a set of stampers to be used in the injection
moulding stage of manufacturing compact
discs. A digital signal from a PC is used to guide
a laser beam, which etches a pattern of 'pits and
lands' (in the case of CDs) or a continuous
groove (for CD-Rs) onto a highly polished glass
disc coated with photo-resist. 

This ‘glass master’ is then cured (devel-
oped) with ultraviolet light and rinsed off, and
a metal (nickel or silver) mould is electro-
formed on top of it. This mould is removed and
then electroplated with a nickel alloy to create
one or more stampers to be used in the injec-
tion moulding machine to press the data into

the polycarbonate substrate of CDs, or the
guiding groove into the CD-R substrate.

Media or ‘blanks’: CD-R media are the discs
used to record digital information with a spe-
cial recorder and pre-mastering software on a
computer. These discs are made of a polycar-
bonate substrate, a layer of organic dye, a 
metalised reflective layer, and a protective lac-
quer coating. 

Some discs also have an additional protec-
tive coating over the metalised layer, 
while others have a printable surface silk
screened on them.

Organic dye: The data layer of CD-R discs is
made from either cyanine or phthalocyanine
dye, which is melted during the recording
process. It then becomes opaque or refractive,
scattering the reading laser beam so that it does
not reflect into the reader’s sensors. The differ-
ence between reflected and non-reflected light
is interpreted by the player as a binary signal.

Pits and lands: In a ‘pressed’ or mass-replicated
CD, the bumps and grooves that represent the
binary data on a disc's substrate are pressed into
it during manufacture. CD-R discs do not have
true pits and lands, but the un-melted, clear
areas and melted, opaque places in the dye
layer fulfill the same function as pits and lands
on a pressed disc.

To access any file, a computer’s operating
system needs to be able to locate the file. A
file system facilitates the storage and
retrieval of hundreds or even thousands of
distinct files. Every operating system uses a
different file system and therefore, there are
a number of CD-ROM file systems in use on
Windows, Macintosh, Unix and others. The
most common file systems for CD-ROMs
are the ISO 9660 and Joliet extensions. ISO
9660 is the international standard and is

designed for the PC and MS-DOS. The Joliet
specification was designed to resolve certain
deficiencies of the original ISO 9660 file
system, such as a limited character set and
file name and path lengths. CD-ROMs that
are to be used on Macintosh computers are
usually created in the Hierarchical Filing
System (HFS) format. This format features
support for sub-directories, up to 31
characters per file name and up to 27
characters for volume names.

CD-ROM FIle System
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CD-Writer
■ Make sure that the drive has a high spin
speed and fast access times. If you need to
read non-sequential data such as a game, then
access time should be your point of concern.
■ Does it support over-burning?
■ Does it support Multi-Session and Incre-
mental Packet Writing?
■ Does it support RAW writing?
■ Does it include a CD-burning software?

DVD-ROM drive
■ A DVD-ROM drive should be able to read
dual-sided DVD media.
■ Opt for a 16X—the fastest speed available.
■ Also, ask for the warranty period and the
parts covered in the warranty.
■ Make sure you buy a DVD-ROM drive that
has at least 512 KB as buffer memory.
■ Opt for a slot DVD-ROM, rather than the

one with the tray, since they last longer.
■ Ensure that a good DVD playback software
such as WinDVD is provided along with
the drive.

External vs internal writers
Choosing between an external and an
internal drive depends primarily on your
requirements.
■ Internal drives are usually cheaper. Opt for

one if you are a home user.
■ Till date, due to their interface, external
writers were slower as compared to their
internal counterparts. However, with the
arrival of FireWire and USB 2.0, this is no
longer a problem. 
■ The greatest advantage of an external USB
CD-Writer is that it can be hot-plugged to the
PC (i.e., there's no need to shut down and
restart).
■ External writers come with the added bag-
gage of SCSI/FireWire/USB 2.0 cards that add
to the budget.
■ Internal CD-Writers tend to hog a great deal
more of the system's resources.
■ Buffer underruns used to be a big problem
with internal drives, but that's been solved
using buffer underrun protection technology.

Your shopping checklist

■ Never use poor quality detergents and
sprays for cleaning. Clean the drives using a
soft, dry fabric.
■ Keep the tray clean. Use a duster for
thorough cleaning.
■ Use an uninterrupted power supply (UPS)
for your PC. This protects your system from
any drastic power surges.
■ Do not push the tray to close it; use the
eject button instead.
■ Never force the tray out, if it doesn't
eject automatically. Use the pin provided
with the drive to remove it manually.
■ Use a good quality lens cleaner to keep
the lens clean, as this is one of the most
important parts of the drive.

Taking care
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Copy-protection is the technology that has been devised
to protect media content—be it streaming or static, 
from being  copied. Although, it’s okay to make a
personal backup copy of any media for archival purposes,
media companies are taking no chances and are
aggressively using different copy-protection techniques to
protect their content. Some popular techniques in use by
game publishers are SafeDisc from Macro Vision and
SecuROM from Sony. Audio CDs use Cactus Data Shield by
MidBar Technologies. 

SafeDisc 2 is the latest incarnation, and consists of three
main features—an authenticating digital signature,

encryption that protects the content and anti-hacking
software. 

SecuROM is a copy-protection technique made by Sony
and is employed by game publishers. The process consists
of adding a unique electronic SecuROM key to the 
CD-ROM using special glass-mastering equipment, also
manufactured by Sony DADC. The electronic key is the
important element in the process. This key is not that easy
to copy to a CD-R. These protection techniques can be
worked around using certain copying software. CloneCD is
one such one-to-one backup CD software that is
commonly used.

Copy protection

Finalising is the process of closing a
session on a disc. An open disk is
one on which you can add data. A

single-session disk has three areas: the
lead-in, the program area and the lead-
out. The lead-in contains the Table of
Contents (ToC), the program area holds
the data and the lead-out is used to 
pad the remaining portion of the disc
with zeroes. 

When the session is closed, the ToC
is written to the lead-in area, which
enables all CD-ROMs and CD players
to read the ToC and access the data.
However, the disc cannot be opened
again to write more data onto it, and
so the remaining space is wasted. How-
ever, if the data is written to the disc,
and the session is not closed, the 
ToC is not written to the lead-in area;
instead it's written to a separate 
area called the Program Memory 
Area (PMA).

CD recorders are capable of looking into
the PMA to find the ToC of the open session,

and then continue to add more data in a new
session. Thus, to make a disc multi-session,
the burn process should not be finalized.

What is Finalising?

Use the Finalise Disc option to close the session for the CD
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So you’re buying
a computer?
Here’s what to
look for, and how
to care for it
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When your brand new computer
is delivered to you, in pristine
condition, your applications

load blazingly fast and run smoothly.
However, as you use your computer, it
tends to become progressively slower and
applications do not run as responsively as
they used to. To counter this, there are a
number of little tasks and housekeeping
settings that you can run on your com-
puter to ensure that it remains running as
smoothly as when you first booted it. Also,
there are a plethora of settings that you can
run on your computer to push it a little
extra, and utilise all the power that is
hidden inside, making it a faster machine
than it ever was before.

Restrict your startup files
Go to the Startup folder in Windows
and remove any applications that are
unnecessary during startup. This

includes download managers, the Office
Start bar, Chat clients, etc. These appli-
cations take up precious resources such
as memory and processing power, and
are invoked when you start your PC.
Therefore, launch them only when you
need them and you’ll be freeing your
computer’s resources for applications
that actually need it.

Load the latest drivers
Your new computer will most probably
come with a pre-installed operating
system, or at least with the setup CDs that
contain the drivers for the various hard-
ware in your system. You are likely to
have outdated drivers on your system,
and while your system would work, it
won’t operate to its full potential.
Remember to load the latest drivers for
your hardware, especially the video card,
motherboard chipset and soundcard.

PC
s Tweaks for your Brand New

Machine

haute gear 

Regular cleaning and maintenance of your
PC is necessary. Here are some tips on how
to go about this:
■ Scan your hard disk for errors regularly.
This will nip any problems in the bud.
■ To ensure that the space on your hard
disk is well utilised, you should defragment
it regularly. This arranges the files in
contiguous clusters, and improves
performance.
■ Update your drivers frequently for a
smooth-running system. The same logic
extends to patches for software

applications such as your operating
system, office suites and anti-virus
packages. 
■ Keep your system in a clean, cool and
dry place. Make sure to keep dust out of it,
but don’t block the fan vents by covering
the cabinet. Cover your system only when
it’s not running, and make sure to keep all
the various fans clean. Dust can cause any
one of many moving parts in your system
to lock up or slow down. This could cause
a noticeable drop in performance and may
even damage some critical components.

…to Keep the Doctor Away
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Special shortcuts

■ Display Windows Help
Press [Windows] + [F1]
■ Open the Start menu
Press [Windows], [Ctrl] + [Esc]
■ Open the System Properties dialog box
Press [Windows] + [Pause Break]
■ Open the Find Computer dialog box
Press [Windows] + [Ctrl] + [F]
■ Open Windows Explorer
Press [Windows] + [E]
■ Open the Find All Files dialog box
Press [Windows] + [F] 
■ Minimize all open windows
Press [Windows] + [M]
■ Expand previously opened windows,
and go back to the window you were working
in last
Press [Windows] + [Shift] + M
■ Display the Run dialog box
Press [Windows] + [R]
■ Select and cycle through the taskbar
buttons
Press [Windows] + [Tab]

■ Set focus on a notification (only in
Windows XP)
Press [Windows] + [B]

Keyboard control for Desktop
Ever thought of browsing your desktop
using only the keyboard? Here’s how you
can do it:

■ Press [Windows] + [D] to show the desktop
■ Press the [Windows], to bring up the Start
menu
■ Press [Esc] to make the Start menu
disappear, but keep the taskbar active) 
■ Press [Shift] + [Tab] once to toggle
between the taskbar and the desktop. Your
desktop will now be active, although you
may not notice any visual indication of it 
■ Press [Down Arrow] to see which desktop
icon is active, and continue to use the
cursor keys to move to the icon you want
to use
■ Press [Enter] to run the icon, or press
[Shift] + [F10] to see the context menu for
that icon

HP 
Pavilion Desktops
for the Complete

Digital
Experience

Keyboard Shortcuts
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■ Have a clear idea about your requirements,
so that the PC you buy matches all your needs.
■ If your new computer has Windows XP, we
strongly recommend at least 256MB of RAM.
In case the PC doesn’t have it, add more
memory.
■ Choose a configuration that is future-proof.
Look out for maximum expansion options such
as PCI and AGP slots, and USB ports.
■ With new PCs offering fast processors and the
latest graphic cards, thermal dynamics is very
important. Get more cooling fans in the cabinet.

■ Choose a monitor that is at least 17-inch in
size. Don’t settle for anything less than an
80GB hard disk, running at 7,200 rpm.
■ If you plan to run multimedia on your PC,
such as, games and 3D creation, make sure
you have a decent graphic card. It will give
you optimal performance. 
■ Check all the finance schemes available, but
don’t fall prey to the free gift schemes. Instead,
take a look at the packages offered.
■ Make sure there is an authorised service
centre close to you.

Buying Tips



Wouldn’t it be easy if you could search
the Web directly, without waiting for
the Web page of a search engine to

load? It is, given the right tools. You can set the
toolbar of the search engine of your choice
(Google, Opera, Netscape, etc.) on your
desktop, and search from there. 

Download and install Google toolbar from
http://toolbar.google.com/. Double-click the
Internet Explorer icon on the desktop to load
IE.. Next, right-click on any of the toolbars, you
will see additional options such as Links,
Addresses, Standard Buttons, etc. Click on
‘Google’ to load the toolbar. The toolbar has a
text field, and buttons—‘Search the Web’, ‘Nav-
igate the Google News site’, a graphical button
to block pop-ups, an Autofill tool for Web
forms, a blog updater and a button that enables
or disables the highlighting of search words on
the resultant page. 

To search, just enter the search string into
the text field of the Google toolbar and hit
[Enter]. You can also specify Boolean text
searches in the same text field area.

The Google deskbar
The Google Deskbar (http://toolbar.google.
com/deskbar/) is an add-on to your taskbar from
where you can initiate any search directly. It
displays the search results in a small window
on the desktop itself. The results window
retracts after short periods of time. To amend
this, right-click on the taskbar and select Tool-
bars > Google Deskbar. A small text search field
appears on the right-hand corner of your Win-
dows Taskbar. You can also configure it to open
the search link inside a separate browser
window. Click on the arrow beside the binocu-
lars, and in the menu that pops up, click on
Options. Here, under the Mini-viewer tab,
check the ‘Display search results within mini-
viewer’ box. Check the ‘When clicking on
results, open a browser’ box, to open results in
a separate browser window. Enable the ‘Auto-

matically close the mini-viewer when you leave
it’ option to close the Deskbar search pop-up
when your mouse cursor leaves the pop-up
window area. Uncheck ‘Use animated open and
close’ for disabling animation displays.

Other tools
Copernic Agent is another popular search

tool that integrates into search engines and pro-
duces results available to them. 

Download and install Copernic agent from
http://www.copernic.com/en/products/agent/down-
load.html. Start Copernic Agent, click on the left-
hand pane and select Advanced. A small
window pops up for  you to enter your search.
Click on ‘Modify search engine settings’ to
open a small window that lists all the search
engines it uses as reference engines—AltaVista,
AOL, etc. Select all for more results, or deselect
those you do not want to use. Click OK to exit.

Copernic spreads
a wide array of search
engines at your dis-
posal. The results are
listed relevance-wise,
which is indicated in
percentages.

Click on the link
displayed on the
right-hand bottom
half of the pane to
browse through the
results. This loads
the Web site in the
default browser. 

Change the
default browser by going to Tools > Options >
Browser. Here, you can also specify a browser of
your choice by clicking on Alternate, and
specifying the path to that browser. Click on
OK to close the window. 

With so many search tools at your disposal,
it shouldn’t be difficult to find the information
you require!

Workshop: Searching by bar 
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It’s something that’s happened to all of us at
some time. It’s a Friday and your eyes let
you see nothing more than to-do lists for

the weekend. There’s the date whose grown
tired of your thousand and one excuses, and
the party that demands your presence...You
waltz away home, memorising the sequence in
which the list has to be executed, and then the
symphony throws up a flat note from real life!
You just forgot to finish that document that
nearly finished you off mentally! 

Sprinting back to office is not an option you
would like to look at! Now, if only there was a
way of doing the damned thing from home!

It’s the same scenario when asking for help on
a lengthy phone conversation with the so-called
help desks. If you could only let them access your

desktop for a while and let
them fix it remotely, indeed
life might actually be worth
living, for a change! 

Here’s the solution—
simple remote access tools
that let you do just that—
access your PC remotely. 

Help’s on the way,
remotely
Windows XP has a nifty
little tool called Remote
Assistance that does what
its name states—trou-
bleshoot computer prob-
lems from a distance. 

Remote Assistance is easy
to use and secure—no one
can take control of your PC
unless you send an invita-

tion, and give the person
proper authorisation. Along

with Windows XP and an Internet connection,
you need Windows Messenger 5.0 (which is avail-
able, by default, on XP), or greater installed on
both the PCs. 

Enabling Remote Access
To enable the Remote Assistance services, go to
Start > Settings > Control Panel, and click on the
System icon. Alternatively, you can use the [Win-
dows] + [Pause/Break] keyboard shortcut. Under the
Remote tab, check the ‘Remote Assistance’ box.
Click on Advanced and ensure that the ‘Allow this
computer to be remotely controlled’ checkbox is
ticked. Let the default setting for the amount of
time the invitation can remain open stay as 30
days. Keep clicking on OK till you exit the menu. 

Inviting the expert
Initiate a Remote Assistance session either using
Windows Messenger or e-mail.

Log on using your standard MSN .NET ID,
which is the same as the one you use for MSN
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Workshop: Remote controlling 
your world

Enable Remote Assistance in the Remote tab of the
System dialog box to send invitations from your PC

Turn on remote services on the Windows XP
Professional host computer in the Remote Tab
of the System Properties Dialog

HP 
Pavilion Desktops

for Thrilling
Digital Gaming



Messenger. Right-click on the expert’s ID in
the main window and select ‘Ask for Remote
Assistance’ to send an invitation to 
the expert. 

Running a Remote
Assistance session
A dialog box informs you if the expert has
accepted the invitation and is ready to con-
nect to your computer. If you do not get a
response after awhile, send an invitation again
since your Internet connection might be
weak. Click ‘Yes’ to let the expert view your
desktop and chat with you. The expert will
have to click on ‘Take Control’ in case you
wish to let him or her have access to your
desktop to solve the problem. Accordingly,
Remote Assistance will prompt you on your
machine. Choose ‘Yes’ to let the expert take
control. Now, both you and the expert have
control on your PC. You can disable access to
the expert by pressing [Esc]. The expert can
also hand back control to you by clicking on
‘Release Control’.

Send and receive files while using Remote
Assistance by clicking on ‘Send a File’. This can
be done by both parties. The receiver is notified
of the file transfer. You can also start a conver-
sation by clicking on ‘Start Talking’. 

Other assistance
Windows XP Professional has an in-built tool,
called Remote Desktop that lets you operate
on your remote desktop PC. Note that Remote
Desktop services are available only for the
Windows XP Professional version.

All you need is the host, i.e., the Windows XP
Professional machine and the local PC—the
client running on any version of Windows. The
PCs could be on the same LAN, VPN, or con-
nected over the Internet. 

Setting up the host computer 
The host computer could be the one at your
workplace or home. You would need to set it up
before you can access it remotely. Log on as
Administrator, since you will need to have

Administrator rights to access the Remote
options. Go to Start > Settings > Control Panel, and
click on the System icon. 

Flip across to the Remote tab and check
‘Allow users to connect remotely to this com-
puter’. Click on the ‘Select Remote Users’ tab.
Here, click on Add to add users who intend to
connect remotely. Either enter the usernames,
or locate the usernames by clicking on
Advanced. Ensure that the Location (com-
puter name) is correctly set, and click on
Find. Click OK, to get back to the Select Users
menu. Again, click OK, and the user is added
to the list. By default, the Administrator has
access to the service. You can remove a user
from the list by highlighting the username
and clicking on Remove. Finally, click OK,
and return to the Remote menu. Here click
OK, and your system is set to receive the
remote connections. You can now lock your
Windows XP machine. 

Note that you also need to have the nec-
essary associated services turned on to con-
nect remotely. 

Also remember to leave your computer
turned on, and connected to the network—
the Remote Desktop service will not be able to
physically switch on your computer! 

Setting up the client
You need to have the Remote Desktop Client
software to connect to the host computer.
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Ensure that Terminal Services, Remote
Procedural Call (RPC), Remote Access Auto

Connection Manager, Remote Access Con-
nection Manager and Telephony are running
on your PC before using any of the remote
services. Go to Start > Run and type ‘servic-
es.msc’ to start the Services tool. Right-click
on the service and click on Start to start it. 

Also, click on Properties and ensure that
all the associated services listed as Dependen-
cies are activated. 

HP 
Pavilion Desktops

for Incredible
Digital Imaging
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By default, it’s installed in all Windows XP
Professional and Home edition computers.
You will have to install the Remote Desktop
Client software separately for all other Win-
dows editions. 

Starting the session 
Starting a remote desktop session is pretty simple.
Go to Start > Programs > Accessories > Communications
and click on ‘Remote Desktop Connection’. 

Click on Options in Remote Desktop Con-
nection. Here, in General, set all the options

related to Logon settings. Save your
previously entered sessions, along
with the authentication details in
Connection Settings, so that you
can log on without entering a user
name and password. Tweak the key-
board and sound options under
‘Local Resources’. Programs lets you
start programs when you connect,
and Experience lets you set the kind
of eye candy that’s acceptable, con-
sidering your connection speed.
Keep the eye candy to a minimum,
and set  the Colors options (within
the Display tab), to a lower value if
you have low bandwidth connec-
tivity. Also, remember to change
the resolution to an appropriate

value. 
Now, specify the

computer that you
intend to connect to.
Enter in the host’s
name or IP address,
and click Connect. A
logon prompt comes
up. Enter the user-
name and password. 

During the ses-
sion, the host is
locked. Unlock it by
pressing [Ctrl] + [Alt] +
[Del], and the remote

session is terminated. 

There’s more 
Remote Desktop can be used in full-screen
mode, or as a windowed session. The default
settings apply keyboard shortcuts for the full-
screen mode. Hence, you get the feeling of
physically operating your host PC. In fact,
just about everything appears as though you
are physically on that host computer—your
disk drives, your mapped and network drives
and network shares, and so on—all your PC’s
resources are literally at your fingertips, and
you could start file transfers and send and
receive e-mails or review documents. 

Remote Desktop can also be used inside an
office to collaborate over a project, or share an
idea with the rest of your colleagues. Since most
remote connections support text and graphics
cutting and pasting through the clipboard, you
can cut out or copy text from the remote
machine and paste it to a local document as
often as needed.
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This is the expert’s view of your desktop

You can chat with the expert
through this chat window

Use Remote Desktop to copy text across PCs,
and more
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Storing bytes
and bits is their
job. Here’s more
on these huge
technology
godowns
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You need to formulate a backup strategy
based on your requirements. One of the
primary decisions is the frequency of
backup. For home users, where there isn’t
much data generated, a manual backup,
as and when required, should do fine.

For small firms with about 10 to 20
employees, this won’t work. Here, a
systematic schedule needs to be set to
make sure that the data on each
computer is backed up regularly.

Moreover, the data backup schedule
should not interfere with a users’ regular
working schedule. The best option,

therefore, is to schedule backups at
night, after office hours.

The next important aspect is the size
of the backup. Almost all backup software
provide at least two levels of backup—full
and modified. The Full option backs up all
data from a specified location, irrespective
of whether the data is modified, or is in
its original form. This form of backup is
inefficient, and consumes lots of space.
Modified backup is a more sophisticated
method that can let you back up only the
data that has been modified, thereby
saving system resources.

Backup Strategies

The number of files and folders
on your hard drive increases as
you keep installing programs. If

the files are not properly organised, the
performance of the hard drive
degrades, and you will end up wasting
valuable time searching for files. The
best way to keep a check on this is to
partition your hard drive, and allocate
the partition sizes according to the
number of applications that are going
to be installed on the system, and the
amount of data that will be stored. As far
as storing files and folder goes, here are
a few simple tips to follow. 

■ Always store all your documents
and other working data on a sec-
ondary partition.

■ Name a folder based on the data that
is stored in it.

■ File names should be such that they
carry sufficient information regarding
content, date created, etc.

■ Keep separate folders for different
kinds of files such as images, docu-
ments, and so on.

■ Try not to install games, applications,
and other system utilities on the main
partition, since this will clutter the disk
with data, and hence affect disk access
time, and therefore performance.

■ Over a period of time, as data gets
stored and deleted, it becomes neces-
sary to defragment the data.

Organising Files and Folders



“Invalid system disk. Insert system
disk and press any key to continue.”
That’s the dreaded hard disk failure

or file system corruption message none of us
want to see, but chances are most of us will,
at some point or another!

That’s because most of us don’t really
take care of our hard disks; we install pro-
grams blindly, and dump all sorts of junk on
them. In order to make a hard disk last and
perform better, all that is needed is a little
tender loving care (TLC).

The hard disk, by far, is the most impor-
tant component of your PC. If your processor
blows up, you get a new one. The same goes
for the motherboard, RAM, or any other
component. But if your hard disk crashes,
you lose every last bit of data you ever cre-

ated and saved. Your PC
comes to a standstill, and
all your presentations,
movies, music, docu-
ments and other valuable
data is probably lost for-
ever. Sure, you can try to
recover it, but that’s a
tedious process. At best,
you can format the disk
and reload the operating
system, and hope the disk
will last longer this time.

Call in the sweepers
In order to keep your
hard disk in shape, the
most basic requirement is

a thorough cleanup. To do this, go to the
\Windows\Temp folder, and delete all the files
there. Now, empty the Recycle Bin. The next
step is to clear all useless Internet files from
Internet Explorer. Go to Tools > Internet Options
in Internet Explorer. Here, click on Delete
Cookies, Delete Files (select the ‘Delete all
Offline Content’ checkbox), and Clear His-

tory. Besides these basic measures, there are
third-party applications, such as Win-
dowWasher and Norton CleanSweep, that
clean your hard disk for you.

Norton CleanSweep: This software lets
you select the files you want to remove in
order to clean your hard disk. Start the
CleanSweep wizard by navigating to Start >
Programs > Norton SystemWorks > Norton Clean-
Sweep > Cleanup > Norton Fast & Safe Cleanup.

In the main dialog box, click on Settings,
and select all the options present, including
‘Temporary Internet Files’. Click OK, and in
the main window, click on Clean Now. This
will clean all the junk files, and show a
report of the total number of bytes freed up.
Close the window, and return to the Sys-
temWorks window.

You can also go to Norton SystemWorks >
Norton CleanSweep > Internet, and select the
‘Internet Cache Cleanup and Cookie
Cleanup’ option. This will clean up the

cookies you accumulated while surfing. You
can also select the ActiveX Cleanup and
Plug-in Cleanup options to remove outdated
or unused plug-ins, or ActiveX controls that
Internet Explorer downloads automatically.
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■ An entry-level solution with
features you would expect
from a more expensive drive

■ 40 Gbytes, 5,400 RPM
Performance Level, Ultra
ATA/100
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The Internet Junk Cleanup option in Norton Clean-
sweep helps clear cookies

Using Internet Options, delete all the
temporary files created while surfing

Barracuda 5400.1
Enables Higher Margins and Greater

Flexibility for Customers
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Applications that do not have their own
uninstallers can be removed using Clean-
Sweep’s Uninstall Wizard. You should use the
Uninstall Wizard even for applications that
do have their own uninstaller, because Clean-
Sweep does a better job of uninstalling a pro-
gram. Go to Norton CleanSweep > Cleanup >
Uninstall Wizard, and you will see programs that
do not have uninstallers.

Select a program you want to remove, and
click Next. You are given an option to back up
the program, in case you change your mind
later and want the program back. Select Yes,
and choose the directory to back up to.

Now, you will be offered the option of
manually choosing which files to delete,
choose No, and click Next. The last screen
will show you the total amount of data, in
bytes, that will be deleted, and a list of the
selected files—you can choose to keep cer-
tain files by de-selecting them. Click OK to
return to the main window, and Finish to
uninstall the program.

Ontrack System Suite: With Ontrack
System Suite, you can go to ‘One Stop Solu-
tions’ and select Cleanup for a totally auto-
mated sweeping of the Registry, Temporary
Internet Files and other unnecessary files
from your system.

Click Next to see a log of the files
cleaned. Click Done to close the window.

In the Cleanup section, you can
manually select the files you want to
remove—choose from Internet
Cache, Internet History, Internet
Cookies, ActiveX, Plug-ins and
QuickFileClean. Click on QuickFile-
Clean, and choose to empty the
Recycle Bin, and delete the Web
Cache, Web History, Lost Clusters,
Temporary Help files and Broken
Shortcut files. Clicking Next will start
the scan, and you’ll get a report of all
files cleaned. Click Done to close the
wizard and return to the main
window. Similarly, run all the other
wizards for a thorough cleaning.

Ontrack has in-built sub-applica-
tions, each performing a specific task. For
example, the Uninstall module uninstalls
applications, and other modules perform
tasks as varied as moving programs to dif-
ferent folders, or even a different computer,
backing up an application and archiving it.
The archive feature creates a compressed
backup of an application before uninstalling
it.

The first time you run the program,
Ontrack analyses your computer and your
files to create a log of files linked to specific
programs. Once this is done, it’ll show you
a list of programs sorted by categories such

Ontrack Quick Cleanup removes junk files, cookies and unnec-
essary files

The most common reasons for data
loss are:
A virus attack: Many viruses are
notorious for deleting files. Some
try to delete or overwrite the
partition table, which tells the OS
about the start and end locations of
the data partitions on the disk.
Accidental deletion of files: This is
a very simple reason for data loss:
the user deletes important files
without moving them to the
Recycle Bin first. The user may also

delete files from the command
prompt, or through applications
that do not utilise the Recycle Bin,
for example, WinRar.
Physical problems with the hard
disk: This is by far the most common
reason for data loss, and also the
most difficult to remedy. Hard disks
can develop a multitude of problems,
starting from faulty read and write
head alignment, to a badly damaged
head glued to the disk platters due
to stiction (static friction).

Data Destroyers

■ Harness the power of experi-
ence, commitment and inno-
vation from the industry’s
only independent supplier of
notebook drives

■ 40 and 20 Gbytes, 2 and 8
Mbytes option

■ 5,400 RPM, 2.5-inch
Notebook

Momentus
The  First  5400-RRPM  Notebook  Drive  to  Combine

High  Performance  With  4200-llike  Power
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as Desktop, Start Menu, Executables and
Monitored. Clicking on a category scans all
the files in that list, after which you can
select a file or executable to be uninstalled.
The program will run in the background, and
find the related files and registry values.
Then, it shows a screen containing a list of all
the files pertaining to the application. Select
the files to be removed, and click Next.

You will see an alert with SafeSelect
enabled—this is a backup of all the files that
are to be removed. Depending on whether or
not you want to backup the file or program,
select or de-select this option, and press Next.
Click Done when finished. You can also remove
files from other categories in a similar fashion. 

In-house maintenance
The first thing you should do is create a swap
file partition on a drive other than the one
where Windows is installed. This way you’ll
ensure better performance, and also not risk
corrupting your hard drive. Back up your
data on another hard disk—if you don’t have
one, use a friend’s.

ScanDisk (Windows 95, 98 and Me):
Before running Scandisk, close all other
applications using their ‘close’ commands,

and not through ‘End
task’ in Task Manager.
Now, open My Com-
puter, right-click on your
C: drive and select Prop-
erties. Go to Tools > Check
Now, select ‘Automati-
cally fix file system
errors’ and ‘Scan for and
attempt recovery of bad
sectors’, and click Start.
After ScanDisk is done
checking the drive,
reboot your PC and
repeat the process for all
partitions and drives. In

Windows XP, you will not be able to scan the
boot drive while Windows is running.
Instead, you can schedule error-checking for

the next time the computer starts. Reboot
your computer, and let Scandisk run.

Disk defragmenter: After running Scan-
Disk, you need to defragment your data. This
makes your hard disk faster and more organ-
ised, and should ideally be done every 15 days.

To start this utility, go to Start > Programs >
Accessories > System Tools > Disk Defragmenter, select
the drive you want to defragment, and click
Defragment. In Windows 98 or Me, set the
utility to ‘Rearrange files so my programs
start faster’ and ‘Check the drive for errors’,
and set ‘I want to use these options’ to ‘Every
time I defragment my hard drive’. Windows
will arrange your frequently used programs at
the beginning of the drive, for faster access.

In Windows 2000 or XP, you get the
option to Analyze or Defragment. Choose
Analyze to see how fragmented the drive is,
and you will be told whether defragmenting
is required. If it is, click Defragment. You’ll
see a graphical representation of the process
taking place. Do this for all your drives.

Third party Tools
Though heavy on your pocket, third-party
disk utilities do a more precise job of main-
tenance than Windows does.

Norton Utilities: This is one of the most
popular applications, and does a perfect job
of hard disk maintenance. The suite features
a module called Norton Disk Doctor that
does a thorough job of correcting file errors.

Install Norton Disk Doctor, and start it
by going to Start > Programs > Norton SystemWorks
> Norton Utilities > Find and Fix Problems > Norton
Disk Doctor. Press Continue, and select the
drives you want to scan by ticking the boxes
next to them. Click on Options; in the dialog
that pops up, select ‘Enable Free Space
testing’, and click OK. Finally, select ‘Fix
Errors’ in the main screen, and press Diag-
nose to start checking your drives.

Speed Disk: Defragmenting using Speed
Disk in Norton is easy. In Windows 98, start
Speed Disk by going to Start > Norton SystemWorks
> Norton Utilities > Optimize Performance > Norton

For ideal
performance,
check your disk
for errors, and let
Windows
automatically fix
them

■ 35 Percent More I/Os per
Second (IOPS) Than 10K
Drives

■ 73, 36 and 18 Gbytes, 5K
RPM, Ultra320 SCSI, 2
Gbit/sec Fibre Channel

Cheetah 15K.3
Lowest  cost-pper-PPerformance  Disc  Drive



Speed Disk. The first dialog box shows you a list
of available drives. Select the drive which you
want to defragment, and click on Settings.
Click on ‘Optimize swap file’ to defragment
the swap file. You can also arrange files by the
file size, the date they were created, accessed,
or used. These options should be selected only
if you know which files should go where.

You can select specific files or use wild-
card characters. This results in a customised
and efficient defragmentation process. 

For Windows XP, there are no direct
options for setting such criteria, but you can
manually add the filenames you want by

clicking on
D r i v e
Options. In
the tabs
named Files
First, File Last,
Files at End
and Unmov-
able Files, you
can add the
f i l e n a m e s
with wild-
cards so as to
place them
accordingly.

U n d e r
Add File, an
Open File

dialog opens asking for files to be added—you
can select multiple files at once. Finally click
OK and then Start, to begin defragmenting.

You can do the same for other partitions
as well, such as your Games partition, where
you need maximum performance.

Ontrack SystemSuite: This suite is
advanced and very user-friendly. It offers a
wide range of features, such as DiskFixer,
which scans your hard disk for any errors.
Start the DiskFixer Wizard and select the
drives you want to scan. At the bottom of
the window, click on the Settings tab. Select
all the tests and choose Duplicate, from the
Crosslinks option, and then select Delete,

from the ‘Lost Clusters’ option. Select all the
scans under Surface Scan, and click OK.

Back in the main wizard screen, select
‘Automatically fix errors without asking
me’, ‘Save Undo Information’ and ‘Scan
disk surface for read errors’—this helps by
doing a more thorough physical test of
your hard disk. Click Next to see the screen
where the fixer shows a complete map of
your hard disk while it’s checking. Since
the disk surface scan has been selected, 
the time taken will depend on your PC’s
configuration.

Ontrack JETDefrag: Ontrack advises you
to use DiskFixer before using JETDefrag. This
is to ensure that no errors occur during the
defragmentation process. Click OK, and select
the drives you want to defragment. Click on
Settings, and move the Space Consolidation
slider to Maximum. This will eliminate slack
space, and pack the files more tightly. Under
‘Days until files become Rarely modified:’ you
can specify which files will be considered least
accessed—if you specify the number of days as
60, then files not modified for 60 days will be
considered as rarely used or modified. 

In the option ‘Days the files remain Fre-
quently modified:’, set the number of days
that specify which files are considered fre-
quently modified. These files will be placed
at the start of the drive so as to quicken
access to them. Click OK, and then Next. In
the Warning dialog box, click OK to start
the defragmentation process.

Do not open or run anything while
defragmentation is on. After it’s over, press
Done and close the main window. Shut
down Windows, and leave it off to cool
after the heat produced by intense hard
disk activity.

Always remember to perform these
actions, no matter what utilities you
choose, as regularly as possible. Doing this
every 10 to 15 days will prolong the life of
your hard drive, and also make a noticeable
difference in speeds and access times for
your applications and games.
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Sort files according to how often
they are accessed, when defrag-
menting using Norton Speed disk

■ Reliability, Performance and
Low Ownership Cost

■ 147, 73 and 36 Gbytes, 10K
RPM,  Ultra320 SCSI, 2
Gbit/sec Fibre Channel

Cheetah 10K.6
Lowest  Cost  of  Ownership  10K  Disc  Drive



To protect against the growing threat of
viruses, and the morbid fear that your
hard drives might crash, backing up reg-

ularly is an exercise you can ill afford to avoid.
But it can be a chore that even the most ded-
icated computer users procrastinate, often
until it’s too late.

So if a software eradicates this drudgery,
and entices us into becoming committed
‘backers’, it’s definitely worth a few hundred
rupees.

Second Copy 2000 from Centered Systems
(www.centered.com) is one such program. Add a
list of the files you want to back up, and it
copies these automatically to a destination of
your choice. In networked environments, you
can select to back up data to another PC. In a
computer with two hard drives, you can
mirror the data on the other drive, since it’s
highly unlikely that both machines and both
hard disks will fail at the same time.

Second Copy organises your backup needs
into profiles. Each profile defines the set of
files or folders that you want to copy, the loca-
tion where you want to copy these files to, and
the frequency of backups. Click on the File

menu and select New Profile. This will bring
up the New Profile Wizard window, from
where you can select either Express setup or
Custom setup. Express setup, as the name sug-
gests, is really easy to use, and you need only
answer three basic questions (What, Where
and When). Once configured, Second Copy
monitors the source folder (What) for changes
or updates, and copies new or changed files to
the destination folder (Where) automatically
at the scheduled time (When). Alternatively,
you can create a new profile by simply drag-
ging the folder you want to back up into the
Second Copy application window. 

haute gear ■
■ printers
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Tracks and sectors: A hard disk consists of platters on which
data is stored. These platters consist of tens of thousands of
tracks that are tightly integrated in concentric circles. Tracks
are broken down into sectors. Hence, a sector is the smallest
addressable unit on a hard disk.
S.M.A.R.T: Self-Monitoring Analysis and Reporting Tool. This
system uses internal hard disk monitoring technology to
analyse your hard disk, and prevent failure or data loss.
Bad sector: A sector that cannot be used due to a physical
flaw on the disk is called a bad sector.
Clusters: A cluster is a logical unit of storage on a hard disk or
floppy drive. The size of a cluster varies from 512 bytes to
256 KB, depending on the file system and on the size of the

partition.
FAT: File Allocation Table. The FAT tells the OS which portions
of the disk belong to which file. The FAT links together all the
clusters belonging to each file, no matter where they are on
the disk.
Partition: By default, when a hard disk is formatted, it has
one partition. A partition can be considered a formatted sec-
tion of a hard disk. Large hard disks can be formatted into
multiple partitions, and each partition behaves like an individ-
ual, or separate, hard drive.
Boot disk: A special floppy, known as a boot disk, allows your
PC to boot, even if it cannot boot from the hard disk. Such a
disk is also known as a System Rescue Disk.

Glossary
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Second Copy’s Profile Wizard  eases  the task of
data backups

■ Reliability, Performance and
Low Ownership Cost

■ 147, 73 and 36 Gbytes, 10K
RPM,  Ultra320 SCSI, 2
Gbit/sec Fibre Channel

Barracuda®  7200.7 and
Barracuda 7200.7 Plus   

World's  Toughest  and  Quietest  High-  Performance
Desktop  Drive  With  Record-SSetting  Storage  Density
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Forget wires,
connect
invisibly
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The growing popularity of laptops
necessitated the need for a wire-
less standard that would allow

people to walk around with their lap-
tops, while still connected to a network.
WiFi, an abbreviation for Wireless
Fidelity, is a wireless standard that offers
mobility while offering data rates com-
parable to those of a wired LAN. It’s
actually a collection of standards rati-
fied by the Institute of Electrical and
Electronic Engineers (IEEE). In 1997,
IEEE approved the 802.11 standard,
which laid down the specifications for
WLAN (Wireless LAN). Subsequently,
revisions were made to this standard
and these resulted in three other stan-
dards-802.11a, 802.11b and 802.11g.
The entire family of 802.11 standards
are collectively called WiFi. The letters
appended to the standard indicate the
task group that proposed the modifica-
tions: for example, task group ‘b’ put

forth the 802.11b standard.
The name WiFi was first given to

the 802.11b standard. Approved in
1999, 802.11b offered extensions to
the original 802.11 that improved the
highest datarate from 2 Mbps to 11
Mbps. It operated in the 2.4 GHz fre-
quency range, like with the original,
and had a range of about 300 feet.
Range and speed are interrelated—as
the wireless clients move further away
from each other, the speed is bound 
to deteriorate.

802.11a operates at 5 GHz, and
hence is incompatible with 802.11b.
So, a laptop with an 802.11b card can’t
connect to an access point running on
802.11a. Also, the range of 802.11a is
lower than that of 802.11b; hence,
more access points are needed. On the
bright side, it offers a much higher
throughput-54 Mbps.

Interference is a problem with
wireless networks.
Bluetooth devices
and cordless
phones are some
sources of this
i n t e r f e r e n c e .
802.11a is less sus-
ceptible to interfer-
ence compared to
standards such as
802.11b.

To solve the lim-
itations of the ‘b’
standard, and at the
same time provide
thespeed of the ‘a’
standard, 802.11g
was introduced.
802.11g offers
speeds of 54 Mbps,

WiFi: How it works
Wi

re
les

s

Here’s a typical Wi-Fi setup in an office environment
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while maintaining compatibility with
802.11b networks.

A wireless network can work in two
modes—ad-hoc and base station. In an ad-
hoc (also called peer-to-peer) network, sev-
eral computers equipped with wireless
hardware come together to form a network.
All the computers communicate with each
other directly. Unless one of the computers
participating in the ad-hoc network is con-
nected to a wired network, none of the sys-
tems can gain access to a wired network.
Three friends meeting in a park and sharing
files between their wireless laptops is an
example of an ad-hoc network.

The other type of network involves the
use of an access point, also called a base sta-
tion. The access point acts as the central point
of the network, and is the link between the
wired and wireless networks. An access point
can be a dedicated hardware system, or just
software running on a system.

In airports and coffee shops, mostly in
the US and Europe, access points are pro-
vided so that customers can walk into the
shops and start using the Internet from

their laptops. Of course, it may not be pos-
sible to cover an entire airport, or an
office, with a single access point. All
access points have a Service Set Identifier
(SSID) assigned to them, as do all the
clients connected to them. When an
access point is installed, the default SSID
must be changed to increase security, and
to prevent users who intend to connect
from some other spot.

WiFi has a basic level of security pro-
vided at the physical level—Wireless
Equivalent Privacy (WEP). But as men-
tioned, vulnerabilities in WEP have been
discovered, and one can’t afford to use it
as the only security mechanism. However,
it is recommended that WEP be turned on.
Additional levels of security can be pro-
vided at the software level in the form of
firewalls. The level of security offered by
WEP depends on the number of bits used
for the encryption key; almost all WiFi
products come with a 40-bit encryption
key. A 104-bit encryption key is also avail-
able, and it is recommended that the
largest available key be used.

Wi-Fi networks have risen from IEEE networking
standards. The 802.11 IEEE covers the wireless
networking standard. Commercial wireless access
points were promoted in early 1995.

Wayport, a pioneering organisation in
the Wi-Fi space, based in Austin, Texas, set
up wireless networks in early 1997. The
same year also saw the IEEE 802.11
standards being finalised. 

Back in 1999, Apple offered Wi-Fi support
along with the necessary hardware. 2001
saw the emergence of many companies that
worked on public Wi-Fi, but several have
since disappeared. In October 2002, the
emergence of WPA, which has now replaced
WEP, ensured better security. Intel worked on

the Banias CPU architecture that led to the
development of the Centrino platform in
2003. This platform works with a Pentium M
CPU, the 855 chipset family, and a wireless
network adapter that conforms to the
802.11b standard. 

In the US, public Wi-Fi access has
boomed. Starbucks, the coffee chain offers
Wi-Fi services, as does McDonald’s.
Internationally, college campuses, hotels,
airports and bookstores, such as the Barnes
and Noble bookstore chain, are getting Wi-
Fi enabled as well. There’s a large laptop
population in the student and white-collar
community who actively use these services,
both for work as well as  leisure.

Around the World in a Wi-Fi



Setting up a WLAN is really easy. How-
ever, requirements change depending
on your network type. There are two

ways to go about this: either you have a pure
wireless LAN, where every computer is freely
portable, or you share a WLAN with wired
computers, in a hybrid of a wired and wire-
less LAN.

To configure a pure wireless network,
you need to install the cards and configure
them to run in ad-hoc mode, which can be
done from the network connection wizard

in Windows XP, or the utility bundled with
the adapter card. After that, install a proxy
server on the computer with the Internet
connection (the master) and set the others
to access the Net through it. That’s it—your
network should be up and running.

However, a word of caution: When buy-
ing wireless hardware, make sure it’s compati-
ble—802.11b (Wi-Fi) will not work with
802.11a/g hardware. Also, wireless equipment
from different vendors may or may not work
together. Buy all your wireless hardware from
a single vendor to avoid such problems.

Setting up a hybrid LAN is a tad more
complicated. Follow these steps to connect
and configure an Access Point to set up your
hybrid LAN:

Connect the Access Point to the
existing LAN with a regular RJ45
cable, which costs around Rs 50 for

a 5 metre cable.
Power up the Access Point and
access the in-built Web server by
entering its IP address—for exam-

ple, http://192.168.0.1, in the browser at the
master. This will open a configuration page,
from where the rest of the Access Point con-
figuration can be done.

Click on the Wireless tab. There are
default values assigned to various
fields. Change the SSID to some-

thing else, such as Home or Wireless, and
assign a network key. Set it to run in infra-
structure mode and set the WEP to 64-bit
from the drop-down menu.

The reason for not using 128 or 256-bit
WEP encryption is that higher settings will
lower the data throughput. Under the LAN
tab, there’s a default IP and subnet mask—
do not change this. Click on the DHCP tab.
Here, enable the DHCP server and assign a
starting IP (say 192.168. 0.2) and ending IP,
say 192.168.0.254, for the client adapter to
automatically pick up IPs.

Enable DHCP only if you want the client
PC to get its IP automatically, otherwise dis-
able the DHCP server and manually assign
the IPs for the client PCs.

Now, all you need to do is configure the
clients.

Install the adapter drivers, then
shut down the PC and plug the
adapter card into the PCI or PCM-

CIA slot, and restart the system. Wait for the
driver to initialise the adapter.

Once the hardware is initialised,
double-click on the adapter card
configuration icon in the system

tray. This will launch the configuration util-
ity. Here the user doesn’t have to do any-
thing, as most of the settings, including the
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Status is fine, all systems ready to go wireless!



138 JUNE 2004

haute gear >> Wireless

Strip AD

SSID and encryption key, are automatically
picked up by the adapter card from the
Access Point.

Check the signal strength available
at the place the wireless desktop, or
laptop is placed by double clicking

the utility in the taskbar.
While setting up a wireless network, it is

important to remember to place the access
point in a proper place: metal tables, cup-
boards, and cabinets filled with clothes can
cause a drop in throughput. Though a wireless
connection is the best choice for a multi-storey
house, there will be obstacles such as walls,
flooring, metal tables and microwave ovens
which might lower the data throughput. To
avoid this, move the access point around to
find the place where the clients get the maxi-
mum signal strength. The same process will
have to be repeated for the clients’ placement.

Clear to Fly
Window panels with a metallic coating, wooden
stuff, etc. greatly contribute to signal disturbance,
thereby resulting in connection drop outs. Careful
planning is required while placing the Access
Point. Sometimes, one needs to set up multiple
Access Points.
Location of the Access Point (AP)
The location of the AP is of utmost importance. It
depends upon parameters such as line-of-sight and
height from floor level. To get broader coverage
per AP, you need to make sure the AP is in the line-
of-sight from many different directions at the same
time. Similarly, the height at which the AP is placed
can influence the coverage area. Depending upon
the internal structure, the range will increase or
decrease as you move the AP up or down.
Reflective/Absorbing Materials
Metal causes multipath issues due to
reflection, and it could impede signals. The
signal deterioration will depend on how well
the container is sealed, and on the thickness
of the metal. 802.11g has lesser problems
because of OFDM (orthogonal frequency
division multiplexing). Still, a given access
point won’t provide the same range where

there’s a lot of metal, than it would in a
typical office environment.
Frequency Band Issues
The band also plays an important role. The lower
the band, the more tenacious it is (2.4 GHz vs. 5
GHz). Therefore, 802.11b or g is more reliable
than 802.11a.
Security
Without stringent security in place, installing a
WLAN is the equivalent of putting up Ethernet
ports everywhere. Even if you use the default WEP
security, it’s not safe enough due to its
dependence on a static encryption key. WPA (Wi-Fi
Protected Access) is more preferred. Further, inline
WPA2 with still better security is also coming up.
Government Regulations
As far as IEEE networking standards are concerned,
the Indian government Wireless Planning
Commission (WPC) has permitted unlicensed
usage of the IEEE 802.11b wireless networking
protocol that allows for WiFi connectivity at 11
Mbps. The same is not the case with the IEEE
802.11g standard: the regulations are not very
clear, but vendors claim that implementation
within a closed environment are possible. You
should check the current status on the regulation.

Tips And Tricks

Place the Access Point such that the users
get the optimal signal reception.
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■ WiFi is best suited for corporates with sev-
eral employees moving about the office
with their laptops.
■ Homes looking for a means to share a
broadband Internet connection can also
consider adopting WiFi.
■ WiFi may be widely used for communi-
cation between computers, and there are
PDAs that support it. It’s also possible to
add WiFi support to a PDA by inserting a
WiFi card into the SD (Secure Digital) slot.
■ In offices with lots of switches etc., WiFi
can help the administrator. If these

devices—the switches and so on—are Wi-Fi
equipped, the administrator can monitor
the devices remotely.
■ A WiFi setup is more expensive than a reg-
ular LAN.
■ The major problem with WiFi is the high
power consumption, which some mobile
devices just can’t afford. WiFi drains bat-
teries, fast. PDA users should avoid using
it, especially if they have a Bluetooth
option.
■ Security is not very easy, since it is diffi-
cult to control access to the network.

What’s good and what’s not about WiFi

For a system to connect to a WiFi network,
it needs to have a WiFi network card, or
an access point, connected to it. WiFi
network cards are like regular network
cards that plug into PCI slots, but have an
antenna. It’s also possible to plug an
external WiFi adapter into a USB port.
Once the network cards are installed and
configured, the system can connect to any
WiFi network.

Hardware access points can be
connected to network equipment such as
a bridge, or they can be connected to a
system that has access to a wired network.
It’s also possible to install software that
converts the system into an access point.
Hardware access points are generally used
in commercial hot spots, while software
access points are used to share an Internet
connection in homes and SoHos.

WiFi: What you need to know

Strip AD
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The marriage of wireless and networks
has seen the evolution of WLANs that
have enjoyed a remarkable success in

the LAN world during the last decade. 
WLAN technology has been adopted at

two levels. The first, and the most com-
monly deployed, form co-exists with the
wired network at the workplace to give
users mobility and ease-of-reconfiguration.

The second level is its large-scale
deployment through the setting up of
hotspots—geographic locations where an
access point provides wireless broadband
network services to mobile visitors.

While vendors are doing their bit to
push wireless among potential users, there
are still issues such as security, spectrum
availability and above all, lack of awareness
retarding its growth.

These hurdles notwithstanding, wireless
is undeniably a technology that holds
tremendous potential and resellers would
do well to keep themselves abreast of its
basics and the advancements in this area. 

Another point in its favour, as far as
India is concerned, is that there’s no license

fee on wireless LAN implementation. The
headache of getting permission is taken up
by the device manufacturer. 

As far as IEEE networking standards are
concerned, the Indian Government’s Wire-
less Planning Commission (WPC) has per-
mitted unlicensed usage of the IEEE
802.11b wireless networking protocol that
allows for Wi-Fi connectivity at 11 Mbps.
The same is not the case with the IEEE
802.11g standard: The regulations are not
very clear but vendors claim that imple-
mentation within a closed environment are
possible. You’d do well to check on the cur-
rent status on the regulation.

Security is a critical issue with wireless
transmission. Since the signal in a WLAN is
freely transmitted in space, anybody in the
vicinity has access to it. This can include a
hacker sitting in a car parked just outside
your home or office. SSIDs are used to
identify the wireless adapters installed in a
wireless environment, by access points. The
SSID is broadcasted freely many times by an
access point. A hacker with reasonable
experience and the help of an 802.11
analysis tool, can sniff the network to get the

SSID, and hence, free access to the home or
office network.

Wireless networks can enable WEP (Wired
Equivalent Privacy), a form of encryption,
available in 64, 128 and 256- bit that will
keep amateur hackers away. However, an
experienced hacker can gain access by
monitoring the data transmission and
decoding the WEP-encrypted information.
WPA (Wireless Protected Access), a more
secure encryption standard, is in under
development, and will be available soon.

Wi-Fi hacker alert!

Wireless connection  

Plug these PCMCIA cards into your laptop to 
go wireless

haute gear >> Wireless
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My eyes open slowly. There’s
a smell and chill in the air
that only happens every

morning at exactly 7:13. I love waking up
to the sounds of birds chirping outside
my window, and feel the sun shining on
my face, diffused through the light cloud
cover. As my senses flow back into me
slowly, the day seems full of promise! 

BRRRING, BRRING, BRRRRRRING,
screams my battered, old MTNL phone.
AARGH! What an ugly ending to such a
beautiful start! BRRRING, BRRRING,
BRR… ‘Oh shut up already!,’ I scream, as
I snatch at the receiver.

“Hello? Oh good morning sir. No, no,
I wasn’t asleep…I was, err…actually just
about to start on some research for the
project. Yes sir, on Monday it will be 
on your table. Now? No sir, no plans for
today. Yes sir. I’ll see you in the office at
12. All the data? No sir, I can’t e-mail it.
No, actually I can e-mail it, but uploading
30 MB on my Internet connection would
take all day. Yes sir, not a problem. I will
find a way to bring the data with me. Yes
sir, see you at 12. Bye.”

Disgusted for being such a pushover,
and a yes-man to boot, I start getting
ready. Damn! Another Saturday wasted at
work. Now how do I get 30 MB of data
from here to office with least effort? Still
pondering, I look out of my window, and
see the cyber cafe opening shop. 

Aha! I pat myself on the back for
having been able to save my skin again,
and set off for the cafe. My friend owns
it—or rather, he is a friend because he
owns it, and I just happen to participate
in the monthly Quake III LAN parties. He
has a thumb drive that will hold my
darned 30 MB of data. 

At home, it takes no time to transfer
the data onto the thumb drive. These
solid state devices have such high read-
and write-speeds, I decided to get one for
myself! After my meeting, or should I say

bottom-kissing session, my boss told me
even he wanted one. 

So I stopped by Lamington Road to
get a feeler for the prices. The first shop

was an authorised dealer for Transcend;
Rs 2,050 for a 128 MB drive and Rs 4,250
for 256 MB. “Anything else?” I ask. He
promptly pulls out a Samsung, a Bil-
lionton and a Lexan. I’d never heard of
the last two, and was told that these are
little-known Taiwanese brands. “The
Samsungs are cheap (Rs 1,800 for 128 MB
and Rs 4,000 for 256 MB), but are infa-
mous. The other two are for low budget
users, but not recommended,” said the
dealer. The Billionton would cost Rs 2,350
and Rs 3,500, and the Lexan would set me
back by Rs 2,000 and Rs 3,250 for the 128
MB and 256 MB varieties, respectively.
Impressed by his honesty, but depressed
by his prices, I moved on.

The second guy I went to, had the
same Samsung drives for just Rs 1,600
(128 MB) and Rs 3,400 (256 MB). He also
had the Transcends for Rs 2,000 and
3,500. I feigned disinterest, so he
promptly whipped out a credit-card-sized
external hard drive. This USB 2.0 baby
would cost me Rs 8,000, and hold 20 GB.
I borrowed his calculator to work out the
cost per MB ratio—Rs 2.56 per MB. 

He also showed me another device
from Xtec, which could hold 40 GB of
data for just Rs 7,000. He told me that
Transcend was also releasing a 40 GB
model, but it would take a couple of
months and cost a lot more. When I
called my boss to tell him this, he 
was elated, but asked me to get it for 
less. Typical!

At last I settled on the product, so
finding the best deal wasn’t that hard.
After browsing through four or five shops,
I walked into a small dirty-looking store
that was selling the Xtec. He wanted Rs
5,000 for the 20 GB and Rs 6,700 for the
40 GB. Well, all I could bring him down
to was Rs 6,400 for the 40 GB, and Rs
2,500 for the Samsung 256 MB. I ended
up buying the latter.

At least my boss was happy, and I
don’t have to sit around a cyber cafe
waiting for slow uploads to complete. 

■ Look for security features such as read-and-write switches, biometric
identification, or at least, software-based security features.

■ The drive should have a key ring, or a hook to attach to a cord, for
easy portability.
■ Data transfer speeds vary! Check this before anything else.
■ Cost per MB is a good way to decide between smaller thumb drives and the
larger external hard drives.

Porta-bi-li-ty, spelt you-ess-bee
Slow uploads? No problem...Thumbs up to thumb drives

Mahesh Benkar
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You’re sitting at home, looking out
the window, enjoying your coffee. It
begins to rain: the smell of parched

earth quenching its thirst rises. Life is just
perfect right now. You start humming your
happy tune. The same, if you’re depressed,
elated, or even just numb. 

There’s a song for every occasion, and
for every thought you’ve ever had. Some
of us are actually gifted enough to make
our own music, the rest of us have always
wanted to learn—but never quite get
down to it. 

How’s this for starters: wouldn’t you
love to be able to play an instrument, know
how to record what you play, and finally,
how to clean up your masterpiece, so that
it sounds professional? All you’ll need is a
computer, a connection to the Internet,
and of course, the instrument you’ll be
playing. Very soon you could be serenading
your sweetheart, strumming romantic
tunes and all!

Let’s start with a little history of music.

The Indian connection
Sound of India (www.soundofindia.com) has
a wide range of articles that describe the
origins of the sur and taal of Indian
sangeet. ITC Sangeet Research Academy
(www.itcsra.org) is another Web site that
chronologically details the evolution of

Thank 
you 

for theAlways wanted to be able
to strum while humming?
As the ad campaign says,
“Just do it!”

MUSIC

PHOTO: Mexy Xavier 
IMAGING: Atul Deshmukh
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Hindustani classical music. MusicalNir-
vana.com gives you all the insight you
need into the basics of raag and ghazals.
It gets into the nitty-gritty of all you need
to know about the history of these two
forms of melody. The instruments section
lists all the instruments used, with 
links to the artists accomplished in 
that sphere. 

Cybersangeet.com does a good job of
profiling artistes who’ve given their heart
and soul to Indian classical music. It gives
a detailed account of the likes of vocalist
Mitali Banerjee Bhawmik, sitar player Joya
Biswas, tabla player Subrata Gupta and
their work in its Profile section. Surd-
hwani.com talks about the lives of Pandit
Bhimsen Joshi, Ustad Bismillah Khan, and
a number of members of the classical ilk in
its Artists section. Its Indian Classical
section, with its Tal, Raag and Vocal sub-
topics does not frighten you from delving
into the intricacies of it all.

Get to know what Indian classical
music is through the eyes of the maestro
himself—Pandit Ravi Shankar, at his Web
site, www.ravishankar.org. His appreciation
of Indian classical music highlights the
finer nuances of the entire genre. 

Pandit ShivKumar Sharma’s site
(www.santoor.com) profiles the acclaimed
santoorist in detail. It also lists his releases,
and also reviews them with short clips
from releases to complete the picture. 

Ustad Amjad Ali Khan, the acclaimed
sarod player, who likes to call himself “a
slave to” (rather than “a king of”) the
sarod, bares his love for the instrument at
www.sarod.com. The Web site also chroni-
cles important events in his life, and also
lets you in on his family tree. It mentions 
the Sarod Museum called the Sarod Ghar,
located at Gwalior, that endeavours 
to preserve the traditions of Indian 
classical music.

Go West…
Essentials of Music (www.essentialsofmusic.
com) is a Web site that will surely delight
the western classical music lover. Whether
it’s Bach or Beethoven, each has been
covered in just the right amount of detail—
a few of their works are posted on the biog-
raphy page to give a feel for their
compositions. Its Eras section dissects the
evolution that came about in composi-
tional styles with time.

Another such Web site is Classical Net
(www.classical.net). It lists information about
when classical composers were born, the
day they died, etc. There are also exhaustive
links to other Web sites that provide
detailed information about composers. The
reviews and articles posted are concise. 

If you want to get to know the people
behind jazz, then All About Jazz
(http://www.allaboutjazz.com/library/index.htm)
is where you need to go. Learn all about
Ella Fitzgerald, the first lady of song, Gene
Harris, Tony Bennet, etc. Learn about the

albums that made them, and this peculiar,
yet delightful, kind of music that originated
in New Orleans. Louis Armstrong has a
special profile page dedicated to him in
Profiles. Another interesting Jazz Web site is
www.thejazzfiles.com, which digs out inter-
esting facts about the lives of tenor saxo-
phonists Gene Ammons, Johnny Griffin,
and pianists Sonny Clark among others.

Rock and Roll? Get the low-down on
its highs and lows at www.history-of-rock.com.
It swamps you with all the things that
happened during the period (1954—1963)
when rock and roll took shape, and came
into existence as a unique genre of music.
Oldies Music (http://www.oldiesmusic.com)
tracks the sound right down to the ’70s.
One of its sections—the Oldies Calendar—
tells you all about deaths, births and other
ground-breaking events that took place in
the current week. Its Oldies Artists sections
has links to Web sites dedicated to musi-
cians and pop artists that made rock and
roll happen. 

Though it sounds like the din in a rail-
way accident, metal music has a dedicated
fan following all over the world. If you’d

“Beethoven can write music, thank God, but
he can do nothing else on Earth” - Ludwig Van
Beethoven 

“There is
no essential
difference
between
classical
and
popular
music.
Music is
music.” -
Ustad
Amjad Ali
Khan

Have you always wanted to say that?
Well, now you can! ACID PRO 4.0,
available at http://mediasoftware.
sonypictures.com/products/acidfamily.asp
lets you synthesise your own music
with a number of effects to boot.

It lets you have a dramatic fade
between tracks, so that they don’t
sound like cut-paste jobs. It also lets
you use as many loops and MIDI tracks
as you like. ACID is bundled with 20
DirectX plugins such as amplitude
modulation, delay, etc.

Fruity Loops studio (www.fruityloops.
com) is another one you should try out.
It has nearly 30 high quality effects
thrown in for better mixing results. Its
inbuilt wave editor lets you edit and
record wave files. The editor also lets you
reverse the track, add loop points to the
file, or record yourself.

Apart from that Fruity Bass Boost,
Fruity Stereo Enhancer and Fruity Blood
Overdrive are some of the cool sound
effects that really add the professional
touch to your compositions.

Oh This? Just Something I Composed…

This band displaced the stranglehold of Iron
Maiden on hard rock. More of this at
http://www.hardradio.com/history/part1.html
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The human eye and brain present a
fascinating problem for game devel-
opers. How do you make a game that

can come close to matching the complex-
ity of visual perception of the average
human? With breathtaking graphics, of
course. How do you make such games
playable? Good question. Here’s where the
cards come in.

With the Radeon X800 and the
GeForce 6800 Ultra, game developers have
in their hands, the newest generation of
programmable GPUs (Geometry Processing
Unit). These have massive number crunch-
ing and processing abilities, cutting-edge
memory technology, and performance
optimisations.

At the cutting edge of the graphics
card industry, nVidia has released its
newest—the NV40-based GeForce 6800
Ultra. Current favourite ATi isn’t standing
idly by—they’ve just released the Radeon

X800 XT (codenamed the R420), the
successor to the hugely popular Radeon
9xxx family.

Computing power
With the new GeForce 6 series family,
nVidia has reworked much of the archi-
tecture to optimise the NV40’s computa-
tional performance.

The GeForce 6800 also boasts of 220
million transistors, as against the 125
million on the GeForce FX 5950. This
number is even more impressive when you
look at the Pentium 4 Prescott’s 125 million
transistors. The ATi Radeon X800 XT  comes
packed with about 160 million transistors,
as compared to the older Radeon 9800 XT’s
110 million transistors. The Radeon X800
XT also scores on GPU clock frequency—it
runs at a higher clock speed than all other
comparable contenders. At a 512 MHz core
clock, this ATi beast beats all the others.

Of course, core clock speeds are a bit
hazy, and might well have changed by the
time you get to buying the hardware. Part
of this has to do with marketing—for
instance, nVidia has announced plans to
introduce a 6800 ‘GT’ variant, a Porsche for
the masses. Costing a little less than the
6800 Ultra, you can get the GeForce 6800
GT, with a slightly lower clock speed, but
lots of graphics memory. Another special,
possibly more expensive edition—the
‘Extreme’ GeForce 6800 Ultra—will run at
450 MHz GPU core clock frequency, with
fast memory. 

Drawing in parallel
More than the numbers, is the graphics
pipelining detail. Well before the X800 XT
and the NV40 came along, there’s been
considerable interest in the features and
specs of the two families, and a lot of
hype. Processing, and accurately render-
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ing computer graphics have traditionally
been described by application developers
as “embarrassingly parallelisable”. What
that means is, the graphics processing
task can be broken down into many
stages and components. The interesting
thing about both the ATi and nVidia
offerings, is the way each handles paral-
lelism in graphics processing. 

The Radeon X800 XT sports 16-pixel-
wide pipelines, split into groups of four—
with four ‘regular’ pipelines beneath each
‘wide’ pipeline. Each wide pipeline works
with groups of four pixels, making for a
total of 16 pixels. Each regular pipeline has
its own pixel shader and texture unit, as
well as shared cache memory across the
wide pipeline.

The  quad pipelines can be enabled or
disabled; thus, the X800 can have from
eight to 16 pipelines in total. Lower-end
models have eight, and higher end

models—such as the X800 XT Platinum
Edition—have sixteen. The X800 now
comes with six vertex shader pipelines—
two more than the 9800 XT. ATi claims
that this, and the increased GPU clock
speeds, gives the X800 twice the vertex
shading power of the 9800 XT.

The X800 now also has more tempo-
rary registers, which allow for more effi-
cient handling of complex shading opera-
tions. The internal floating point calcula-
tion precision in the X800’s pixel  proces-

sors still remains at 24 bits per colour chan-
nel—red, blue, green and alpha—the same
as the 9800 XT. The data formats supported
are both 16-bit and 32-bit. However, the
computational power is significantly
higher, with twice as many arithmetic/logic
units (ALUs). With this, the X800 can
process up to five instructions for each pixel
per clock cycle, as opposed to three with
the R3x0 family. The X800 also scores from
its predecessor with a vast increase in the
number of mathematical and texture
instructions. This means that the X800 XT
can perform complex pixel shader calcula-
tions more efficiently. If the complex pixel-
shading processing cannot be carried out
in a single pass, the job is split, and each
fraction is processed. The results are stored
in temporary buffers and aggregated later.  

The GeForce 6800 Ultra also has a 16-
pixel pipeline unit—a big jump compared
to the GeForce FX5950’s four-pipeline
design. Each 16-pixel pipeline of the NV40
comes with its own texture unit per
pipeline. This differs from the GeForce
FX5950’s 4-pixel pipeline—two texture
units per pipeline, which could output up
to 8 pixels per clock cycle. The 6800, on the

other hand, manages 16 pixels within a
clock cycle—the same as the Radeon X800.
For today’s games, with large and complex
models, and many polygons in each scene,
the 6800’s six vertex shaders provide
dazzling vertex processing performance.
Think of realistic, high resolution game-
play, with fascinating details—that’s the
result of just the sort of serious number
crunching that works here.

nVidia has enhanced the computa-
tional abilities of the NV40 family in other

ways too. First, the number of temporary
registers has been increased—this used to be
a weak point in the FX 5950 series. The pixel
processors can now perform floating point
computations with full 32-bit precision per
colour channel, and with the additional
temporary registers. 

With changes in the internal
programmability of the GPUs, we can
expect to see additional precision in
computing shaders. Developers can now
employ more advanced rendering tech-
niques with fewer compromises. 

Both ATi and nVidia have reworked and
vastly enhanced the vertex processing capa-
bilities of their offerings, and the result of
this will be seen while rendering complex
game models. With a huge amount of
geometric data to be processed, for the
many polygons in each frame, the vertex
processing capability of the nVidia and ATi
cards will be welcome. ATi’s enhanced
instruction set will allow for more efficient
pixel and texture computations, but the
new Radeon does not support the pixel and
vertex shader 3.0 specifications of DirectX

For the sort of hard cash you will shell
out for owning one of the top graphics
cards, you definitely need to have the
games too. Both cards are DirectX 9.0
compliant, so the games you could start
with, and drool over are Far Cry, and UT
2004, as well as Prince of Persia: The
Sands of Time, Splinter Cell: Pandora
Tomorrow and PainKiller, which are
already out on the store shelves. There
are more games coming in the pipeline,
though. Look forward to playing
S.T.A.L.K.E.R: Shadow of Chernobyl and
Half-Life 2 as well. These games aren’t
tailor-made for either of the cards, but
you can enjoy all of these games the way
the developers intended, full with all the
special effects and flashes, bangs and
pops and gore. id’s DOOM 3 would also
be a worthy game for them, as and when
it’s released. 

The nVidia GeForce 5950 FX is
based on the the NV38 GPU
architecture, and the nVidia GeForce
5700 FX is based on the NV36 GPU.

The GeForce 6800 Ultra is the first
example of the the NV40 GPU.

The games that people play

The
GRAPHIC

Details
After more than two years of rumours and ‘informed guesses’,
nVidia and ATi have come out with their latest graphics
blockbusters. Find out what’s changed



9.0. Since the GeForce 6800 Ultra does, this
opens up the possibilities of more dynamic
programming control. 

Memory counts 
After all the hype about increased compu-
tational performance, there’s an even
more important factor—memory. Graph-
ics memory has now moved on beyond
DDR, and both ATi and nVidia have
implemented the spanking new GDDR3
memory standard.

Even more pertinent is how ATi
has worked with the memory. The
Radeon 9800 XT’s problem was the
relatively slower memory clock—730
MHz, as compared to the GeForce FX
5950’s 950 MHz. They finally set that
right by implementing a brand new
memory interface. It’s a 256-bit-wide
interface, similar to the Radeon 9800

XT. ATi claims that this inter-
face is more
efficient, and
that higher
memory clock
speeds are
supported.

Thus far, the
highest end X800
has 256 MB of
GDDR3 that runs
at 1,120 MHz,

yielding a peak memory bandwidth of
33.4 GBps. The interface has four 64-bit
data channels communicating with four
independent memory controllers, via a
switch. ATi says that the memory inter-
face can be extensively tuned; further-
more, the memory controllers can be
reconfigured to perform more efficiently
for certain applications. 

The GeForce 6800 Ultra, too, uses
GDDR3; the 256-bit wide memory bus

clocks at 1,100 MHz, and the Ultra comes
with 256 MB of memory onboard. The
memory bandwidth is a good 35.2 GBps, as
against the FX 5950’s 28.3 GBps, which also
has a 256-bit memory interface running
256 MB of DDR memory at 950 MHz.

Earlier examples of the NV3x archi-
tecture, such as the FX5800, had a prob-

lem with the smaller 128-bit memory
bus width; the FX 5950 changed that to
256-bit. But the biggest change with the
GeForce 6800 Ultra is the potent combi-
nation of the wide 256-bit bus, the
sixteen- pipeline design and the GDDR3
memory, which give it the large memory
bandwidth.

It looks like GDDR3 is the way to go
for the present and the future. The
memory interface, type and the archi-
tectural design are going to affect the
actual pixel and textured pixel (texel) fill
rates, but with the kind of specs the
Radeon X800 and the GeForce 6800
Ultra sport, there isn’t going to be any
bottlenecking there. 

Performance optimisations
Neither ATi, nor nVidia have spared any
other performance optimisations. ATi has
introduced a new compression algorithm
for normal maps, called 3Dc. The normal
maps work on the idea that information
about an object is stored as a texture, and
each texture element stores three compo-
nents of a vector perpendicular to the
object surface at a given point. The
DirectX 9.0 specification offers compres-
sion algorithms for this as well, but those
would lead to information loss, with
blocky artefacts in the stored normal
maps. The X800 also features enhanced
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Anti-aliasing: Anti-aliasing is a
technique used to reduce the visual
impact of aliasing, or jagged edges, on
a computer graphics system.
Anisotropic filtering: An advanced
texture-filtering technique that
improves image quality of objects that
extend from the foreground to deep
into the background.
Fill rate: The speed at which a graphics
card can render pixels, usually
measured in Megapixels per second.
GPUs with higher fill rates can display
higher resolutions and more colours, at
higher frame rates than other chips
with lower fill rates.
Frame buffer: The memory that is
dedicated to the graphics processor
and used to store rendered pixels
before they’re displayed on the
monitor.
Frames per second (fps): The rate at
which the graphics processor renders
new frames, or screens full of pixels. A

faster GPU renders more frames per
second, making the application more
fluid and responsive to user input.
Graphics Processing Unit (GPU): A
high-performance 3D processor that
integrates the entire 3D pipeline—
transformation, lighting, setup and
rendering. A GPU offloads all 3D
calculations from the CPU, freeing the
CPU for other functions such as physics
and artificial intelligence.
Lighting: In 3D graphics, lighting is
used to calculate the degree to which
an object is affected by a source, and is
used in games to create realistic-
looking scenes with greater depth,
instead of flat-looking or cartoonish
environments. 
Pixel: Stands for ‘picture element’. A
pixel is the smallest element of a
graphics display.
Pixel shaders: Pixel shaders alter lighting
and surface effects, which gives a natural
look to materials and surfaces. 

Polygon: The building block of all 3D
objects, usually triangles or rectangles,
used to form the surfaces and skeletons
of 3D objects.
Texel: Texels are the smallest units of a
texture map, similar to pixels.
Texture: An image file that is used to
add complex patterns to the surfaces of
objects in a 3D scene.
Texture mapping: The process of
applying a texture to the surface of 3D
models in order to simulate walls, skies,
etc. Texture mapping enables developers
to add realism to their models.
Vertex shaders: Vertex Shaders are used
to give a life-like look to characters and
environments. For example, developers
can add wrinkles or dimples using vertex
shaders—when a character smiles.
GDDR3: A newer memory standard
that has been co-developed by ATI and
JEDEC, and is an open standard now. It
yields greater performance with lower
power consumption.

Jargon Buster

The GeForce 6800 Ultra. Note the large heatsink and
fan combination, and the two DVI connectors

C
ourtesy: FiringSq

uad.com

The ATi
Radeon 9800 XT
was codenamed
the R360, and
the cutting edge
Radeon X800
was codenamed
the R420
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algorithms for anisotropic
filtering and full screen
anti-aliasing. For video
stream processing, the
X800 uses the same tech-
niques as do its predeces-
sors, called Videoshader
technology. The GPU
performs de-interlacing,
reduces noise levels, has
support for HDTV and
applies anti-aliasing, which
wipes out the typical arte-
facts present in MPEG-4
video compression.

nVidia has added a programmable video processor to the NV40,
with some features similar to the X800—de-interlacing the video
stream, removing blocky artefacts, noise cancellation, and also,
support for HDTV. An exciting feature of the programmable video
processor is that it can fuse special effects onto the picture, in real-
time. Game lighting, for instance, is another exciting feature of the
video processor. nVidia has come up with a new technique to render
dynamic lighting into computer graphics. The feature should bring
in a photorealistic feel into computer graphics, making games more
life-like. 

The GeForce 6800 Ultra also comes with enhanced algorithms for
full screen anti-aliasing, and a new method for anisotropic filtering. 

It’s the interface too
As of now, both ATi and nVidia are offering AGP versions of the
Radeon X800 and the GeForce 6800 Ultra. On the horizon, though, is
the new standard in PC I/O—PCI-Express. PCI-Express is expected to
debut before the year ends, and will eventually replace the  AGP and
PCI standards.

It’s a matter of bottlenecks—AGP, for instance, was developed to
work around the inadequacies of PCI. But if you take applications
such as HDTV-video editing, you’ve just about crossed into a zone
that needs the kind of I/O bandwidth that PCI-Express offers. Over
the coming months, both nVidia and ATi will offer solutions that
will make the transition to PCI-Express from the AGP 8X interface.

What does that mean for graphics cards? They now won’t be
limited by slower speeds due to the interconnect between the system
I/O and the graphics subsystem. It also means that cards can now
happily consume more power to run—the GeForce 6800 FX specs
already necessitates a 480 W power supply. Industry analysts say that
with PCI-Express coming into a position to overtake AGP, card
makers will switch over to it. ATi and nVidia are working on bridge
interconnects that allow for a smoother transition.

So what’s in store?
Processing geometric data for today’s games needs fascinating, cutting-
edge hardware; nVidia and ATi are developing just such fancy hard-
ware. As CPUs get ever more powerful, system memory moves to
DDR2, and PCI-Express makes a move into your desktop, these
advanced graphics processing beasts are going to push the limits of
gaming with fluid, fast gameplay, even when all the bells and whis-
tles are turned on. It’s still going to be a game, and not reality—not
yet, at least—but you’ll come as close as you ever have with the latest
offerings. Gentlemen, start your engines. Let the games begin.

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com

JUNE 2004

1/2 pg VAD

The ATi Radeon X800 XT Platinum
features a small heatsink and fan, and
both DVI as well as analog outputs
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Scenario 1: You have 1 GB of music on
your PC, but need to work on another PC
for a while. You do miss your music, but
don’t want to wait for hours as the songs
are copied to your current PC. And what
if you needed to use yet another PC? Also,
you want to control what
you listen to.

Scenario 2: You want to
hear your music on your
colleague’s speakers over the
cubicle.

Scenario 3: Your boss has an
FM card in his PC, and you
want to listen to the radio on
your PC. What do you do?

All you need is Winamp
(any version except 3.x),
SHOUTcast Distributed
Network Audio Servers (DNAS), the
SHOUTcast Digital Sound Processing
(DSP) plugin and Sound-Requester
plugin.  SHOUTcast (www.shoutcast.com)
is a software allowing people to broadcast
audio, for others to connect and listen to.

Stirring up your own music
Install Winamp. Apart from play-

ing music, it allows you to arrange and
catalogue your music in the order you
prefer. You can also create playlists.

Blow-
ing

your own
trumpet
You now need
to install
S H O U T c a s t
DNAS, which
allows your PC
to serve music
to other
computers. Go

to the newly-created program group for
‘SHOUTcast DNAS’, and click ‘Edit
SHOUTcast DNAS configuration’. A .ini
file opens with a number of configurable
options. The important ones are:
■ MaxUser: The number of people you’ll

broadcast to. A higher
number means more system
resources and bandwidth.
■ PortBase: Set this to a free
port on your PC, such as
8000.
■ Password: Set a password
for Winamp to connect to
the DNAS interface.

Save the file, and click on
‘SHOUTcast DNAS (GUI)’ in
the SHOUTcast program
group to start the software.
It’s now  ready to accept
audio outputted by software
such as Winamp on 

your PC.

Signals to the outer world
Close Winamp, if it’s running, and

install the DSP plugin. Now open Winamp
Preferences, go to Plugins >
DSP/Effect and click ‘Null-
soft SHOUTcast Source
DSP…’ to configure it.

In Output, click
Connection, and select
Output 1. Enter ‘localhost’
in ‘Address’, ‘8000’ in
‘Port’, ‘1’ as ‘Encoder’, and
the password you set in the
DNAS .ini file.

Next, in the Encoder
tab, select Encoder 1, and
set what quality you wish
to stream at. If you’re low
on resources, select lower
quality. If it’s going to be
just a few people, increase the quality.

Now, return to the Output tab and
click Connect. The status should change

from ‘Not Connected’, to a running
display of the time and bytes sent.

Your PC is now ready to serve. What-
ever you play in Winamp, can be listened
to by people who connect to your PC on
your IP. If your IP is 128.128.0.147, people
can connect to your station via Winamp at
http://128.128.0.147:8000/listen.pls
through Winamp’s ‘Play URL’ feature.

The ‘I can control 
thee’ thing

Install the Song Requester plugin
(http://www.oddsock.org/tools/gen_songre

quester/), which you can
configure so your Winamp
can be controlled from any
PC on the network, via a Web
interface. You will need to
specify a password in the
plugin configuration screen.
Once installed, if your IP is
128.128.0.147, visit
h t t p : / / 1 2 8 . 1 2 8 . 0 . 1 4 7 /
admin.cgi and click ‘Refresh
Playlist Cache’.

Now, you can go to any
PC on your network, and visit
that URL to do the play,
pause, stop or skip operations

on any track.
SAURABH KUMAR

saurabh_kumar@thinkdigit.com

Melodies from Afar

The Winamp DSP plugin shows you the
running status of the time and bytes spent

Find it on the 101 Freeware CD
Winamp 5.0.3
SHOUTcast DNAS
SHOUTcast DSP plugin

Control your music, wherever you are

If you want your
audience to also view
song titles, then in
SHOUTcast DSP
options, click ‘Enable
Title Updates’ and
set all to ‘Auto’ in the
Output tab’s ‘Yellow
pages’ section.

If you have a
secondary audio source
feeding your PC, such
as a TV tuner card or
FM radio, you can select
‘Soundcard Input’ in the
Input tab to stream this
audio. You need to
hook the device’s sound
output to your PC’s
Line-In jack first.

To enforce the same
volume across songs
during playback, you may
want to use a plugin such
as Zyraxs Evil Volume
Normalizer (www.
winamp.com/ plugins/
details.php?id= 79888).
To use more than one
DSP plugin at the same
time, use DSP Stacker
(www. specialaudio.com). 



Two laws govern how soon a com-
puter becomes obsolete—Moore’s
Law and Parkinson’s Law of Data.

Read up on these two, and you’d want to
junk your four-year old PC already. But
hang on—old computers are not worth-
less. In fact, those who know the worth of
an old computer would only be too happy
to buy a second-hand one. So what
exactly do these folks do with their out-
dated machines?

UPENDRA SINGHAI

upendra_singhai@thinkdigit.com
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There are lots of things
you can do with that old
dabba of yours. Here are
a few...

➜

Don’t JUNK
thatPC!

An office assistant
The most common use for older computers, especially amongst small firms and SoHo
users, is account maintenance. Another common use is word processing. Minimum
system requirements for Windows 95 is a 386DX processor, 4 MB of RAM and 50 MB
of hard disk space. Windows 98, too, needs only a minimum of a 486 processor with
24 MB of RAM and 205 MB of hard disk space. 

For word processing and other office applications, install Microsoft Office 97 on
the old computer. MS Office 97 requires a minimum of a 486 Processor, 8 MB of RAM
and 73 MB of hard disk space. Once these are installed, you can do all your word pro-
cessing on the old computer, and free up your newer computer for other, more impor-
tant uses: Games!

For accounting, use software such as Tally’s older versions, 4.5 for example. This
version was discontinued nine years ago, but runs on a 386. Look for other software
that runs on a low-end machine: there are many sites that give you information about
these software, and many discussion forums too. Try www.old-computers.com for one.

Mexy Xavier
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www.old-computers.com 
A site dedicated to old computers. Has a
discussion forum as well.
www.netfilter.org 
The home page of the 
Netfilter/iptables project. Visit this site
for information on iptables.
www.rpmfind.net
A search engine for RPM packages of all
kinds.
www.486superlinks.tk 
A source of old software for old machines.

Sites to visit

Set up a network
Your old computer is going to get much more useful if you network it. Setting up a
basic network is easy—all you need is two Ethernet cards, a cross-crimped network
cable, and some change of
settings on the two machines. 

On the primary comput-
er, enable file and printer
sharing, and set the IP to, say,
192.168.0.1. Set the IP for the
secondary computer to
192.168.0.2 and set the sub-
net mask for both computers
to 255.255. 0.0. 

You’re done! These IPs
can be anything in the
192.168.x.x series, where x is
between 0 and 255.

DJ, play that song
You can turn your old computer into a music server. If you have Windows installed
on your primary machine, there are two ways to do this. One way is to install Win-
dows on the old computer, install Winamp, and then run a ShoutCast server. For
details on setting up a ShoutCast server, see the 30 Minutes Expert on page XX in
this issue. Another way is to simply store all your MP3s on the old machine for
anyone in the network to view and play.

You can also think of installing Linux on the old PC. This will allow you to play
MP3s without installing a GUI. One of the popular command line tools is mpg321,
a free tool that can be downloaded from http://mpg321. sourceforge.net. Before you can
install this tool, you will need to install libid3tag and libmad (the MPEG audio decoder
library). Red Hat Package Managers (RPM) packages for these can be found at
www.rpmfind.net, and are hardly a few KBs in size. Even mpg321 is just a 58 KB file.
Once you’ve downloaded these files, copy them to your Linux machine and log in

as root. First install libmad by issuing
the following command:
rpm -ivh libmad-0.15.0b-2.fr.i386.rpm
Then install libid3tag using:
rpm -ivh libid3tag-0.15.0b-
0.1.rh73.fr.i386.rpm

Now go to the directory where
your music is stored. Here, create a file
named list.pls with the song names,
and press [Enter] after each song. This
will serve as your playlist. Now enter
the following to start playing your
music:

mpg321 -o oss --shuffle --list list.pls
Here ‘-o oss’ specifies you’ll be

using default sound system for output;
‘--shuffle’ specifies that the songs
should play in random order; and ‘--
list list.pls’ specifies the playlist.

Networking two computers requires you to change the
IP settings on the two machines, and that’s about it

Run a ShoutCast server after installing
Winamp, and your old PC is a music server

You can turn your outdated computer
into a file server, a Web server, a proxy
server, or even a music server. Making a
file server is easy. Simply create a folder
and share it with write permissions. The
best use for a file server would be to
install Linux on it and use it for backups. 

With Linux, the chances of your files
getting infected with viruses are remote.
Further, Linux gives you more stability.
If you have other computers connected
to this file server, you can use it as a
repository for shared files, too.

To make your computer a print 
server, just attach your printer to the
computer. Since printing doesn’t require
a powerful processor, older computers
work fine. However, remember that
depending on the drivers of the printer
for various operating systems, you may
need to install a newer version of oper-
ating system for the printer to work prop-
erly. Consequently, some old comput-
ers—even a 486 or Pentium 100—just
might not do.

Setting up a computer as a gateway
helps in several ways. 
■ You can share it with more than one
computer; 
■ It caches Web sites, so frequently visit-
ed Web pages load faster. 
■ You don’t need to set up a firewall on
all the computers separately. 
■ You can maintain a log of what sites
are being visited. 

For this, first download Squid and
install it using the following command:

rpm -ivh ….
Once it’s installed, search for the

squid.conf file. Normally it’s located in the

Servers of all sorts
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Experimenting with stuff
Most organisations don’t seem to like popular IM clients such
as MSN Messenger. Setting up a chat client for a local network,
such as Jabber and IRC Daemon, is an ideal solution. For
details, refer to the May 2004 issue of Digit, on page 136.

One of the best uses you can put your old computer to is
to experiment with stuff you’re not sure about. You can
install Linux, play around with partitions, re-compile the
kernel, and so on. It’s also fun to use old computers for com-
mand-line tools: get a C compiler and learn C the old way.

We said it before and we’ll say it again—there’s lots of
things you can do with your old dabba. Use your imagina-
tion—you have nothing to lose! 

1/2 Pg  V AD

/etc/squid directory. Open this
file in a text editor such as vi,
and find the line under the
ADMINISTRATIVE PARAME-
TERS section  that says: 

# visible_hostname
Change it to  visible_host-

name digit
Assuming you want your

proxy server to be called ‘digit’,
you now need to set the access
permissions in this configura-
tion file. 

Scroll down to OPTIONS
FOR EXTERNAL SUPPORT PRO-
GRAMS, and locate ‘# TAG
http_access.’ Just before this line,
add the IPs of the computers
that can access this proxy serv-
er. For example, if you want to

allow access to 192.168.0.2, add the following:
acl friend src 192.168.0.2
Here, ‘friend’ is an alias. You’ll use this alias in the next step

while setting up permissions. Scroll down and find the line that
says ‘INSERT YOUR OWN RULE(S) TO ALLOW ACCESS FROM
YOUR CLIENTS,’ and add the following:

http_access allow friend
This line needs to be above ‘http_access deny all’. Now, save the

file, and start Squid by typing in ‘squid’.
Next, you need to set up firewall rules. The simplest way to do

this is to use the setup command, if you are running Red Hat. 
Otherwise, you will have to use ‘iptables’. For more details on this,
refer to ‘Lock and Load Linux’ in the April 2004 issue of Digit on
page 102.

One you’re done with the setup, you’ll need to specify the
proxy settings on the other computers before you can browse the
Internet. Open Internet Explorer, go to Tools > Internet Options, and
switch to the Connections tab. Then, click the LAN Settings but-
ton, and specify the proxy server address as 192.168.0.2 and 3128
as the port. Here, the IP we’ve specified is that of the computer
where Squid is installed.

Create a folder, and give it write
permissions.
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Whoops! Here comes that evil
creature called ‘Boss’, making
rounds in the office, spying

on what people are doing. Oops! You
have too many chat windows open, so
many stupid Web sites, and even Solitaire
and Mine Sweeper. As you mentally draft
your resignation letter, while clicking
wildly on all the little Xs you can see,
your boss stops to check the computer of
your colleague in front of you. Phew,
that was too close! Unfortunately, the
girl in front of you didn’t even have time
to say a prayer—she was playing Bejew-
elled, was nearing a high score, and
didn’t notice Big Bad Boss. 

As you wonder who’ll replace her,
you start thinking, “If only there was a
way that I could do all I wanted to, and
not worry about getting caught…”

There are a few ways you can go
about this. None of them are boss-proof,
of course, but they can really save you in
a jam. Here are the 10 commandments
for goofing off.

Thou really should
“Work”

Working isn’t all that bad! Why, we at Digit
work almost an hour a day! The best thing
about the chore is that it leads to the
forbidden fruit—‘praise’—from the powers
that be. If all goes well, you can get a hefty
pay hike, become the boss’ pet, be the envy
of your colleagues, or even join the ranks
of Bossdom. Once in bossdom, you’ll never
have to worry about work again.

If that sounds appealing, ignore this
article, but remember this will cause you
to become a stick-in-the-mud. Prepare to
be hated by all and sundry, watch out for
that potential dagger-carrying Brutus
and remember this article…chances are
you’re going to need to read this in
about a year, once you run out of steam.

Remember thy desktop,
and take a snapshot

The first thing we think of doing in a jam,
is press [Windows] + [M] (minimise all) or

Be a Smart@ss
@ Work

Be a Smart@ss
@ Work

10

9

Who says work 
isn’t fun?

We bring you the 
10

Commandments
of goofing off 

at work
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[Windows] + [D] (show desktop). Some
people also prefer [Alt] + [Tab], always
remembering to keep what’s work related
as the previous window visited. On a bad
day, you end up looking like you weren’t
doing anything at all, or have something
even worse pop on your screen. 

The quick fix for this is to open up
all the applications that you “should” be
using, and press [Alt] + [Print Screen]. Now,
go to Start > Run, type ‘mspaint’ and press
[Enter]. This opens up Microsoft Paint.
Press [Ctrl] + [V] to paste the captured
image, go to File > Save As and save it as,
say, ‘desktop.bmp’. Then, go to File > Set
As Background (Centered). Right-click the
Taskbar, select Properties, tick the ‘Auto-
hide the taskbar’ checkbox and click OK. 

Right-click on the Taskbar and go to
Toolbars > Desktop to bring up the Desktop
tab. Drag it to the extreme left, top, or right
of your screen. Right-click on this new
Desktop Taskbar and select Auto-Hide.
Finally, right-click on the desktop and go to
Arrange Icons By > Show Desktop Icons
(uncheck it). Now, if your boss is a bit of a
Nosy Parker, press [Windows] + [M], and it
looks like you’re hard at work. 

Honour Thy Messenger
Most bosses are pretty lenient

about Web surfing, but chatting is a

strict no-no. For times when
the messenger is banned, use
Messenger Plus from
www.msgplus.net—a pretty
impressive tool for MSN
Messenger. It has some really
cool MSN add-ons, including
Boss Protection. 

Download and install
Messenger Plus, and the next
time the Boss is looking, all
you need to do is press [Ctrl] +
[Spacebar]. This hides all open
chat windows, and also
changes the Messenger icon to
anything else that you want—

the default is pretty good though. To
change the Boss Protection settings,
open the main Messenger window, and
go to Plus > Preferences > Boss Protection.

Turn the other cheek
With a little help from a third-

party utility, you can safeguard yourself
from ever being caught. Anti-Boss Key
(www. mindgems.com) is by far the best

solution to the problem. Down-
load this utility, and install it. By
default, it hides everything you’ve
kept open—including what’s on
the taskbar. All you have to do is
press [Ctrl] + [`] (the default
setting), to hide all incriminating
Windows—including the Anti-
Boss Key window, of course.

But that’s not all. You can also

set applications for it to ignore and leave
visible, and also customise which applica-
tion it brings to the foreground when you
press your secret key combination. It can
even launch that application for you, in
case you didn’t have a work related appli-
cation running when your boss walked in. 

We suggest you change the default key
combination. The default combination to
hide and show the application itself is [Ctrl]
+ [\]—which you also need to change. Go
to Extra Settings > Keyboard to change the
default key combinations. The only sore
point here is that the software is a 20-day
trial version, and costs about $30 (Rs 1,350)
to buy—worth it to protect your privacy. 

Do not curse thy
system administrator

The biggest problem we face is trying to
surf the Internet. Most of us connect to
the Internet via the company’s proxy
server, which means every little thing we
do online is logged and can be traced
back to the user. You have to fight proxy
with proxy, and use any of the thou-
sands of blessed souls out there offering
free anonymous proxy servers.

All you have to do is visit a public
proxy site, and then use these sites to
browse anything you want. All your
systems administrator will see is data
going to, and coming from, this sole
proxy Web site.

Of course, system administrators aren’t
dumb enough to be unaware of these sites,
so don’t use a single proxy for long.

8

7

6

A Desktop snapshot can prevent a lot of bloodshed

Here you are relaxing by playing a quick
game of BookWorm and your boss
rounds the corner...thanks to Anti-Boss
Key, all he sees is a Word document

Once you’ve configured Anti-Boss Key, getting
caught would almost be a crime

May Messenger Plus always protect you from
your grumpy boss
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However, there’s one Web site that no
one in their right mind would block—
Google. The easiest way to surf anony-
mously is to use Google’s cache operator.
For example, to view www.thinkdigit.com/
forum, all you’d need to do is go to
www.google.com and enter ‘cache:www.think
digit.com/forum’ in the search box.

Go forth and multiply
Who said you have to have just one

desktop? Yes, Linux users have an unfair
advantage, as they already have multiple
desktops inbuilt with whatever distribution
they use, but Windows users, too,  can opt
for this. You can use Cool Desk, available at
http://www.shelltoys.com/virtual_desktop.
Install the software, and you’re all set. You
can create nine virtual desktops, but
beware; this uses a lot of system resources. 

All you need is two desktops: one for
all non-work related applications, and the
other for stuff that your boss expects to
see you working with. Switch to the one
with all the work-related applications at
the slightest sign of boss trouble.

SSH! He can hear
everything

For those who run Linux, are lucky
enough to have an always-on broadband
connection at home, and unlucky
enough to work in an office where just
about every port is blocked, you can
make a monkey out of everyone. 

All you need to do is run SSHd
(Secure Shell daemon) on your Linux
box at home, set it to accept incoming
connections from a port that your
office allows (port 80 for example), and
leave your home PC running when
you’re at work. 

Now you can use an SSH client such
as PuTTY to access the Internet, and do
just about anything you want. You can
even use PuTTY’s X11 forwarding to use
the GUI, and its tunnelling capabilities
to forward ports (See box ‘Tunnel Your
Way Out’ above).

Remember, you can also use this
even if you have just a shell account on
a Linux box anywhere in the world, with
unrestricted Internet access.

Tunnelling is the process of
encapsulating data of one protocol
within the data of another, to set up a
secure connection.

Strictly speaking, tunnelling is
frowned upon. So if your office is
particularly strict about their Internet
access policies, don’t do it. For those
who work in offices that couldn’t care
less, and just block ports because every
other company does, this can really help. 

If you have a Linux machine at home
running SSHd, or an account on just
about any computer around the world
that runs SSHd, you can gain almost
unrestricted access to the Internet.

Start Putty, enter your home computer’s
IP address, or the address of the computer
you have an account on, check the SSH
option and then key in the correct port.
Now, in the left-hand pane, go to
Connection > SSH > Tunnels. If your
connection is fast, and the remote computer
allows it, you can enable X11 forwarding,
otherwise just tunnel so that your
applications get access to the ports they use. 

The only things you need to know is
which applications use which ports, and
which servers. For example, to connect to
an IRC server (irc.someserver.com, for
example) on port 6667, set the source

port to ‘6667’, and the destination to
irc.someserver.com:6667. This creates a
tunnel as soon as you log in to your home
Linux box. Therefore, all you need to do to
connect is type ‘/server 127.0.0.1:6667’ in
an IRC client. Your IRC client’s connection
is routed to the remote computer, over
your SSH port, to the server you want to
connect to. You can do this for all
applications that use a specific port, server
and the TCP/IP protocol.

Tunnel Your Way Out
Not all bosses are born that way! Most
were human once, and even employed
some of the tactics mentioned in this
article to pull the wool over their
superiors’ eyes. Here’s what the
experts had to say:

Cell phones make certain noises
called ‘ring tones’. These are handy when
you’re in a meeting, and can’t suppress a
yawn. Just get your cell phone to ring,
make it sound like the company’s fate
depends on this call, excuse yourself, and
take five minutes to compose yourself
before returning to the ordeal.

Prashant Narekuli,
Brand Manager, Digit

I use two seperate branches of my
work to make excuses for each other. So
when management calls me for a
meeting, I tell them I'm busy with editorial
work, and vice-versa. I also use "editor-
powers" to worm out of meetings.

Sumod Hajela,
Assistant Editor

I always keep three windows open—
the New York Times Technology Web site,
the CNN tech page and the Google news
page. This way, my boss thinks I am
researching all the time. What he doesn’t
know that there is a word game always
on in the background.

Sachin Kalbag, 
Features Editor

We use Quake III to test graphic
cards, PCs, motherboards, CPUs and
laptops! We Quake, and if anyone asks,
we claim to be testing Intel’s latest
CPU—when actually the CPU is some old
P3! This is so clichéd now, people think
we’re goofing off even when we’re
actually testing!

Deepak Dhingra,
Assistant Manager, Test Centre

If you stand around chatting with your
colleagues, it's wise to blurt out a few
official sounding words now and then—
even if it's out of context. So we stand
around chatting all day, and slip in words
such as 'layout', 'pagination', 'illustration',
'photo-shoot', etc., just in case a senior is
within earshot.

G S Virdi
Editor, Smart Computing

If You Can’t Beat ’Em, Join ’Em
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You can use PuTTY’s port forwarding style
tunneling to get access to all that you’ve been
denied, thus far

➜
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Thou shalt lie
The ultimate work-shirk is not even

coming in to office. Why waste all that time
travelling, when you can stay at home? The
problem is that bosses never believe your
lame excuses, since they are well-versed
with every excuse in the book. What you
need to do is convince them over the
phone that you’re telling the truth.

If you want to call in sick, the fake
cough that you emit at a strategic pre-
planned point in your conversation with
the boss, just never seems to come out right.
So, the next time you get a sore throat,
record your coughing spasms on your PC as
a WAV file. Now, when you call in sick, play
the file and sound like you’re dying.

Of course, this means that you’re

only limited by your imagination. Just
make sure you label your WAV files
correctly. You don’t want a background
of the sounds of the Amazon jungles or
a Delhi traffic jam starting to play when
you’re pretending to be sick.

Don’t do that, or
you’ll go blind

One really neat trick you can try is to
loosen all the peripherals and card in
your cabinet. When no one’s looking,
shut down your PC, open up the cabinet,
and remove all the screws for the periph-
erals. Get rid of the evidence: clean up the
screws lying about. Now, loosen the cards
a bit, and start your computer, as a test to
make sure it still works. If the computer
boots properly, carefully close the cabinet
and get back to work.

Now, give your cabinet a little 
kick just when you’re showing a 
colleague something work related. He or
she will be your witness. Chances are
that your loosened cards will fall out,
and cause your OS to hang. Even your
display might show some really weird
colours, or switch off altogether. Now,

you can spend an hour (or even two)
“fixing” your computer!

Just bite that apple
Whenever possible, try and grab all

the fun work—as the saying goes, “Find a
job you like, and you’ll never work a day
of your life!” Try and get a job as a reviewer
for SKOAR!, the gaming magazine, or
convince your editor to let you write an
article called ‘Be a Smart@ss @ Work’. You
can hold meetings, have brainstorming
sessions, go around asking your bosses all
sorts of uncomfortable questions, and
even goof off a bit and say it’s “research!”

If you aren’t afraid to share your
shirking secrets, write to us at
shirkers@thinkdigit.com, and give us a few
tips. In the end, remember that your
boss was probably doing the same things
once, and may be wise to your tactics. 

And remember, your boss may be
sitting in his or her cabin reading this arti-
cle, right now! However, since sloth has
always been the greatest inspiration for
creativity, we’re sure you’ll keep inventing.

Happy goofing off!
ROBERT SOVEREIGN-SMITH

robert_smith@thinkdigit.com
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Recording background noises to back you up
on your excuses may help you keep your job



166 JUNE 2004

Mahesh Benkar

insight ■
■ linux works

It’s sad, but
true—you
could well be
struck by
lightning, a
freak explosion,
or a Linux
disaster. While
we can’t help
you with the
first two, here’s
how to tackle
the last

Reliability is a comforting thought;
switching to Linux just reinforces
this. Your Linux box packs in a
fantastic desktop, more utilities

than you can use, and the satisfaction of
running a perfectly stable system. Almost. 

You wouldn’t be reading this if you
hadn’t faced the odd Linux problem, and
while the chances of you seeing your
Linux box fizzle into smoke are remote,
like any good scout or guide, always 
be prepared.

Don’t wait around to let disaster jump
up on you. Never forget to:
■ Regularly back up all your data. There is
no substitute for a good backup.
■ Make boot diskettes for your Linux, as
well as your Windows system if you’re
dual-booting. It’s better to be prepared for
both the devil and the deep blue sea.
■ Test your backup and boot diskettes reg-
ularly. You don’t want to be left with
coasters in your moment of despair.
■ Keep your Red Hat CDs readily accessible.
After all, they’re CDs, not servants at your
beck and call!
■ You can make a bootable Knoppix 3.1
CD from the ISO on the Digit Linux Spe-
cial DVD distributed in August 2003
(www.knoppix.org is the official Web site,
and the current downloadable version 
is 3.4)
■ Make backups of driver CDs and any
new drivers you’ve downloaded.

Rescue 
me
Rescue 
me
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If you have your boot diskette, you should be able to boot into
Linux, and reinstall the boot loader. If not, no problem—Linux
is quite forgiving, and with just a little effort, you can get back
to GRUB-ing or LILO-ing your boots.

For GRUB users, boot into Linux using the first Red Hat 9
install CD, and once on the prompt, chroot to the /mnt/sysim-
age directory. Now that you’re in, run this command to get
GRUB working:

grub-install /dev/hda
This example assumes that you’re loading GRUB in /dev/hda,

the MBR of the first IDE hard drive. To install GRUB in the boot
sector of the Linux partition ( located on, say, /dev/hda5), use:

grub-install /dev/hda5
If all goes well, you should see no error messages popping up,

and a message that looks
like "Installation finished.

No error reported..."
(and so on, for a

couple of lines.)
LILO users

have it even eas-
ier. All you
need to do is
run ‘lilo’ from
the command

line after booting
into Linux using
the install CD,
and chroot-ing
into the correct
directory. Of
course, in both
cases, you would
need to have
copies of the con-
fig files (the
grub.conf and
the lilo.conf files
r e s p e c t i v e l y,
located within /etc) in the right places, and the associated files
in the /boot partition.

You may also be unable to boot into Linux because of a
kernel panic, which occurs when the kernel cannot be boot-
ed into. This could happen because of the installation of a
newly , (and badly), compiled kernel. Another problem may
be a system service that refuses to load, hence preventing a
boot. In such a case, boot into single user mode from the boot
loader, and start the ntsysv utility; locate the service and dis-
able it from the bootup list. Other problems could include
hard drive corruption errors.

Let’s look at recovering the root password from the boot loader.
If you’re using GRUB, then, as GRUB loads up, highlight the
Red Hat Linux entry on the GRUB menu, and then press [E] to
edit the boot configuration. Locate the following line, some-
thing that looks like this:

kernel /boot/vmlinuz-2.4.20-0.70 root=LABEL=/ hdc=ide-scsi 
Type the number ‘1’ at the end. Doing so boots the PC into

run level 1-single user mode, where you’re automatically
logged in as root. This done, type ‘passwd’ at the prompt. You
can enter a new password here.

If you use LILO, try this. At the LILO boot prompt, type
‘linux single’ to get to single user mode. Of course, you may have
entered a boot password, and forgotten that as well, which
effectively prevents you from adding in any arguments to the
boot loader whilst booting. 

For wretched times like that, get hold of the Red Hat 9 install

CDs. Next, boot
using the first CD—
the bootable CD—
and type ‘linux
rescue’ at the boot
prompt. The res-
cue program will
run through a
couple of the ini-
tial install steps,
such as setting up the
mouse, keyboard and network
interfaces. 

You don’t need to set up the network interface: run straight
through the program to the point where you can choose to
mount the hard drive with read-write permissions. Click on Con-
tinue, and get into the command prompt. Type ‘chroot /mnt/sysim-
age’. You now get into the root environment (/) with the right
permissions. Now, reset the password by typing ‘passwd’, then
type ‘exit’ to get out of the chroot-ed environment, and ‘exit’
again to reboot. That’s it, password recovered. 

Remember that since it’s so easy to recover a boot password,
you need to physically secure your machine if you don’t want
someone else using your computer as root.Edit the GRUB entry to boot into single-user mode

“I, uh, forgot the root password”

Boot into Linux using the Red Hat CDs, the
rescue-image way

“I can’t boot into Linux”
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For Windows XP users, GRUB is godsend. Unlike LILO, it allows for seamless
dual-boots with Windows XP, and a wide variety of Linux and Unix OSes, with-
out any additional tweaking. However, it’s quite possible that you managed to
destroy the MBR sufficiently enough—be it a virus or just another boot loader—
that you can’t boot into Windows. Before pressing the panic button, try rein-
stalling your boot loader. 

It’s quite possible that with your GRUB device mapping intact you may be
able to boot into Windows XP. If you are really out of luck, you need to resort
to loading in the Windows XP boot loader, NTLDR. Here’s how: Insert the Win-
dows XP bootable CD, and during setup, press [R] to initiate the recovery con-
sole. Locate the correct Windows installation that you want to recover—this

applies only if
you have multi-
ple Windows
installations—
and supply the
admin pass-
word. Next, run
the ‘fixmbr’
command, and
you should
have the
NTLDR sitting
in the MBR.

Windows 98
users can get
away with a

neat and simple solution—boot using the Windows 98 CD or a Windows 98
bootable diskette, and run ‘fdisk  /mbr’ at the command prompt. This will over-
write the current MBR (GRUB or LILO) and allow for fast booting into Windows
98. 

So what happens to
Linux? For information on
how to continue dual
booting into Linux
using the NTLDR, refer
the February 2004 issue
of Digit. With Windows
98, you may consider
reinstalling GRUB on
the MBR itself. In any
case, remember that
Linux needs a boot
loader regardless of
whether or not you’re
dual-booting. So you
could choose to install a
third-party booting util-
ity such as XOSL in the
MBR, and install GRUB (or LILO)
in the boot sector of the Linux partition.

XOSL (www.xosl.org) is a free tool with a slick GUI and is highly recommend-
ed for dual-boots. Downloads may be problematic as the Web site appears to be
down for a while now, so get a copy from an enlightened friend.

It’s fairly simple to cleanly remove
Linux from your hard disk, and go
back to single-boot Windows. This is
a two step process: You first need to
overwrite the partitions that Linux
occupies on your hard drive, and
then follow up by cleaning the MBR,
if that’s occupied by Linux. 

First, determine your current
boot loader. If it’s NTLDR—and
you’re dual-booting using
GRUB/LILO on the boot sector of the
Linux partition—you don’t have to
bother with clearing MBR. If the
boot loader is LILO, boot into Linux
and run the ‘lilo -u’ command to
uninstall LILO. 

To recover hard drive space from
Linux, use the GNU fdisk tool, from
the command line: fdisk /dev/hda.

(This is if you want to run fdisk
on the /dev/hda hard drive.)

Next, choose the Linux
partitions, both the file system
one(s) and the swap partition, and
delete them. For convenience, you
can also choose to convert them
into VFAT, or FAT32.

If you’re running GRUB, or forgot
to uninstall LILO, here’s the way out.
For Windows 98 users, once you 
have finished with the fdisk
operation, use the Windows 98
bootable CD, or boot diskette to
boot into Windows 98 and run ‘fdisk
/mbr’, as explained earlier. 

That’s about it. Windows XP
users will have to boot into Windows
XP using the Windows XP boot CD.
Press [R] during setup to activate 
the recovery console, and run the
‘fixmbr’ command.

If you have the money to spare,
we’d recommend that you invest in
PowerQuest’s Partition Magic 8. It’s
one of the best commercial tools for
managing disk file systems, and do
conversions between a variety of
operating systems including Linux
and FreeBSD, and all versions of
Windows. Partition Magic’s Boot
Magic tool also manages multiple
boots.

“No more tux,
please”

Next up, clicking ‘R’ takes you to the Recovery Console

“I can’t boot into Windows!”

➜



insight ■
■ linux works

JUNE 2004

There’s a simple solution if you accidentally deleted everything
on your system as root: Reinstall everything. Format and rein-
stall, but if you happened to wreak havoc over only one parti-
tion, try this: if you tried ‘rm- rf *’ in the /usr directory, there is
hope for you. Boot using the Red Hat 9 CDs, and choose the
standard install option by pressing [Enter] at the prompt. Then
choose to upgrade. Don’t do a fresh install. 

Over the next few screens, you’ll be asked to enter some
options about the upgrade software packages. Don’t take a
chance—install everything that you think you have lost. Once

done, the reinstall starts. The advantage of doing this versus a
clean install is that your personal files are safe, as long as you
don’t choose to format. 

On the other hand, keep in mind that if you happen to be
the unlucky administrator of a machine hexed with root-kits,
doing this may not be advisable. Instead, back up the data selec-
tively after inspecting it, then clean format and reinstall Linux.
You just cannot take a chance with tainted binaries and pro-
grams, and it is worth the effort to clean format from scratch
and secure your machine, to ensure that the episode is not
repeated. 

The default Red Hat 9 file system is Ext3, a journaling file sys-
tem that allows for quick recovery from hard drive crashes. This
means that the entire sequence of hard drive operations is jour-
nalled (or recorded), which lets the file system recover from
crashes much faster. For instance, a forced file system check
does not always take place with the Ext3 file system in place.
However, despite this, its possible that errors and inconsisten-
cies with the data on the hard drive may force an integrity
check. Generally, this takes place automatically. 

As the system boots up after a crash, you are prompted to

start an integrity check, which you should perform. To do so
manually, you can use the ‘fsck’ com-
mand. Keep in mind that fsck should

not be performed on a mounted parti-
tion, as this may corrupt the contents and

cause serious errors. Refer to
the man page on fsck  for more
detailed usage instructions.

To copy essen-
tial data from a
Linux installation

that you may
not be able to

boot into or use,
there’s a workable solu-
tion from Knoppix, the live boot CD distro. Of course, the data
has to be readable. Also keep in mind that data recovery in case
of a badly corrupted hard drive should be done by an expert.

For quick data recovery from a hard drive that’s not badly
damaged, boot into the Knoppix Linux distro. The nice thing
about Knoppix is that it scans and configures your 
computer hardware on the fly, and automatically mounts
FAT32 file systems. Once you boot into Knoppix, you should
be able to read the contents of the hard drive and recover
data onto another partition.

SRINIVASAN RAMAKRISHNAN

srinivasan_ramakrishnan@thinkdigit.com

“Oops. I believe I just deleted my…”

Boot into Knoppix and recover your data

Upgrading your Linux installation should get your box working

“Crash! Bang! Whiz! Fizzle. Ouch! Now what?”
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The first seven steps
Some time after installing Windows

XP, there was a problem and some files
went missing. I was asked to load the
missing files from the original CD. While
doing so, somehow, I loaded the entire OS
again. Thus, there were two operating sys-
tems on my C drive. 

Now, when I scanned my drive for
viruses, a series of events took place, and I
got a message that said I couldn’t have
the same OS, on the same drive, twice. I
had to re-format the C drive. 

Even after this, I was unable to load
the OS. So I choose the D drive to install
it. I did not get a boot disk with the OS
CD. Can you to tell me how to partition
my hard disk, and format it with the NTFS
file system, step by step.
Dr K P M Prabhu

Follow these guidelines for the first
seven steps after booting from the
Windows XP CD: 

First, press [Enter] for a new installa-
tion. Next, press [F8] for agreement
acceptance. You can choose [R] for
repair, and [ESC] for a new installation;
select New.

If you already have partitions on your
disk and want to re-create those, delete
each by selecting and pressing [D]. Press
[L] to re-confirm your selection.

Start creating a partition by pressing

[C]. Enter the size of the partition. For
example, a 20 GB drive can have a 8 GB
and a 12 GB partition. You can permute
and combine as you wish. However, as a
general rule, leasing too much space for
the C drive is not advisable; the C drive
should only be used for the operating
system and program files.

Once the partitions are created, select
C: and press [Enter].

Here, you can select between FAT and
NTFS. Whichever you select, make sure
you don’t select the ‘Quick’ option.
Hereafter, the installation should be sim-
ple to complete.

TV tuner settings
I have a Pentium 4 2.4 GHz, an Asus

P4B533-VM motherboard and 128
MB of DDR RAM, running
Windows 98 SE; I have Goldwave
installed. I recently installed a
Mercury TV-tuner card. When I ran
the program, there was sound, but
it disappeared when I recorded a
sample video! 

When I changed the source in
Goldwave to Line-In, the recording
had sound. Also, I found that
changing the Line-In volume in
Goldwave had the same effect on
the recorded video, whereas the
Line-In volume in the volume panel
had no effect. I uninstalled

Goldwave, but found that the recorded
volume was the same as before. Changing
the Line-In volume in the volume panel
did not have any effect on the recording.
Please help.
Deepmoni

For Live TV, as well as recording,
your input source should be configured
to Line-In. Also, check that the Audio
Out settings have your sound card
as default.

Now, to control the recording vol-
ume, start Volume Control from
Accessories. Go to the Options menu,
then to Properties, select ‘Recording’
and press [Enter]. Now, move the vol-
ume bar for the Line-In to change the

NTFS and FAT blues, hyperthreading hype, vanishing displays—it’s all in the game.
Everything has an answer—seek, and ye shall find!

➜

Click on recording,
then OK, and
then modify the
recording volume
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recording volume level. Check your
recording and adjust this accordingly.

Pages that do not open
I have an Athlon XP 2.4 GHz PC con-

nected to a LAN, running Windows 98 SE
and Internet Explorer 6 with SP1. The
problem is that when I visit any of the
Web sites such as Indiatimes, Yahoo! India,
Rediff, MSN India, or others that contain
ActiveX control (.ocx) files, I get a security
alert message saying, “Your Current

Security Settings Prohibit Running ActiveX
Controls on this page, so the page may
not display correctly.” What do I do?
Abhijit Mukherjee

To get over the problem, open up
Internet Options in the Control Panel,
and change the settings bar in the
Privacy tab to Medium. If you wish to
customise the settings, you can do so in
the Security tab by clicking ‘custom
level’ and defining your own settings.

Vanishing act
I have a 40 GB hard disk, split into

three partitions. One of the partitions is
13 GB. 

Last week, I reinstalled Windows XP
on my system. After installation I seem to
have lost the 13 GB drive—only two drives
appear. What do I do?
Girish Cariappa 

Right-click on My Computer and
click Manage. Now, click on Disk
Management, and then verify that the
13 GB partition is formatted—that is, it
should show the status as ‘healthy’. If
not, then right-click on the partition
and select format. Now, you should be
able to see the partition.

Spyware in file system
How can I convert an NTFS partition

into a FAT32 partition?
Every time I shut down my PC, I get

an error message saying, “Ending
Program - wupdater.exe.” What is the use
of this exe file? How can I get rid of this
message permanently?

When I open Internet Explorer, every
time a Web site with the address
http://searchcentral.cc is opened. I tried the
‘Use Blank’ option in Internet Options, but
it isn’t working.
Sumit Goel

Use Partition magic (www.pow-
erquest.com) to convert NTFS to FAT32. 

As far as wupdater.exe is concerned,
it is spyware. Go to Start > Run, type
‘msconfig’ and press [Enter] and de-select
the file. It shouldn’t auto-start the next
time Windows boots up. Delete the file if
you want to, but that might crash the
software that installed it. 

Finally, the IE problem is also due to
the spyware in your system. There are
spyware removal tools such as Spybot
(included in this month’s 101 Freeware
CD), which reduce the trouble involved
in manually searching and removing
each one of them.

Is /boot necessary?
Can I install Linux without creating

partitions for /boot and swap? If so, where
will the boot loader install?
S. Mohammed Riyazudeen

No, you can’t install Linux without a
swap partition, but you can skip the cre-
ation of a separate /boot partition. In this
case, the boot files will be stored in the
/root partition.

Windows is not ready to
install

I have a Celeron 1.2 GHz, an Intel i810
motherboard and a 40 GB Seagate hard
disk. Earlier, my PC was running Windows
98; while installing ELX Linux, I corrupted
my FAT partition. So I removed all the par-
titions and re-created them, but now even

A virus despite anti-virus
I have a PC with Windows XP. I

recently bought an Internet connection
pack, but before installing the pack, I
installed McAfee Virus Scan Professional
Edition. Now, whenever I connect to the
Internet, I get the message that
says,”This system is shutting down.
Please save all work in progress and log
off. Any unsaved changes will be lost.
This shutdown was initiated by NT
AUTHORITY\SYSTEM. Time before shut-
down: 1 minute. Message:
Windows must now
restart because the
Remote Procedure
Call(RPC) service termi-
nated unexpectedly”. I
have tried to detect a virus,
but to no avail. What might
be the problem?

V Madhav Rao

You are infected with the blaster
worm. Download the fix from
http://securityresponse.symantec.com/avcen
ter/venc/data/w32.blaster.worm.removal.to
ol.html. You need to frequently update
your virus definitions. Also keep
Windows updated with the security
patches that are released by Microsoft
from time to time. If you do so, you’re
less likely to get caught up in the Web
of viruses and worms.

Illustrations:
Mahesh Benkar

Moving the bar up and down controls the
security

The Disk Management window shows you the
disk status



174

insight ■
■ troubleshooting

JUNE 2004

after many attempts I am unable to install
Windows 98.

After a couple of reboots, it starts exe-
cuting scanreg and then hangs. When I
boot the system with a bootable floppy,
scandisk gives an error saying, “Some of
Windows files have been allocated to
invalid partitions/locations,” and a
prompt such as ‘Fix it’ or ‘Don’t Fix It’.
Even after I choose ‘Fix It’, the problem
isn’t resolved. What do I do?
Amit Gupta

There are only two possibilities—
either the RAM or the hard disk is faulty.
As a first step, get a working RAM mod-
ule from a friend’s PC and try the instal-
lation. If it works, just get new RAM. If it
doesn’t, then get the hard disk checked
thoroughly at a service centre.

Can’t find root
I am totally new to Linux. Whenever I

try to install PCQ Linux 2004, I get an
error saying the root partition is not
defined. What is a root partition? I have an
80 GB Samsung hard disk with four FAT32
partitions: The C: drive is 10.7 GB, and has
Windows XP installed. The D: drive is 11
GB, E: is 28 GB and F: is 26 GB.

I want to install PCQ Linux 2004 on
the D: drive with the dual-boot option. 
Ashish Jha

While installing Linux, you need to
create the ‘ext3’ and swap partitions.
At this point of time, specify the
mount point for the ext3 partition as
‘/’, without the quotes. You won’t get
the error message.

Hangs at power on
My PC just doesn’t boot. What I mean

is that the PC starts normally, I can hear
a single beep, then the PC shows the sys-
tem configuration, then, ‘updating
ESCD’, and that’s it—nothing on the
screen after that. A cursor blinks but the
OS doesn’t start. I had Windows 98 on
my machine.
Afiya

If you are well versed in PC hard-
ware, open the cabinet and tighten the
connections: the hard disk and CD-
ROM connectors, etc. Press the RAM
module gently. Also, verify the boot
sequence in the BIOS; the first in the list
should be the hard disk. Finally, use a
boot floppy and check the partition
table using ‘fdisk’ for irregularities; a
bad partition table can cause such prob-

lems. If ‘fdisk’ does not give an error,
call an engineer. 

Is CD NTFS or FAT?
I downloaded data from the Internet

on a machine running Windows
2000/NTFS, and burned it on a CD. My
home PC runs Windows 98/FAT, so natu-
rally it’s unable to see the CD files, and
hangs. Is there any software available to
view or extract the files from the CD and
convert them to FAT?
Some Niyogi

CDs have a file system of their
own—CDFS. It does not matter if the
host file system is NTFS or FAT. If the
CD was created successfully without
any errors, it should be read in
Windows 98 too. A weak lens might be
the culprit, but to verify this, just read-
ing the CD in another drive using
Windows 98. If the CD works, then the
drive is faulty.

What is HyperThreading?
I would like to know what

HyperThreading is. I have heard a lot
about this new product from Intel. I
have an assembled PC that comprises an
Intel D845GEBV2 motherboard (which
has an external AGP slot and Extreme
Graphics onboard as well), an Intel
1.7 GHz, 512 MB RAM and a 80 GB
Seagate Barracuda hard disk. 

I would like to exchange my current
motherboard for Intel’s new Hyper-

Where is my display?
I have a Pentium 4 system with dual-

boot, i.e., Windows 98 SE and Windows
XP. In Windows 98, I right-clicked on the
desktop and changed the resolution.
Now my computer does not show up the
display in Windows, and instead shows
up the message ‘Out of frequen-
cy’. What’s the problem?

Where I can find details
about files such as boot.ini,
io.sys, config.sys and autoex-
ec.bat?

Bikrant Rana

To set the display
right, boot into
Windows 98’s Safe
Mode, by pressing [F8]
while Windows is just
about to start. In safe

mode, change the resolution to a
lower one such as 640 x 480, and
then restart the computer. As far as
information about Windows files is
concerned, visit www.support.microsoft.
com, and search for the specific file
details you need.

Make sure all connections and
modules are tightly fitted



Threaded one. Do you recommend  the
exchange, or should I make do with my
present configuration? I intend switching
to a HyperThreaded motherboard since it’s
relatively faster, and supports multitasking. 

Can you recommend motherboards
that are better than the one I have in
mind. If so, please suggest some that
have an external AGP slot, as I have a
graphics card. Also, please let me know
the cost involved.
Siddharth

Intel’s HyperThreading technology
pertains to processors and not to
motherboards.

Intel’s latest CPUs have this feature,
and nearly all new motherboards for

the Pentium 4 platform support it. 
As far as performance goes, there will

be a marginal gain, and that, only with
applications optimised for
HyperThreading. Unfortunately, as of
today, there are very few such applica-
tions. Another good point to note is
that, some applications actually see a
performance drop when used with
HyperThreaded processors.  

However, you have a pretty decent
machine and there is absolutely no reason
to shift to a newer configuration as of now.

Back up Outlook Express files
I have Window 98 SE and Outlook

Express 6. I need to know how to save, or
copy my e-mails from Outlook to a CD.

Neeraj Mishra

To back up files,
first start Outlook
Express, then go to
Tools > Options, and
click on Mainten-
ance. Next, click on
Store Folder, copy
the path, and paste it
into Windows
Explorer. Finally,

copy all files to the backup location.
Restoring is simple: copy the files

back to the original folder.

Monitor starts! 
We switch off the monitor when lis-

tening to music or running anti-virus soft-
ware. However, to our surprise, the system
automatically shuts down when we switch
it back on. How do we solve this problem?
Arnab and Smita

Get your power supply checked at a
good service centre, as it’s faulty. It’s
unable to take the load when you start
the monitor, thus triggering off a
restart. You may even need to replace
the SMPS with another with a higher
power rating.
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sos@jasubhai.com
E-mail us your
computing prob-
lems, and we
may answer
them here! Since
we get more

mails per day than we can handle, it
may take some time for your query 
to be answered. Rest assured, we are
listening!

Msvcrt.dll revisited
I am unable to set up some soft-

ware on my computer. The error mes-
sage I get is, “The MSVCRT.DLL file is
linked to missing export NTDLL.DLL
rtGetNtVersionNumbers.”
Sudhanshu Bhasin

The problem is simple, the soft-
ware you've installed isn't meant for
Windows 98. Certain software were
designed for Windows 2000 and later,
and won't run on windows 98.

However, it's also possible that the
program you're trying to install now
isn't the culprit. If you tried to install
software earlier that was meant for
the NT platform, it could have cor-
rupted your MSVCRT.DLL file, or
installed the wrong version.

To fix this, you need to extract the
MSVCRT.DLL file from the CD, and
overwrite the one in the
‘\Windows\System\’ folder. This should
solve the problem.

Unwanted visitors
I have a Windows 98 SE machine. I

use Internet Explorer 6. One day after
browsing a few Web sites, my home-
page became ‘www.4-counter.com’. I
replaced it with ‘about:blank’, and also
reset all Web settings to their defaults.
But after rebooting, the default home-
page again became www.4-counter.com.
What is the problem? How can I reset
my homepage to a blank page?
Raj

To solve the problem, you’ll need
to modify the registry. This is a risky
affair, so be careful. Open the Registry
Editor by executing ‘regedit’ at the
Run prompt. Now search and delete
each key that has a value of
‘http://www.4-counter.com’.

Alternatively, you can search and
remove spyware applications using
spyware removal tools such as Spybot
(included in this month’s 101
Freeware CD).

Summer heat
I have a system with an AMD

Athlon 1800 MHz, an ASUS mother-
board, and 256 MB of DDR RAM. The
problem is that the CPU fan overheats.
How can I rectify this?
S Palani

Only use the original fan and
heatsink that was provided with the
CPU. If need be, you can purchase
better cooling solutions from third-
party vendors.

As a precautionary measure, veri-
fy that excessive amounts of dirt
haven’t accumulated on the fan
blades. You may need to clean the fan
carefully with a paint brush. If you
have to remove the fan to clean it, be
careful and snap it out carefully. 

Use thermal paste to increase heat
dissipation—remember, too thick a layer
of thermal paste can act as an insulator
and make matters worse. Sometimes,
keeping the cabinet open may help.

FAQs

Open the store location in explorer and copy the files
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Adobe Acrobat Reader
Full 6.0
Adobe Acrobat Reader comes
in two flavours—the Basic and
the Full version. The difference
is that the Full version has
comprehensive help, support
for accessibility features, and
most importantly, the provi-
sion to search within Adobe
Catalog Index files. The Index
files provide access to a full-text
search system. This makes it
simpler and faster to search for
text within multiple PDF files,
through a single interface. 

The search interface sup-
ports search using simple, 
compound or Boolean argu-
ments. Advanced search capa-
bilities, such as stemming and
proximity, help you refine the
search results.

To search via an index,
drag and drop the index file,
with the PDX extension, into
the application. The search
bar opens on the right hand
side. By default, the search
application will be in Basic
mode, but by using the link at
the bottom of the page, you

can enable Advanced
mode. Remember, you
need to use the Full version
of Adobe Acrobat Reader
6.0 to avail these options.

The results obtained can
be sorted in various ways.
Relevance sorting keeps the
most probable results on
the top. ‘Sort by filename’
is self-explanatory. The
Digit Archive filenames in
the second free CD with
this issue, have been cho-
sen such that, on being
sorted, they appear in

chronological order.

dBpower AMP Music
Converter
To start using dBpower AMP,
all you need are the plugins
for the formats into which
you need to encode your
audio files. Once you have
them installed, you can start
right away. 

Within Explorer, locate the
file you want encoded, right-
click on it, and choose ‘Con-
vert To’. You should see the
listed options for the audio
formats supported. Select the
format of your choice and
click on it. This opens the
Options menu where you can
set parameters such as encod-
ing quality and type. When
you have entered the options,
click on Convert to start con-
verting the file.

Winamp 5.03
Global Hotkeys

Winamp 5.03 features global
hotkeys that allow you to con-
trol your player using the key-
board. The fun thing is that

the shortcuts work even if
Winamp is not in focus. Thus,
even if you’re working 
in Word, you can pause, 
play, stop, or increase or 
decrease volume with 
the following configurable
key combinations:

Welcome the Media
Library
Winamp boasts of a powerful
feature called the Media
Library. Open it by right-click-
ing on the main window and
selecting Library, or by press-
ing [Alt] + [L]. You can navigate
over the main sections, called
Views, from the left side pane.

To add your files, click on

ESSENTIALS MULTIMEDIA

Acrobat allows you to search
within an index for quick search

Action Shortcut

Play/Pause [Ctrl] + [Alt] + [Home]

Stop [Ctrl] + [Alt] + [End]

Next Track [Ctrl] + [Alt] + 

[Page Down]

Previous Track [Ctrl] + [Alt] + [Page Up]

Increase Volume [Ctrl] + [Alt] + [ ]

Decrease Volume [Ctrl] + [Alt] + [ ]

Left Seek [Ctrl] + [Alt] + [ ]

Right Seek: [Ctrl] + [Alt] + [ ]
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Library, and select the directo-
ries containing your media
files. Winamp immediately
separates the audio from the
video files, and puts each
under the correct View. 

If you flip across the
default Audio and Video
Views, you’ll notice there’s a
lot you can do in each View.
For example, under the Audio
View, you can view your col-
lection by artiste or by album.
There’s also a useful search
facility that lets you search 
for files within the library,
with the results displayed in
the Results pane. You can nar-
row down your search by
entering multiple keywords.
You may choose to either
enqueue the results to the cur-
rent playlist, or play it straight
off the library. 

If you right-click on the
track in the Results pane, you
can choose to play all tracks
by the same artiste, or play all
the tracks in the album, or add
the files to a playlist. Right-
clicking on the track in the
Results pane lets you access
and change file information,
and remove the file from the
library and the drive.

You can even create your
own custom views, such as
‘High Bitrate’ to automatically
filter only those audio 

files which have a 
bitrate of, or more 
than, 192 Kbps. 

The media library
can also keep track
of various playlists. It
also allows you to
keep track of media
folders—your music
sources. These can be
local or shared fold-

ers. They can be scanned
automatically for new media.
Tags are used to generate
searchable info in the library
for later reference.

The Playlist Editor
Winamp’s Playlist Editor has-
n’t really changed in this
makeover. It still remains the
easiest to work with. If
you’ve just loaded a huge
playlist, and want to search
for a specific track, a quick
search-and-select can be
done by pressing [F3]. 

This opens up the ‘Jump to
file’ window, where you can
enter the search criteria. 
The filtered song can 
be played immediately, or
enqueued to be played after
the current song.

Forget me not
If you want to list your
favourite tracks such that they

Eudora

Insert recipients quickly
If you send frequent e-mails
to certain addresses, then use
the ‘Recipient List’ in Eudora
for quick access to their e-
mail addresses. 

To add a user to this list,
go to Tools > Address Book.
Click on the desired user to

see all his/her details. In the
Recipient List checkbox,
select Yes. 

Once you have added
the desired users to the
Recipient List, sending e-
mail to them will be easier.
Just right-click in the To, Cc
or Bcc box, select ‘Insert
Recipient’ and click on the
desired user.

INTERNET

The Media Library is a manageable bird’s
eye-view of all your music collection

Winamp is full of features
waiting to be utilised

can be accessed in a jiffy, you
can bookmark them with
Winamp’s convenient book-
marking feature. To bookmark
tracks, right-click the selected
tracks in the Playlist Editor and
select ‘Bookmark Item(s)’. You
can also use the [Alt] + [I] com-
bination for this. To access the
bookmarks, right-click on
Winamp, go to Bookmarks
and pick up your track from
the list there.

Not just skin deep
The new Winamp boasts of
skin support which, apart
from looking really great,
has some new and impres-
sive features. To begin with,

the ‘repeat’ button is now a
three-way toggle. It toggles
between ‘No repeat’, ‘repeat
playlist’ and the new ‘Repeat
Track’, which will keep
repeating the current track.
Also on offer is the Notifica-
tion feature, which, if the
player is minimised will pop
up details of new actions,
such as a track change, a
playback pause etc.

Additionally, you can
make Winamp transparent,
and as unobtrusive as you
want. Also, for those with
changing moods, Winamp
can now wear multitudes of
colours. Change the colour
to suit your mood.
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You’ve got tweet!
You can change the sound
played when a new mail
arrives, by assigning a wav
file within Tools > Options >
GettingAttention. Click the
unnamed button, locate the
.wav file, and click Open.
Now, whenever you receive
an e-mail, your sound of
choice will be played.

A backup a day keeps
the doctor away
Backing up your Eudora e-
mails is as simple as copying
and pasting. Find the Eudora
folder—in Windows 98, it’s
located at C:\Windows\app
licationdata\qualcomm\eudo-
ra—and select all the files
with the .mbx, .pce, .txt and
.fol extensions. Copy the
selected files to a backup
storage device. The .mbx,
.pce and .fol files relate to e-
mails, while *.txt files con-
tain the address book.

Drafts, or stationery
Instead of typing the same
body text for oft-formatted
e-mails, such as standard
responses to information
requests, you can save gener-
al layouts of such e-mails.
These are saved as Stationery
in Eudora, and can be read-
ied to be sent with minor,
last minute changes. To cre-
ate new Stationery, go to
Tools > Stationery. A blank
window will open up. Right
click in this window and
select New. In the composi-
tion window, fill in as many 
fields as you wish, and save
the Stationery. 

Sending the e-mail is now
as simple as double-clicking

a Stationery item and mak-
ing a few changes, if any.

Mail list
Some people have more than
one e-mail address. You can
send an e-mail to all of these
by creating a mail list. To do
this, when you create a user
entry in the address book,
you see a box that says ‘This
nickname will expand to the
following addresses’. Enter as
many e-mail addresses as
you want, and your list is
ready.

Work faster
The fastest way to send e-
mail is to press [Ctrl] + [E] to
open the send e-mail box.

Filter on nick
Eudora provides a different
way to filter e-mails. Instead
of the regular filter, using the
e-mail address, Eudora
allows you to filter using
nicknames. This way, even if
the e-mail address of the per-
son changes, the mail will
still be considered recognis-
able. Of course, if both the
nick and e-mail ID change, it
would bypass the filter. 

To set up a filter, go to
Tools > Filter > New. Specify the
conditions, and the action to
be taken, and you’re done.

Vacation reply
With the help of Filters and
Stationery, configure Eudora
to reply to all e-mails that
arrive within a specified peri-
od. The filter acts a dummy
controller—you can draft a
personalised respnse, which
will be sent as a reply mail
during the vacation period.

Eudora add-ins
Eudora has add-ins to facili-
tate and automate many
frequent tasks. These are
easily downloadable from
the Internet. Here are some
of the more popular ones.

Mail alert
This add-in runs as a stand-
alone program, using Eudo-
ra’s e-mail settings, to poll
your e-mail server at regular
intervals. If it detects new
mail at the server, then it
pops up a window indicating
this. It also provides ways to
read, reply to and delete the
e-mails directly from the
server. The MailAlert add-in
can be downloaded from
http://www.diamondridge.com/s
oftware/mailalert/index.htm.

Address book to HTML
This add-in helps you export
Eudora’s address book to
HTML. This is handy, when
publishing your address
book on your Web site for
others to refer. It consists of
an executable program,
which needs to know 
the folder location of the
address book. 

In Windows 98, the
default folder is C:\Win-
dows\ApplicationData\qual-
comm\eudora. The add-in
needs ‘NNdbase.txt’, which
contains Eudora’s entire
address book. On clicking
the ‘Convert’ button an html
file is created in the same
folder, by the name NNd-
base.htm. The add-in itself
provides a way to view the
converted file. This add-in is
available at http://www.min
dspring.com/~aegreene/eudora/.

Mail to HTML
Similar to ‘address book to
HTML’ is ‘mail to HTML’.
Suppose you subscribe to a
mailing list, and get an inter-
esting e-mail which you
would like to share. You can
upload this to a Web site,
Intranet, or Internet based
with just a few mouse clicks. 

The add-in effectively
converts the entire mailbox
into HTML pages. It general-
ly finds the source folder,
and you need to specify 
the destination folder where
the HTML files will reside
after conversion. 

Apart from this, you can
even convert mails into text
files. The plugin is available
at http://users.erols.com/tgitlin/

Synchronise two PCs
Use this plugin to synchro-
nise the address books of two
PCs running Eudora. 

There’s an interface win-
dow where you have to
select NNdbase.txt—the
address file, from the first
computer, and then the
address file from the second
system. A destination file
that consists of a compiled
address book from both
machines is created. The plu-
gin is available at http://eudo-
ra.interweb.be/addins.html.

Opera 7.23
Down with the mouse!

Opera supports a whole lot
of keyboard shortcuts. We
list some of them here:

To go to a URL directly,
you can press [F2], and enter
the URL in the address bar
which pops up. If your
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address bar is enabled, you
can press [F2] to take the key-
board focus to the address bar.
Additionally, you can load a
document from your hard
drive by pressing [Ctrl] + [O]. 

Document images can be
easily toggled simply by
pressing [G]. This is a three-
way switch, and will cycle
between ‘Show all images’,
‘Show loaded images’, and
‘Do not show images’. If you
come across a Web page with
bad formatting, making it
unreadable, you can press
[Ctrl] + [G]. Of course, you can
always use the classic [F5] or
[Ctrl] + [F5] combination for a
page refresh.

Once you are done with a
window, you can hit [Ctrl] +
[F4] to close the active 
MDI window.

Zip zap zoom!
Opera boasts of true zoom
functionally, which allows
you to zoom not only text,
but even images and styles
proportionately. You can
exploit this feature using the
trusty old keyboard by repet-
itively pressing [0] and [9] for
a 10 per cent zoom out, or
zoom in respectively. [7] and
[8] can do.

If you’re lost, you can
always press [6] to revert to
100 per cent zoom.

Scroll that page
You don’t need a mouse to
use the scroll bar. You can hit
[Ctrl] + [F7] to toggle the scroll
bar on or off. The arrow keys
can be used to scroll up and
down. [Page Up] and [Page
Down] scroll page-wise. Like-
wise, [Home] scrolls the 

document to the top, and
[End] takes you to the end of
the document.

Additionally, you can use
[Q] and [A] to navigate to the
previous and next text link
on the page respectively.
Once on a link, press the
Space Bar or [Enter] to open
the link in a new window.
Handy, eh?

If there’s a form on page,
despair not; you still don’t
need a mouse to enter the
form. Press [Tab], and Opera
will promptly take you to the
form fields. Don’t feel like
making a purchase at that
moment? Press [F9], and focus
will return to the Web page.

Looking around for a his-
tory of URLs visited? Press
[H], and you get the list at
your fingertips…literally.

Manage that document
Opera boasts of keyboard
shortcuts for just about
everything. It allows you 
to manage your document
windows easily using key-
board shortcuts:

Put across a point
Apart from being an excel-
lent browser, Opera doubles

up as a fabulous presenta-
tion tool.

Press [F11] to transform
Opera into presentation
mode. Scrollbars vanish, the
document opens in full
screen and menus hide. Cer-

tain parts of the document
may be hidden, and fonts
and formatting may change
to reflect presentation status.

The M2 factor
Another weapon in Opera’s
arsenal is the feature-packed
M2 client that fulfils all
your news or mail client
needs.

To configure a new
newsgroup account, go to
Mail > New Account. Choose
the type of account—in this
case, it will be a news
account. To subscribe to a
thread of the Microsoft
newsgroup domain, enter
msnews.microsoft.com as the
incoming server and your
SMTP as the outgoing serv-
er. The outgoing server will
be used to send your posts
to the news server via e-
mail. Use the following set-
tings to better refine your
account usage preferences
in your mail account:

Leave messages on

server (POP accounts
only): This will leave a copy
of the message on the server
even after you have down-
loaded and read it. Good if
you might need mail again
at another computer.

Mark messages
as read if already
downloaded: This
option will ask M2 to
mark a mail as read if
the mail has been
marked as read from
some other mail
client earlier, or from
some other location.

Download mes-
sage body when
checking: This

selects if M2 should down-
load only the message head-
er, or the complete message
body as well. Choosing to
download only message
headers can come in handy
so you can delete spam, or
an unsolicited, large mail
just by reading its header.

Keep local copy of mes-
sage body: This makes a
local copy of the mail for
later viewing.

Check for mail every #
minutes: This forces M2 to
check for new e-mail after a
specified duration.

Play sound when new
messages arrive: M2 can
optionally play back a sound
alert to indicate the arrival of
a new mail.

Queue messages (do 
not send immediately):
Enabling this option causes
M2 to halt a message imme-
diately. Instead, it queues it
in the outbox. All messages
will be sent only when the
Send button is clicked.

Opera is capable of transforming a Web
page to a slide

Action

New document 

Duplicate window 

Reload all

Cascade windows

Tile horizontally

Tile vertically

Restore focus

Switch to next

Switch to previous

Minimise current

Maximise current

Close all

Shortcut

[Ctrl] + [N]

[Ctrl] + [Shift] + [N]

[Ctrl] + [F5]

[Shift] + [F5]

[F6]

[Shift] + [F6]

[F9]

[Ctrl] + [Tab]

[Ctrl] + [Shift] + [Tab]

[4]

[5]

[Ctrl] + [Shift] + [W]



names, not limited to chang-
ing of case.

If you have a number of
files downloaded from, say,
your digicam, and you need
to prefix all filenames with a
word, say, ‘goatrip_’, you can
turn on the Prefix option in
the Serial Filenames tab and
enter the word you need to
add before all your filenames.

Serial mender
So you downloaded a hun-
dred different photographs
from a hundred different
sites for your project, but the
mixed filenames are making
it hellish for you to keep
track of them? 

Go to the Serial Filename
tab and enable the Auto-Ser-
ial Naming option. The
result will be filenames such
as ‘picnic_trip_1.jpg’, ‘pic-
nic_trip_2.jpg’, etc.

A powerful feature wait-
ing to be exploited here 
is ‘Auto Suggest’. Once
enabled, it analyses the tar-
get folder to automatically
suggest a prefix for a file-
name, which, most often,
makes sense.

The General Stuff
StopYell’s General tab is
chock-full of features you
can use. Often, Web sites
rename the filenames to
adhere to online Web
resource locator naming
standards, which are brows-
er friendly, but forget to
change the filename back to
its human-readable form.
This is when special charac-
ters in the filenames get

replaced with codes. For
example, space becomes
%20, and so on. 

Fixing this on 50 files can
be a headache without
StopYell. Go to the
Advanced Options and
switch to the Advanced tab.
Here, in the General tab,
check Enable Replace. By
default, underscores and
‘%20’ are converted to
spaces. Other configurations
are available as well.

The same tab will also
allow you remove all digits
from filenames, or remove
extra whitespace, at the click
of a button. 

Eventually, filenames
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StopYell can suggest filenames
to use for serial filenames

StopYell 2002

Mend your filenames
StopYell is a one-stop solution
for all filename renaming
jobs. You can make elemen-
tary or complex filename
changes, and StopYell will 
do it all at the click of a but-
ton. This feature comes 
in handy when there are mul-
tiple file sources, and you
have to follow various file
naming conventions. 

Use the simple dialog box
to change your filenames to

lowercase or keep it all caps.
You can also choose to con-
vert a long filename to sen-
tence case, which converts
the first letter of the filename
to caps. If there are numbers
or special characters in the
filename, you can define if
you want the character
immediately after the special
character to be capitalised.

Similar changes can 
be made on filename exten-
sions too.

StopYell, by default, keeps
the advanced filename
rename options disabled so
that no accidental filename
change happens. Click the
‘Enable Advanced Options’
option to enable advanced
features. This will allow
StopYell to generate new file-

Change your filenames from
HiCcUpS.jpg to Hiccups.jpg

Replace bad characters such 
as % from filenames quickly 
and easily

SYSTEM

Advanced options allow StopYell
to improve filenames by more
than just the case



OpenOffice.org

Turning off AutoFor-
mat and AutoCorrect in
Writer
Writer, the word processor
within the OpenOffice.org
suite, comes with automa-
tors, namely the auto-for-
mat and auto-correct
facilities. While these may
be useful, they can also be
irritating, especially when
text is being corrected or for-
matted wrongly. For exam-
ple, with the default
settings, it capitalises the
first letter of every sentence;
every URL is recognised and

is coloured to mark it out as
a hyperlink. 

To turn off these, go to
Tools > AutoCorrect/AutoFormat.
Under the Options tab,
uncheck the options that
you don’t need. You can
choose not to have it auto-
correct and auto-format,
while you modify the text,
or while you enter the text
onto the page. 

Inserting special char-
acters in Writer
To insert special characters
such as the ® or © symbols,
place the cursor in the
desired position, and then
go to Insert > Special Character.
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such as ‘34_gOa%20
Trip.JPG’, get converted to
‘Goa Trip.jpg’. Did we hear
“Cool”?

Name your tracks
Not resting at its capabilities
to rename simple and com-
plex naming requirements,
StopYell manages to auto-
matically rename MP3s by
reading their ID3 tags. 

Give it a folder full of
songs, and it will look in

each song to get related
details such as Title, Artiste,
etc, and build up a logical
filename for each file, so you
know the song just by look-
ing at the filename.

StopYell changes the
naming convention depend-
ing on how much informa-
tion is found in the ID3 tag
of a given song. Default and
recommended naming con-
ventions are provided by
default, but can be changed
if needed. Info tags get
replaced by the actual infor-
mation. For example, a file
called ‘so young.mp3’, with
‘%a - %t(%m)’ selected

builds up the filename ‘The
Corrs - So Young (Talk On
Corners).mp3’.

ZoneAlarm

Program control
Clicking on Program Con-
trol lets you set security lev-
els for programs that may
access the Internet from
your computer. 

Clicking on the Main tab
lets you set broad-based
rules; set Medium here. To
set specific rules for each
program, open the Program
tab—here you will find a list
of programs that have tried
to connect. 

You can also add pro-
grams such as your browser,
e-mail client, or a specialised
application to which you
would like to grant access.
For example, if you use file-
sharing programs over the
Internet, you can add the
filename here through the
Add option, and set its
parameters. Choose between
denying access, to allowing
outright access, or settle on
the program asking for per-
mission every time it wants
to connect.

Server rights
ZoneAlarm may alert you
about granting server rights
to certain programs—this is
the case with chat and file
transfer software that allow
for real-time conversations,
such as Yahoo!, MSN or
mIRC. You can assign these
rights from Program Control
under the Programs tab.
ZoneAlarm monitors the
activity of the programs con-

tinuously and prevents unau-
thorised access.

Full stop
To stop all Internet activity,
click on the red Stop button.
You can configure the Inter-
net Lock from the Program
Control screen, in the Main
tab. This is obviously a drastic
measure—use this if you are
certain that a Trojan or some

other major security loophole
exists on your computer. 

You can also configure
certain software to bypass
the Internet lock. This is
useful, if, for example, you
wish to leave for the day, but
need a download to com-
plete. In this case, you can
give, say, your download
manager rights to bypass the
Internet Lock.

Rename a file from good_
song.mp3 to
Californication.mp3



48

insight ■
■ tips and tricks

184 JUNE 2004

Choose Symbol from the Font
list, and click on the symbol
you want inserted.

Locking text 
Writer also has an option that
lets you lock in a section of
text to prevent it from being
edited or changed. Select the
portion of text that you want
protected, go to Insert > Section,
and under the entry for Write
protection, select the Protect
option. Finally, select Insert.
The selected text is now
locked; you cannot overwrite
the text. 

If you like to safeguard the

section with a password,
choose the ‘With Password’
option, provide a password
and click OK.

Freezing panes in Calc
To view row or column cap-
tions for a long spreadsheet as
you work through it, you can
freeze the fields that hold the
caption. 

If a single row or column
caption needs to be frozen,
click on the cell just below or
to the right of the row or col-
umn that contains the cap-
tion. Go to Windows > Freeze. If
you have either column cap-

tions or row captions, you
can create cross freezing by
clicking on the uppermost
left side cell that does not
contain a caption. 

For example, in a sheet
with single row and column
captions, choose the B2 cell.
If you have multiple row and
column captions to be frozen,
you can split the sheet win-
dow. Click on the cell just
below or to the right of the
row or column where you
want to insert your caption,
and go to Windows > Split. The
sheet window splits. Now,
you can scroll both parts of

the split window, displaying
the caption as per your
requirements.

About those pesky
####s
If you see ### in a cell where
you have entered some data
value in Calc, it means that
the value is too large to be dis-
played, and that Calc has
clipped it to display ‘###’. To
read the value, resize that par-
ticular cell. If the cell content
is text, you can double-click
on the cell. This shows a red
triangle that indicates that
the field is overflowing.

NSIS 2

Showing the doors
Any installation package is
incomplete if a corresponding
uninstall module is not bun-
dled. Uninstallation is as
essential a component as the
installation module. Hence, it
is necessary to add the correct
values in your NSIS script to
allow for a successful unin-
stall.

The information has to be
added to the following reg-

istry key: HKLM\Software\
Microsoft\Windows\CurrentVer-
sion\Uninstall

You need to add the fol-
lowing mandatory keys:
DisplayName (string):  This
is where the name of your
applications goes.
UninstallString (string):
Path and filename of the
uninstaller. Always quote the
path to ensure that spaces do
not prevent Windows from
finding the uninstaller.

Optionally, add the fol-
lowing information to help
users get more data about

your application:
ModifyPath (string): Path
and filename of the applica-
tion modify program 
InstallSource (string): Loca-
tion from where the applica-
tion was installed
RegCompany (string): Com-
pany name of the application
HelpLink (string): The Web
site of the application
HelpTelephone (string): The
phone number for applica-
tion support
URLInfoAbout (string): A link
to the application home page
DisplayVersion (string): Dis-
played version of the applica-
tion 
VersionMajor (dword): Major
version number of the applica-
tion 
VersionMinor (dword): Minor
version of the application
NoRepair (dword): This is set
to 1 if the uninstaller has no
option to  repair the installa-
tion

DEVELOPER TOOLS

NSIS has many configurable options, such as which compression to
use for the final install package
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Most of you have seen the Lord of
the Rings movies by now. It is
truly amazing when you consid-

er the detailed universe that this literary
work of Tolkien has created. Especially if
you are an RPG fan, most of the characters
and locales you encounter owe their ori-
gins to this trilogy.

However, movies don’t follow the book
exactly, and this annoys purists.

So if you’re interested in this world and
want to know how it all began, The Hobbit
is here to entertain you. Although no
movie version exists to the book that pre-
ceded LOTR, there is a game at your dis-
posal. Best of all, it sticks to the book.

The story goes thus. A group of
Dwarves has been rendered homeless by an
evil dragon called Smaug the Magnificent.
Following the great loss and suffering
across Middle-earth, the Dwarves decide to
do something. They are accompanied by
Gandalf, who recruits Bilbo Baggins  to
essay the role of a burglar and treasure-
hunter extraordinaire. Now, Bilbo must
endure a series of challenging quests.

The story is depicted nicely through

the use of storyboards,
in-game cutscenes and
voiceovers. 

Once the quest
begins, the game’s visu-
al appeal strikes you,
despite the boring
opening video. Butter-
flies in myriad colours
circle the flora of Hob-
biton, neat little gar-
dens surround each
Hobbit’s home, and
brightly coloured jew-
els and glowing silver
pennies are yours to
collect. All this is set to a very pleasant
soundtrack.

The game has been developed by
Inevitable Entertainment for consoles.
Graphic effects such as fire and magical
sparks are used liberally. Slamming your
weapon down on an enemy results in a cir-
cle of light, and monsters go up in flames
and a shower of gems. The game has got
Arcade Console stamped all over it. This,
and the depiction of Bilbo as a slightly over-

grown kid, has resulted
in the Everyone rating
for the game.

As you progress,
the game difficulty
takes a sudden upward
bump. Enemies attack
in waves, more bosses
are encountered, and
the puzzles seem a hell
of a lot more difficult.
Abundant action saves
the game from sliding
the Tomb Raider way.  

However, the
action slacks in levels
like The Gathering of

the Clouds, where enemies are few. At
times like this, you need to take it easy for
a while. Fortunately, the next level, The
Clouds Burst is all-action, no puzzles. So
you can merrily take on seven to eight gob-
lins at a time, and show them who’s boss.

By that time, you should have
acquired the skills required to mutate
from a timid Hobbit into a roaring ball of
curly hair with big, hairy feet. The game is
ported to the PC by a strange entity called
The Fizz Factor, and they have had to
grapple with the twin devils of camera
controls, and the save system.

If you have a gamepad resembling a
console, you will find that all is well. Oth-
erwise, stick to a keyboard-mouse combi-
nation. The save system consists of
pedestals where you can begin anew. The
PC porting has also introduced a crashing
bug that decides to present itself whenev-
er the planets are aligned just so. You never
know when it might strike. 

When played at a stretch, The Hobbit
can seem never-ending. But taken a session
at a time, it provides plenty of entertain-
ment, and is way above your everyday
third-person slash-em-up.

The Hobbit
Visual appeal and entertainment aplenty

Genre: Action  ■■    Developer: Inevitable Entertainment/The Fizz Factor ■■      Publisher: Vivendi Universal Games  ■■      Distributor: Sony Music Entertain-
ment ■■      Phone: 022-2646-1600  ■■      System Requirements: 600 MHz CPU, 128 MB RAM,16 MB 3D card  ■■      Price: Rs 999  
Web site: www.sonymusic.co.in  ■■ Rating: ★★★   ✩✩

Bilbo gets a much-needed power-up

Now you know why he’s called Smaug the Magnificent

✩✩
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Commandos 3: Destination Berlin
Revamped and much more intense

Difficulty-wise, Commandos 3,
fits somewhere between the
first two versions. Its interface

has been revamped from the original
cluttered backpack. All other functions
are neatly categorised into five hexag-
onal buttons displayed at the bottom
of the screen. Two of these provide
access to your weapons and items.
Right-clicking on them expands the
buttons to show all usable equipment. 

This rearrangement looks very
good, but veterans don’t really bother
with the interface—they will use the hotkeys
instead. But, except for three or four critical
hotkeys, the rest have been done away with.

C3 has more intensity in it than C1 and
C2 combined. Several missions have very
limited time to accomplish the objectives.
In the opening mission, your sniper needs
to take out the elite German sniper, before

he kills off the Russian soldiers. In one mis-
sion, the night before D-Day, you need to
disable the reinforcements stationed in a
camp, within 10 minutes, before they head
for the beaches of Normandy.

The missions in C3 have undergone 
a sea change. The total game time has
been halved.

The sound in C3 is, excellent.
The graphic engine now gives you
the ability to zoom and rotate
smoothly around your character
even while indoors. 

Another facet of the game that’s
been done well is the characters that
populate it. The fluff of the previous
titles has been discarded. 

Unit skills have also been upgrad-
ed. Commandos can now carry sol-
diers around. All units can now stun
soldiers and tie them up. The only

exception to this is the weakling Spy, who
still has to rely on his hypo injections to
knock people out.  

C3 carries both good and bad things.
The game is relatively short, and there are a
few glitches. But, as long as we get our year-
ly dose of some great Nazi lovin’, we’ll still
be playing Commandos 3. 

Genre: Action  ■■    Developer: Pyro Studios  ■■    Publisher: Eidos Interactive   
System requirements: 700 MHz CPU, 256 MB RAM, GeForce or Radeon-class card with 32 MB memory, 2 GB free disk space
Price: Rs 2,999  ■■      Web site: www.commandosgame.com 

The Fuhrer addressing his Nazi legions

Need for Speed Underground
Too Fast

The first thing that NFS Underground
reminds you of is 2 Fast 2 Furious, the
movie that inspired millions to get

their crummy cars upgrades and loud
gangsta rap. The car racing scenes in the
movie were mind blowing. Here is a game
that promises the same fun. 

Additions to this version of NFS are the
Drag and Drift modes. And the competi-
tion is great. The PC puts up a good fight,
and rival cars use all available shortcuts. To
be on top, take all the shortcuts and drive
like the devil.

The handling of cars is by far the best
in this version. You start off with standard
cars, all fresh out of the     factory — mod-
els with handling and speed that are not
the best. But as you progress and upgrade
the car, its handling improves, and so
does the speed. But performance
upgrades are not the only things you can

do with the cars. It is also
very crucial that you car
looks good. You can get style
points and multipliers that
unlock vinyls and other
goodies that add to the look
of your baby. 

The music list for NFSU
comprises punk and gangsta
rap.  You will enjoy this too till
the end of the starry-eyed
effect. It would have been awe-
some if they’d allowed us to
play MP3s from our hard drive.

The motion blur is awe-
some. It makes you actually feel the speed.
But  there’s no motion blur on older cards
like the GeForce2 or the Radeon 8500. You
need NOS to experience it. There is a small
program available online to the game work
on LANs. The LAN gaming thing is very sim-

ilar to the online one, and it’s fun. 
The game could have been awesome,

but there only 15 race tracks. Would I buy
it? Yeah. For the simple reason that EA has
promised a LAN gaming patch and the
online thing.

Genre: Action ■■  Developer: Electronic Arts  ■■  Publisher: Electronic Arts  ■■  System requirements: 800 MHz CPU, 128 MB RAM, GeForce2-class card, 1
GB hard disk space  ■■      Web site: www.needforspeed.com  ■■    Rating: ★★★★

A slow-mo sequence depicting the downfall of your ride

✩✩
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Here’s an interesting tome on informa-
tion security. Security Warrior is co-

authored by Dr. Cyrus Peikari and Dr Anton
Chuvakin, old hands at computer and
information security, and is targeted at an
audience with intermediate knowledge of
computer architecture and networks. The
book is structured into four sections and an
appendix, and its Web site, www.security-
warrior.com, has a lot of interesting papers
and code samples.

Part I discusses software cracking or
reverse code engineering (RCE), in the con-
text of Windows and Linux on the x86 plat-
form. It also deals with RCE on ARM-pow-
ered handhelds running Windows Mobile
apps. The authors work through the chap-
ters with interesting live examples.

Part II is about network stalking, with
TCP/IP security, social engineering tech-

niques and network reconnais-
sance, using commonly
available tools. It ends with
a look at how hackers hide
their tracks. 

Part III discusses plat-
form attacks, with Unix and
Windows attacks, as well as
SOAP XML security, SQL
injection. It has a fascinating
chapter on wireless security. 

Part IV discusses log
analysis, new approaches to
IDSs, honeypots and inci-
dent response.

At the end of each
chapter are references to
papers and articles pub-
lished, many of which are
online. The appendix cov-

ers some useful Soft-
ICE commands. 

This is not a book
for wannabe under-
ground crackers.
Instead, you, as a soft-
ware developer, a net-
work administrator, or
just the desktop user
can know how com-
mon security measures
are circumvented. If
you have some famil-
iarity with Linux, Unix
and Windows with C,
you will definitely
enjoy reading this
informative book.

Thoroughly recommend-
ed—get your copy today. 

Security Warrior: Know your enemy
Knowledge is power

Publisher: O’Reilly  ■■    Author: Dr. Cyrus Peikari and Dr. Anton Chuvakin  ■■    Distributor: Computer Bookshop (India) Pvt. Ltd 
Phone: 022-2206356/0989/5631, 022-22077922/23/24  ■■    E-mail: cbs@vsnl.com  ■■    Web site: www.securitywarrior.com  ■■    Price: Rs 500
Rating: ★★★★

Instant Immersion Translator
Deluxe is a suite of translation

programs. The programs offer
translation between English
and a host of other languages,
but you use each of them
slightly differently. 

The translation quality it
offers is better than what
Google’s and AltaVista’s lan-
guage services offer. However,
you need to be connected to
the Internet to use the pro-
gram—the translation engine is
not local.

This review is from the perspec-
tive of the French and German translation
engines, although there are many lan-
guages available. "From the colloquial to
the complex, your message will be deliv-

ered accurately and
quickly," the cover claims.
True, to an extent. Don’t
expect flawless transla-
tions. The system is still
plagued with the problems
that all translation engines
are bogged down by—con-
text, slang, poetic usage,
and so on. Reverse-transla-
tion still produces the com-
ical  results that Google
and other free online trans-
lation services do.

You’d expect that idioms and
stock phrases would get translated perfect-
ly, but that’s not the case either. 

However, for plain language, as occurs
in business letters and product descrip-
tions, translations are easy to understand.

There are settings you can choose from—
formal, familiar, gender of the speaker,
among others. And there are dictionaries
to choose from, such as, legal, medical,
and so on. 

The features are nifty. In LogoTrans, one
of the components of the suite, the reverse
translation appears automatically. In File-
Trans.Net, you can browse to a file of your
choice to be translated, and the maximised
window gets translated automatically. In
TransIt.Net, you simply choose the lan-
guage pair, and drag an icon onto the file
to be translated.

All very well, the bottomline is, how
good are the translations? The verdict is
"pretty good." If you’re a frequent user of
translation services, or if you need good
translations for business purposes, the price
of Rs 4,295 for this suite is worth it.

Publisher: TOPICS Entertainment  ■■      Distributor: Microware Computer Services  ■■      Phone: NA 
E-mail: helpdesk@topics-ent.com  ■■      Web site: www.topics-ent.com  ■■    Price: Rs 4,295
Rating: ★★★★✩✩

Instant Immersion Translator Deluxe  
A cut above online translation

✩✩
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It all began when the new breed called
Recruits-from-Chennai was intro-
duced to Team Digit. After an elabo-

rate round of introductions, the Recruits
attempted to settle in. They soon began
the search for elusive office space. After a
day of musical chairs, they finally landed
their very own work stations. Life would
now be complete. 

Or so they thought. Till they attempt-
ed to log in.
<Click> HTTP 404: Site not found.
<Click> Unable to access network.
(Silence)
(More Silence)

The seemingly perfect computers sim-
ply refused to acknowledge their presence
in the organisation.

While the Recruits wondered if this
was the Editor’s way of telling them that
he had changed his mind about hiring

them, Saurabh ‘CD’ Kumar uttered the
magic words, “Ask Ajay.”

It doesn’t take long to realise that the
Real Boss here is a lean, mean man called

Ajay Borwankar, the Network
Administrator. 

Soon, Dr Ajay was sum-
moned to set things right.
Newbie Meera had forgotten
her password; Newbie Supro-
tip struggled to get his com-

puter to behave like one;
Newbie Nadim hijacked
designer Sachin Dalvi’s
computer, and therefore
has no problems…yet. He
better begin admin-wor-
ship in full earnest, once
Sachin returns.  

Two hours later, the
Recruits made their
grand entry into the
network. The relief on

their faces gave way to
reverence for their sav-

iour, Ajay. But, there are
rules, and keeping Ajay in

good humour involves veneration. 
Doggedly protective of the network,

Ajay tolerates little criticism. Complaints
such as “mails take two hours to show up
in the inbox” will be met with cold dis-
dain.  “I have no problems on my home
computer” is his fuming retort. 

First lesson: Be nice to Ajay Borwankar.
Even the ‘Monday Meeting’, where the

CEO welcomed the newbies, did little to
assure them that he was the real boss. 

Despite the typical oh-so-state-of-the-
art settings, Digit has its fair share of the
lighter side of life. Here, you prick one ear,
and you get the customary dosage of ver-
bal lambasting from the big boss. Prick
the other, and your other boss has least
control of his vocal cord over forgotten
Bollywood numbers. And if you are lucky
enough, yet another boss, stung by some
conspiracy theory, wanders aimlessly
with arms akimbo, wondering, not for the
first time—who pinched the table fan
from his cubicle! And as if that wasn’t
enough, the building rattles every
evening from the quarry blasts.

Even the canteen guys chip in at The
Digit Show. If you order coffee, it is very
likely that three days a week, the liveried
boy will thrust vada-pao under your
nose, with a, “Is this what you asked
for?” look.

No, we’re not in a different time
zone, nor just plain crazy. Our
new year begins in June, when

we celebrate Digit’s birth. More chaos,
more technology, the latest hardware,
deadlines, and even more innovative
ways to surprise our readers. This also
means resolutions, and Team Digit’s
resolutions ranged from the solemn to
the bizarre!

The Editors were sober and realistic:
Sumod says, “I’m gonna exercise more,”
and Sachin claims, “I shall go home in
time to watch the beautiful sunset every-
day.” They’ll probably be the only ones
to keep their promises! 

Our designer Pillaiji declared, “I
want to close the issues earlier.” Deep-
ak ‘PJ’ Dhingra quips, “I want to close

issue later. Let’s finish the June issue on
June 15th.”

Aparna said, “I resolve to increase
the digits in my salary”, while Saurabh
‘CD’ Kumar wants to learn to manage
his moolah better!

Srini swears he will finally upgrade his
ageing processor, while Garfield resolved
not to resolve. Ram says, “I’ll spend more
time at my desk than in the smoker’s
bay,” and Mitali says her resolution is
“1024x768”! Raaabo just confused us all
by saying, “I resolve to make time to
resolve a resolution that will make others
resolve to keep their resolutions.” 

As of now, we’re starting an office
pool to see whose resolution crashes,
burns, screams and dies first. We hope
none do. We’ll keep you posted.

We seek him here, we seek him there
The newbies seek him everywhere
One minute he’s out, the other he’s in
The sly, elusive Network Admin!

Welcome to the Digit Show!

Happy New Year!
Digit’s birthday bash is today!

Mahesh Benkar

Of ample laughter and the Real Boss...
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a. Charles Babbage
b. Herman Hollerith
c. Tim Berners-Lee
d. Konrad Zuse

Which of the following 
companies has acquired
Ximian, the specialist in Linux
desktop management and 
groupware technology?
a. Novell          b. Cisco
c. Hughes        d. Red Hat

The first application of
computer chips was in designing
the guidance system for a flying
machine. What was it?
a. The Apollo spacecraft
b. The Airbus A200
c. The Minuteman Ballistic missile
d. The Grumman X-29

Enlightenment, the
revolutionary desktop for
Linux, was launched in 1997.
Who developed it?
a. Linus Torvalds
b. Wichert Akkerman 
c. Bob Young
d. Carsten ‘Rasterman’ Haitzler

Palm OS 4.0 is the newest
operating system for Personal
Digital Assistants (PDAs) from
Palm Technologies. Which of
the following is an addition to
this operating system from
version 3.5?
a. Virtual File System Library
b. Flash ROM upgrade capability

c. Working memory allocation as
per RAM available

d. Graphical User Interface (GUI)

This company, founded by
Marc Andreessen and Jim Clark
in the early ‘90s, was later called
Netscape Communications.
a. AOL
b. Cisco Systems
c. Mosaic Communications
d. 3Com

This browser engine
technology was codenamed
NGT. By what name is it better
known?
a. Active Server Pages
b. ActiveX
c. JavaScript
d. Gecko

Which animated motion
picture made the most money
world-wide?
a. Shrek
b. Monsters Inc
c. Antz
d. Finding Nemo

Name the original
hypertext project founded by
Ted Nelson in 1960. It
preceded the World Wide Web
and Lotus Notes, and derived
its name from the first line of a
poem by Samuel Taylor
Coleridge.
a. Odyssey      b. Utopia 
c. Xanadu       d. Limbo

Which is the
world’s largest full-
time dedicated
astronomical
instrument?
a. Search for Extra-
Terrestrial Intelligence
(SETI)

b. Very Long Baseline Array
(VLBA)
c. The Green Bank Telescope
(GBT)
d. Atacama Large Millimetre
Array (ALMA)

The World Wide Web, as
we now know it, was
developed as a project at the
European Organisation for
Particle Physics Research.
Situated on the border
between France and
Switzerland, what is this
organisation better known as?
a. CERN        b. ICANN
c. FCC          d. ISOC

This cost-effective WLL
technology was developed in
India by IIT Chennai and Midas
Technologies, Madras. Identify it.
a. dRMS b. VoIP
c. CorDECT d. CDMA

Name the company that
negotiated a deal with the
Federal Space Agency of Russia
to fly Dennis Tito and  to the
International Space Station?
a. Space Travels
b. Space Adventures
c. Space Frontiers
d. Space Discovery
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This month’s theme: Personalities

Across
1. A derogatory term describing a

new user of a USENET newsgroup,
whose naive comments irritate the
group’s established members.

3. The standard arrangement of keys
on a typewriter or keyboard.

5. A 16-bit character encoding
system spanning all characters in
all languages, including Chinese.

7. A file format designed to enable
exchange of documents between
different word processing
programs.

8. A short message sent over a
network by one computer to check
whether another is correctly
connected to it.

Down
1. Behaviour guidelines evolved by 

users of the Internet.

2. A software, surreptitiously installed
on a computer, monitoring use of
that computer without the user’s
knowledge.

4. A device that pushes traffic through
a packet-switched network; for 
example, the Internet.

6. The world’s first online
encyclopedia; founded in 1982.

■ qubit
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LinuxChix is a community for

women who like Linux. The

membership ranges from pure

novices to technical writers

and even programmers.

did you know

Got an interesting question? Send

it in with the correct answer to  

quiz@thinkdigit.com

numberette

Powered by

GPS is also used to keep
time, because GPS
receivers can display
time accurate to withiny
time accurate to within150 billionth
of a second

1 to 5 Way to go...

6 to 10 Good, if you like
being mediocre 

11 to15 Your next job could
be with us!

QUOTIENT

Quiz
1: b2: a3:b
4: c5: d6: a

7: c8:d9:d
10: c11: b

12: a       13: c

14:b

Crossword
Across: Down:
1 Newbie1 Netiquette
3 QWERTY2 Spyware
5 UNICODE4 Router
7 RTF            6 Delphi
8 PING

Answers

US Space Shuttles use a noise-cancellation
technology that protects astronauts from
permanent hearing damage. Who invented it?

3

He is believed to have invented the mechanical tabulating machine—
the first device for high-volume data processing. It was first used in
the 1890 census in the US. He also established the Tabulating

Machine Company—one of the founding companies of IBM.

a. Alexander Graham Bell 
b. Amar Bose 
c. Lewis Nixon
d. Thomas Alva Edison
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